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Notice
The information contained in this document is subject to
change without notice. LI-COR MAKES NO WARRANTY OF
ANY KIND WITH REGARD TO THIS MATERIAL,
INCLUDING, BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE. LI-COR shall not be liable
for errors contained herein or for incidental or consequential
damages in connection with the furnishing, performance, or
use of this material.
This document contains proprietary information, which is pro-
tected by copyright. All rights are reserved. No part of this doc-
ument may be photocopied, reproduced, or translated to
another language without prior written consent of LI-COR,
Inc.
Mac® and Mac OS® are trademarks of Apple® Inc., registered
in the U.S. and other countries. Microsoft® and Windows® are
trademarks of Microsoft Corporation in the United States
and/or other countries. Google® is a registered trademark of
Google Inc. All other trademarks or registered trademarks are
property of their respective owners.
Copyright © 2013–2019, LI-COR, Inc. All rights reserved.

CE Marking:
This product is a CE marked product. For conformity inform-
ation, (typically EMC, Safety, RoHS, and/or Wireless) contact
LI-COR Support at envsupport@licor.com for a Declaration of
Conformity. Outside the U.S., contact your local sales office or
distributor.
For ReaCH (Regulation (EC) n.1907/2006) related questions,
information is available on the European Chemicals Agency
maintained website for the Waste Framework Directive SCIP
database.
You can search by product name (for this product
“LAI-2200C”), or request an “SCIP number” from the email
above.
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LI-COR scientific products are for professional use (non-con-
sumer products). These products do not fall within the vol-
untary scopes of regulations: UNI EN ISO 14024, TCO
Certified, EPEAT 2018, Blue Angel, TÜV Green Product Mark,
Energy Star, EU GPP, or other similar regulations. The typical
scope for these regulations is lighting, furniture, copiers,
mobile phones, televisions, computer/servers, home appliances,
to name a few. As such, our products do not use any labeling
that indicates adherence thereof.
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Part Name Toxic and Hazardous Substances or Elements 

(Pb) (Hg) (Cd) (Cr(VI)) (PBB) (PBDE)

PCBs) 
X O O O O O 

Optics)
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Cables and Wires) 
X O O O O O 

(Metal Parts)
X O O O O O 

(Plastic Parts)
O O O O O O 

(Batteries)
O O O O O O 

 SJ/T 11364 

O =  GB/T 26572
(indicates that the content of the toxic and hazardous substance in all the Homogeneous 
Materials of the part is below the concentration limit requirement as described in GB/T 26572).

X =  GB/T 26572
 (indicates that the content of the toxic and hazardous substance in at least one Homogeneous 

Material of the part exceeds the concentration limit requirement as described in GB/T 26572).

LAI-2200C/ LAI-2200TC

This device complies with part 15 of the FCC Rules. Operation
is subject to the following two conditions: (1) This device may
not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause
undesired operation.
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Welcome…
…and thank you for your purchase of the LAI-2200C Plant
Canopy Analyzer. The LAI-2200C is the successor to the
LAI-2000 and LAI-2200, which LI-COR produced and sold for
over 20 years. At LI-COR, it is our passion to provide scientific
instruments of exceptional quality, and we hope that the
LAI-2200C performs exceptionally for you. We welcome your
comments and suggestions. Feel free to contact us at any time.

Note: The LAI-2200C is based on the LAI-2200, with
the addition of a Global Positioning System (GPS).
The LAI-2200 can be equipped with the 2200CLEAR
upgrade kit, giving it the same functionality as the
LAI-2200C.

About this Manual:
This manual should serve as a guide to understanding the
proper operation, abilities, and limitations of this instrument.
Operators new to the instrument are encouraged to read the
theory sections and become acquainted with the body of pub-
lished literature that cites data collected with the LAI-2000 and
LAI-2200. Operators familiar with the LAI-2200 could jump to
the new scattering correction feature for direct sunlight con-
ditions (Sun on page 5-6) and the new integrated GPS system
(Global Positioning System on page 3-23). The menu-level con-
tents can help you find explanations of various instrument func-
tions.
Familiar with the LAI-2000? See LAI-2000 vs. LAI-2200C on
page D-1 for a brief comparison with the LAI-2200C.
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Section 1.
Getting Started
The LAI-2200C calculates Leaf Area Index (LAI) and other
canopy attributes from light measurements made with a
“fish-eye” optical sensor (148° field-of-view). Measurements
made above and below the canopy are used to calculate
canopy light interception at five zenith angles, from which
LAI is computed using a model of radiative transfer in
vegetative canopies.

The LAI-2200C (or LAI-2200 equipped with the
2200CLEAR upgrade kit) includes a built-in GPS module
(Global Positioning System on page 3-23).

What’s What
If you have just taken delivery of your LAI-2200C, check
the packaging list and verify the contents of the shipment.
The following components should be included:

LAI-2270C Control Unit
The LAI-2270C Control Unit (console) is used to con-
figure instrument settings, store recorded data, and com-
pute results. An internal GPS module supplies location
data. The LAI-2270C is shipped with 4 “AA” alkaline bat-
teries, which can provide up to 90 hours of operation. An
internal lithium backup battery maintains the clock when
the main batteries are removed. Refer Control Unit on
page 2-1 for a complete description.
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LAI-2250 Optical Sensor
The LAI-2250 Optical Sensor (wand) is the data col-
lection component of the LAI-2200C. It is shipped with
two “AA” alkaline batteries, which can provide over 140
hours of typical operation. A protective cap is provided
to cover the bulkhead connector. Refer to Optical Sensor
on page 2-6 for a complete description.

The optical sensor contains high precision optical com-
ponents, including lenses, optical filters, and light
sensors. It should be treated like an expensive camera
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lens and protected from impacts and intense vibration.
See Maintenance on page 2-8 for complete care instruc-
tions.

View Caps
Five view restricting caps, a pin-hole cap, a solid cap,
and a diffuser are provided with the LAI-2200C (part
number 9920-005). The view restricting caps serve to
limit the azimuthal field of view of the optical sensor in
circumstances in which it is necessary or desirable to
block part of the view. The solid cap (part number 6520-
020) should be used to protect the lens when it is not in
use. The white diffuser cap (part number 6522-117) is
used for collecting the ancillary data for applying scat-
tering corrections when operating in direct sunlight (See
Sun on page 5-6). The drilled cap (cap with the small
pinhole drilled in the middle) is used for collecting leaf
transmittance and reflectance properties (see Procedure
2.14 - Measuring Leaf Transmittance and Reflectance on
page 8-31).

Figure 1-1. View caps used with the LAI-2200C. The solid
black cap is to protect the lens. The diffuser is covered with
protective paper—remove it before collecting data.

Sensor Cables
One 6-pin cable (part number 9922-127) with bulkhead
connectors is provided with each optical sensor. It is
used to connect the optical sensor to the control unit.
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Data Cable
A USB Type A to USB Type Mini-B cable (part number
392-07872) is provided to transfer data between the
LAI-2200C and a computer.

FV2200 Software
File Viewer 2200 (FV2200) is the software package for
processing data from the LAI-2200C on your computer.
It is available for Windows®, Mac OSX®, and Linux.
Download the latest version using the following link:
www.licor.com/2200C-software.

FV2200 includes data analysis, charting, GPS mapping,
and support for the scattering correction for meas-
urements made in direct sunlight (see Data Analysis with
FV2200 on page 7-1).

Accessories
In addition, the LAI-2200C includes the accessories lis-
ted below.

Bubble Levels
Two bubble levels are provided with each optical sensor.
The bottom level (part number 610-03047) attaches to
the underside of the optical sensor for use in situations
in which the sensor is held over the operator’s head. The
top level (part number 610-03048) attaches to the top of
the optical sensor.

Both levels look similar. The top level, however, has the
manufacturer’s name printed on the bottom, whereas
the bottom level does not. The top level also has the
circle printed on the glass, whereas the bottom level has
the circle printed on the white background.

http://www.licor.com/2200C-software
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Lens Cleaning Kit
The Lens Cleaning Kit (part number 610-03100)
includes cleaning solution and lens cleaning cloth.

Carrying Carabiner
A carabiner (part number 610-10456) is included to
allow hands-free transportation of the control unit. The
clip attaches to the base of the control unit with a ring.
It can be attached to the user’s belt loop.

Calibration Sheet
The calibration sheet indicates the angular response of
your LAI-2250 and its response in an isotropic envir-
onment. It is a good idea to store the calibration sheet
in a safe location. If it is lost, contact LI-COR for the cal-
ibration information for your instrument.

Instruction Manual
The Instruction Manual contains basic operating and
maintenance information for the LAI-2200C.

Accessory Kits
Two accessory kits are provided, one for the control unit
(part number 9922-107), and one for each optical sensor
(part number 9922-108). They include frequently
replaced components.

Theory of Operation
Leaf Area Index is one-sided leaf surface area per ground
surface area. Because the LAI-2200C is sensitive to all
light-blocking objects in its view, the term foliage area
index is more appropriate. In scientific literature, the
terms effective Plant Area Index (PAIeff) (Garrigues et al.
2008), Vegetation Area Index (VAI) (Fassnacht et al.
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1994), and others have been used to refer to indirect
LAI measurements that may include non-leafy veget-
ation. We use the term LAI throughout this manual,
except when discussing measurements of isolated plants,
in which case we use the term Foliage Density. For
more on this, see LAI or Foliage Density? on page 6-12.

Basic Theory
The amount of foliage in a vegetative canopy can be
deduced from measurements of how quickly radiation is
attenuated as it passes through the canopy. By meas-
uring this attenuation at several angles from the zenith,
foliage orientation information can also be obtained.
The LAI-2200C measures the attenuation of diffuse sky
radiation at five zenith angles simultaneously. The
LAI-2250 Optical Sensor projects the image of its nearly
hemispheric view onto five detectors arranged in con-
centric rings.

If the sensor is level and viewing the sky, detector 1 will
measure the brightness straight overhead, while detector
5 will measure the brightness of a ring centered at the
68° zenith angle (22° above the horizon), subtending
13°.

A normal measurement with the LAI-2200C consists of
a minimum of ten numbers: five of the numbers are the
signals from the five detectors when the optical sensor
was above the vegetation, and the remaining five are the
readings made with the sensor below the vegetation. For
both readings, the sensor is looking up at the sky. Five
values of canopy transmittance are calculated from these
readings by dividing corresponding pairs. For example,
if detector 1 reads 50 (units not important) above the
canopy and 5 below, then the transmittance at that
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angle (centered at 7°) is 5/50 = 0.10. From trans-
mittances at all five zenith angles, the LAI-2200C cal-
culates foliage amount (leaf area index, LAI) and foliage
orientation (mean foliage tilt angle, MTA). In practice, a
number of below-canopy readings are usually made to
improve the spatial average.

Assumptions
There are some basic assumptions that must be met in
order to make accurate calculations of foliage density
and orientation. The extent to which these assumptions
are violated will affect the accuracy of measurements
and subsequent calculations. The four major assump-
tions, in approximate order of importance, are:

1 The foliage is black. It is assumed that below-canopy readings
do not include any light that is reflected or transmitted by
foliage. An optical filter in the LAI-2250 Optical Sensor rejects
any radiation >490 nm. Foliage typically reflects and trans-
mits little radiation in this portion of the spectrum, which
helps minimize violations of this assumption.

Note: The file viewer software FV2200 version 2.0
and above removes this assumption when you
apply the scattering corrections to your data. See
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Scattering Correction on page 10-11.

2 The foliage is randomly distributed within certain foliage-con-
taining envelopes. These envelopes might be parallel tubes
(as in row crops), a single ellipsoid (an isolated bush), an infin-
ite box (turf grass), or an infinite box with holes (deciduous
forest with gaps).

3 The foliage elements are small compared to the area of view
of each ring. The approximate guideline is this: the distance
between the sensor and the nearest leaf above it should be at
least four times the width of the leaf. This relationship is
described in more detail later in the manual.

4 The foliage has random azimuthal orientations. That is, it does
not matter how the foliage is inclined, as long as all the
leaves are not facing in the same compass direction. The
importance of this assumption is reduced when meas-
urements are made in a wide range of compass directions or
without a view-restricting cap.

No real plant canopy conforms exactly to these assump-
tions. Foliage is never random, but is often clumped
along stems and branches, and certainly is not black.
Many species exhibit heliotropism, which violates the
azimuthal randomness assumption. The practical com-
promises that must be made are often not serious, how-
ever. Many canopies can be considered random, and
living foliage does have relatively low transmittance and
reflectance of light below 490 nm. Offsetting errors may
be common, such as when leaves are grouped along
stems (increasing light transmittance), but arranged to
minimize overlap (decreasing transmittance).

Some canopies violate these assumptions to an extent
that requires consideration. Measurements of conifer
canopies, with their high degree of organization, or
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senescent crops, with thin reflective leaves, might have
large absolute errors. The LAI-2200C is very sensitive to
small relative differences. In some cases, it might be
necessary to calibrate the instrument with direct meas-
urements in order to achieve high absolute accuracy.
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Section 2.
Introduction to the Instrument
This section describes the physical characteristics of the
instrument, the keypad interface, basic software nav-
igation, initial setup, and instrument care.

Control Unit
The control unit (console) houseing
is constructed of durable ABS plastic
with a rubber seal between the two
halves. The rubber seal also serves as
a shock cushion to protect the instru-
ment from impacts.

Display
The display is a 128 x 64 LCD graph-
ics display. It shows alphanumeric
characters. To adjust the display con-
trast hold the minus (-) key and
press the up or down arrow keys.

Keypad
The LAI-2200C features a 22-button
tactile response keypad. The upper
block of 9 keys are used to navigate
through menus, select menu options, and log data. Basic
functions of the upper 9 keys are described in the fol-
lowing chart:
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MENU

PressMenu to go to the Main Menu;
or when in Logging Mode, to go to the
Log Adjust menu.

EXIT

Exit returns to the main screen unless
an input or toggle field is active. In
these cases it returns to the previous
screen.

OK

OK selects the highlighted menu field
or implements a setting after changes
have been made.

START

STOP

Start/Stop is used to initiate or ter-
minate a logging sequence.

LOG

When in Log mode, the Log button
records a reading (or two if two wands
are attached).

The Up arrow and Down arrow but-
tons are used to navigate through
menu options and increment or decre-
ment values in some fields.

The Right arrow and Left arrow but-
tons advance to the next or previous
menu sub-level when on a menu
screen. If a toggle field is active they
toggle the setting. They also are space
and backspace keys in alphanumeric
fields.

The lower block of 12 keys are used to enter alpha-
numeric characters. Each key is used to enter the letters
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and numbers indicated by the label on the key. Keys 1–9
can also be used to log global positioning system (GPS)
coordinates when GPS is active and a file is open in the
LAI-2200C (or LAI-2200 equipped with GPS). The 22nd
key is the power on/off key at the top left of the keypad.

When entering alphanumeric characters with the
keypad, each button cycles through a loop of characters
and stops looping when a different button is pressed or
after 1 second has passed without a button press. Some
fields can only accept numeric or alphabetic characters.
The right arrow key is used to enter spaces and the left
arrow key functions as a backspace key in alphanumeric
fields.

Cable Connections
USB (Universal Serial Bus), light sensor, and optical
sensor connections are on the top and bottom of the
LAI-2200C console.

Optical Sensor Cable Connections
The 6-pin bulkhead connectors (labeled X and Y) are
used to attach optical sensors (wands). The control unit
will automatically detect an attached wand. Wands can
be attached or removed while the instrument is
powered on. To attach the cable, orient the red dot on
the cable toward the keypad and press straight in. To
release the cable, grasp the collar and pull straight out.
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Figure 2-1. The cable connects to the wand and console. The
red dot on the cable connetor should be oriented to the
keypad. To remove the cable, grasp the connector and pull.

Light Sensor Cable Connections
Two BNC (Bayonet-Neill-Concelman) bulkhead con-
nectors are available to attach LI-COR Quantum
Sensors. They are labeled “1” and “2” on the front of the
control unit and identified as Port 1 and Port 2 by the
control unit.

BNC Light Sensor Connectors
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LAI-2250 Optical Sensor (wand) connectors X and Y

Data Cable Connection
A Mini USB port is available for communicating with a
computer (Connecting to a Computer on page 3-22).
When connected with a USB cable, the computer will
identify the LAI-2270C (the control unit) as a mass stor-
age device.

Mini USB Port

Memory
The control unit is equipped with 128 MB of non-volat-
ile flash memory. The instrument stores data on an
internal Secure Digital (SD) card, which should provide
sufficient memory for intensive data collection (enough
storage for over 1.5 million records).



LAI-2200C Plant Canopy Analyzer Instruction Manual

2-6

The format for the SD card is FAT16. Do not modify
the card in any way when connected to a computer, and
never remove or replace the card unless it is with a card
purchased from LI-COR Environmental (part number
616-10387).

Optical Sensor
The optical sensor (wand) is constructed with a durable
aluminum enclosure, which protects the electronic and
optical components. It can be mounted to a camera tri-
pod or raising pole using one of the ¼”-20 tripod
mounting holes. It can be used independently of the
control unit for data collection. When the wand is
attached to a console, it is powered with the console bat-
teries – it does not require its own batteries. Otherwise,
it requires two “AA” batteries.

Caution: Batteries must be inserted with the
positive poles (+) toward the cap.

AA BatteryAA BatterytteryAA BatBatter

- +

Keypad
The optical sensor keypad includes two buttons that are
used to log data, switch between A and B readings, and
power on/off the optical sensor. The LOG button on the
wand functions the same as the log button on the con-
sole – if the console is in logging mode (see Logging
Mode on page 3-12), the LOG button will log a record to
the open file.
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Optical sensors will turn on when the control unit is
turned on (if the wand and control unit are attached),
when the optical sensor cable is connected to a
powered-on control unit, or when the optical sensor
power button is pressed (when disconnected from the
control unit). To turn the optical sensor off, press and
hold the A/B|Power button for 2 seconds. To switch
between A and B readings press and release the
A/B|Power button.

Indicator LEDs
Three light emitting diodes (LED) indicate the state of
the optical sensor. The POWER LED is illuminated
when the sensor is turned on. The LOG LED illu-
minates when data are being recorded. When the LOG
button is pressed, the LOG LED lights up for the dur-
ation of the reading and turns off when the log is com-
plete. The optical sensor’s LOG LED will flash every 2.5
seconds or 1 second as part of automatic, unattached
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logging (see Logging Configurations on page 3-14). The
ABOVE LED indicates whether the next reading from
this sensor will be labeled A (LED is on) or B (LED is
off). Pressing the A/B|Power button switches between
A and B readings.

Features
The optical sensor has 1 megabyte (MB) non-volatile
flash memory that is used when operated in unattached
mode (for about 25,000 records). The optical sensor will
indicate that its memory is full by flashing all three
LEDs simultaneously. When the optical sensor batteries
are low (<2V), the green POWER LED will turn red.
The optical sensor will shut off automatically when the
battery voltage is below 1.8 V.

Optical sensors do not require batteries when they are
used in attached mode - they use power from the con-
trol unit. Be aware, however, that if a data cable is
removed during a data transfer between the wand and
console, the files may be damaged or lost. The control
unit display indicates when data transfer is taking place
with an on-screen indicator (see Logging Mode on
page 3-12). Be sure to wait until data transfer is com-
plete before disconnecting the data cable.

Maintenance
The LAI-2200C is designed for low maintenance, and
generally it should require little servicing beyond keep-
ing it clean and replacing the batteries.

Control Unit
The control unit battery compartment is on the back of
the instrument. To open the battery compartment,
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remove the two screws that secure the battery cover
with a #1 cross-head (Philips) screwdriver. The control
unit requires 4 “AA” batteries. Be sure to observe proper
polarity when changing batteries. Replace the batteries
and reattach the cover.

Optical Sensor
The optical sensor uses 2 “AA” batteries, which are in
the handle of the optical sensor. To remove the optical
sensor batteries, use a coin or large flat-tipped screw-
driver to turn the battery cap counter clockwise about ¼
turn. When inserting new batteries, insert the negative
(-) pole into the battery holder first. The positive (+)
pole on the second battery makes contact with the black
cap (part number 345-10735).

If the instrument is to be stored for a long period of
time, remove the batteries to prevent damage that may
result from battery leakage and corrosion.

Calibration
There are two parts to the factory calibration. One is
done at a range of angles in collimated light, and is used
to center the detector and verify the angular response.
The other is done in isotropic conditions (an integrating
sphere) and provides calibration factors that are used to
match each ring’s output to each other, but not to any
absolute standard. This inter-ring calibration has no
effect on LAI determination, but would be important if
you were to use the sensor to map angular distributions
of diffuse radiation.

Recalibration of the optical sensor is not necessary, as
long as the optics within the sensor remain in place.
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The detectors may have long-term electrical drift, but
this will not affect LAI determinations.

Instructions for entering calibration multipliers are in
Calibration and Match Values on page 3-4. The procedure
for matching two sensors is separate from calibration
and is described in Matching Sensors on page 3-10.

Cleaning
The optical sensor lens should be kept free of dust, dirt,
and deposits when collecting data. To help keep the lens
clean, leave the opaque lens cap in place when the
instrument is not in use.

The front lens of the optical sensor can be cleaned with
distilled water or the Lens Cleaning Kit included with
the instrument.

Note: Be very careful not to scratch the MgF2 coating
on the lens. Avoid cleaning the lens with paper
products, and never wipe the lens while it is dry.
Damage to the lens is not covered under the war-
ranty.

The instrument display and keypads can be cleaned with
a moistened non-abrasive cloth when necessary.

Storage
When storing the LAI-2200C for a long period of time,
remove the “AA” batteries, replace the bulkhead con-
nector caps, and attach the lens cap.

Replacing the Internal Battery
The following steps describe how to replace the internal
lithium battery. The battery should last up to 7 years.
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Always use a BR1225 watch battery (part number 442-
08614).

1 Using a #1 cross-head (Phillips) screwdriver, loosen the four
screws that secure the top and bottom of the control unit. The
four screws are located in the corners of the back of the con-
trol unit, under the gray protective rubber. Nudge the rubber
out of the way of the screws.

2 Gently separate the two halves.

3 The battery is in a round coin-cell battery holder. Lift the silver
tab slightly and slide the battery out. It may be necessary to
lift the battery slightly with the blade of a standard screw-
driver.

4 Slide the new battery into the holder with the positive (+) ter-
minal facing up.

5 Join the top and bottom halves of the control unit. Be sure the
rubber seal is seated properly.

6 Gently tighten the four screws that hold the two halves of the
case together. Be very careful not to over tighten the screws,
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as they may strip the plastic. If a torque screwdriver is avail-
able, torque the screws to 4 in.-lbs.

Software and Firmware Updates
The FV2200 software application can notify you of soft-
ware updates and other developments if the computer
that is running the application has internet access. Each
time it is launched, FV2200 checks to see if there are
any notifications that it has not already told you about,
and if so, shows them to you. You can view the latest
notifications at any time by clicking Help > Latest
LAI-2200 News. This notification summary has links
that will take your web browser to the appropriate loc-
ations.

You can also select Help > Check for Software
updates > ShowWand and Console Information
to view the latest versions of FV2200, console, and wand
software, and, if you choose, download them from the
FV2200 application.

Instrument Firmware
There are two firmware components in the LAI-2200C –
the console firmware and the wand firmware. Any
updates will be available for download from FV2200
Help > Check for Software updates > ShowWand
and Console Information. The following procedures
describe how to update the firmware.

Console Firmware

1 Acquire a console firmware file. It will have a name similar to
“lai01.img”.

Download using FV2200 Help > Check for Soft-
ware updates > ShowWand and Console
Information or get the file from the
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licor.com/env/support/LAI-2200C/software.html. The
file will be saved to your downloads directory.

2 Attach the LAI-2200C console to a computer using the USB
connection.

After the LAI-2200C has been recognized by the com-
puter, copy the new firmware file to the LAI-2200C
mass storage device root directory.

3 Next, “eject” the disk, then disconnect the LAI-2200C from
your computer.

4 Power on the control unit and go toMENU > Firmware
> Console > Upgrade.

5 Select the new firmware file and pressOK.

The new firmware will take several minutes to
install, and a Complete OK message will be dis-
played when it is finished. Press OK when the firm-
ware update is complete.

Optical Sensor Firmware

Note: When using multiple wands, be sure they all
have the same firmware version.

1 Acquire an optical sensor firmware file from FV2200.

Either click Help > Check for Software updates
> ShowWand and Console Information and
save the file to your computer or download the file
from licor.com/env/support/LAI-2200C/soft-
ware.html. It will have a name similar to
“wand01.bin”.

2 Copy the file to the Console memory as in step 2 in the pre-
vious example.

Note: Wand firmware can only be updated through
port X. The firmware version can be checked through

https://www.licor.com/env/support/LAI-2200C/software.html
https://www.licor.com/env/support/LAI-2200C/software.html
https://www.licor.com/env/support/LAI-2200C/software.html
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port X or Y, but updates can only be delivered to
wands connected to the X terminal.

3 Disconnect the LAI-2200C from the computer.

4 Connect the wand to port X, turn on the console, and go to
MENU > Firmware > Wand > Upgrade.

5 Select the new file and pressOK.

The update will take several seconds to complete.
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Section 3.
Basics of the LAI-2200C
This section introduces the basics of the LAI-2200C,
including configuration options, usage considerations, and
a guide for making basic measurements. It is recom-
mended that users who are unfamiliar with the LAI-2200C
follow the example measurements and become thoroughly
acquainted with the practical considerations (in the next
two chapters) before attempting real measurements with
the LAI-2200C.

Power ON and OFF
To power on the LAI-2270C Control Unit (console), press
the power button. It is below the left side of the display.

If not attached already, attach an optical sensor (wand) to
the X or Y port using the cable (part number 9922-127).
The optical sensor should turn on when the control unit is
turned on (if the cable is attached), when connected to a
powered up control unit, or when the optical sensor
power button is pressed.

To turn off the control unit, press the power button. To
turn off the optical sensor, press and hold the power but-
ton for 2 seconds. The control unit features a user-settable
auto-off timer that will shut off the instrument auto-
matically. The auto-off timer can be set for 5-60 minutes.
The optical sensor automatically shuts off in 30 minutes if
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no button is pressed (unless configured for automatic
logging or connected to a control unit).

Console Auto-off Timer
To set the auto-off timer on the Control Unit (console),
press theMENU button, select Console Setup, then
Auto-off Timer. Set the timer as desired and press OK
to save the settings.

Monitor Mode Navigation

X1: 634.0710

X2: 727.1623

Y1: 0.0000

Y2: 0.0000

When the LAI-2200C is
turned on, Monitor
Mode (right) will be dis-
played. Observe the vari-
ables called X1, X2, Y1,
and Y2. These are values
from rings 1 and 2 from
the X and Y sensors. Each row of the Monitor Mode
screen can be set to display any one of the values in
Table 3-1 on the facing page.

X1,...,X5 Readings for Wand X, rings 1-5

Y1,...,Y5 Readings for Wand Y, rings 1-5

gLAT: Latitude

gLNG: Longitude

gALT: Altitude

gSAT: Number of Satellites used

gHDOP: Horizontal Dilution of Precision

gUTC: UTC time (YYYY/MM/DD, HH:MM:SS)

T: Time (HH:MM:SS)

Table 3-1. Variables that can be displayed in Monitor
Mode.
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D: Date (YYYY/MM/DD)

BATT: Battery Voltage

1: Readings for Light Sensor 1

2: Readings for Light Sensor 2

Table 3-1. Variables that can be displayed in Monitor
Mode. (...continued)

X1: 634.0710  

X2: 727.1623

Batt: 5.80

T: 03:24:48

To change variables on
the display, press the up
or down arrow to select a
field. The active field will
be highlighted for about
1 second. Press the right
or left arrow button to
scroll through available variables.

Basic Menu Navigation
Main Menu
 Wand Setup
 Log Setup
 Data
 Console Setup
 Firmware

Basic navigation through
menus is accomplished
with the upper block of 9
keys. When viewing a
menu (press theMENU
button to view the Main
Menu, shown at right),
the selected menu level will be highlighted. Press OK or
the Right Arrow to select the highlighted menu option,
press the Left Arrow key to go back a menu level or
toggle field settings, and press EXIT once to return to
the Main Menu or twice to return to Monitor Mode.

Setting the Clock
Be sure to set the clock on both the console and optical
sensors. The console clock can be set manually (Pro-
cedure 1.1 - Setting the Console Clock Manually on
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page 8-17) or by using the time information from the
GPS (Procedure 1.2 - Setting the Console Clock from GPS
on page 8-17). Once the clock is set, you can syn-
chronize an optical sensor to the console (Procedure 1.4 -
Synchronizing Wand and Console Clock on page 8-18).

Note: If using two optical sensors, the clocks in both
must be synchronized in order to match data in time.

Calibration and Match Values
Every wand has two sets of 5-number calibration values:
the “permanent” set (accessible viaMENU >Wand
Setup > Cal Values) and the “working” set (MENU >
Wand Setup > Match Values). The match values are
always used when the wand is making measurements,
while the cal values (which are printed on each wand’s
calibration sheet) are there to serve as built-in reset val-
ues. For more details on wand calibrations, see Wand
Calibrations on page 5-32.

The simplest thing to do with the match values is to
reset them to the calibration values (see Procedure 1.5 -
Resetting Wand to Factory Calibration on page 8-19), and
then leave them alone. With the factory calibration val-
ues in place, the ring values of the wand will all read the
same when in an isotropic environment, allowing the
sky brightness distribution to be measured, which is an
important step when doing scattering corrections. The
calibration does not ensure that two wands will read the
same absolute brightnesses, however, so when two
wands are used to obtain data for computing LAI (one
wand above the canopy, one below), then an adjustment
needs to be made. Further details are in Multiple-Sensor
Operation Revisited on page 5-21.
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Overview of Configurations
The settings described in Wand Setup below affect the
selected wand and are stored on the wand. Those
described in Log Setup on the next page affect the global
template and will be applied to any new file that is cre-
ated on the control unit. Settings that affect how LAI is
computed are stored as part of each file. The procedure
for changing the settings of a file (post processing data)
is described for the console in Data Management on the
Console on page 3-20 or with FV2200 in chapter Data
Analysis with FV2200 on page 7-1.

Wand Setup
Certain pieces of information are stored on each optical
sensor. You may wish to change or view these settings.
They are described below. In order to access these set-
tings, one or more wands must be connected, and you
must select a wand.

Set Name: You can name each wand (up to 8 alpha-
numeric characters). The name is stored on the wand
and can be viewed when the wand is connected to a
console.

Clock: Set the wand time by synchronizing with the
console clock or entering the time manually.

Cal Values: View/Edit the five back-up calibration val-
ues. These values are shown on the wand’s calibration
sheet.

Match Values: Access the five working cal values:
view/set values to directly edit or reset them, and
calculate values for matching two wands.

Auto Log: The control panel for setting up automatic
logging for wand.
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Log Setup
Basic parameters can be set prior to collecting data. For
most applications the default settings will work fine, but
the preferred settings will vary depending on the applic-
ation. Most of the following settings can be changed for
a file after data has been collected as well. The following
items are in theMain Menu > Log Setup menu:

Transcomp: Defines how transmittance is computed
(including which readings (A or B) are used for
above-canopy readings, how they are used, and what
the instrument does with transmittances >1.0). These
settings are described in detail in the table below.
Normally, A readings are above canopy, and B read-
ings are below. The software can also be set to determ-
ine which is above and which is below by comparing
the readings (ring by ring) of successive A/B pairs or
records until it finds a pair for which every ring of
one is consistently higher than the corresponding
ring of the other. The ID of the higher record,
whether A or B, is assumed to be the above record ID
through the rest of the file.

Transcomp Setting Description

Define Above
A (Default) A records are

Above, B are Below
B B records are Above, A are

Below
Compare Find which is Above and

which is Below
Determine Above
Previous (Default) Use the previous

Above record
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Transcomp Setting Description

Interpolate Interpolate between the
nearest (time) Above read-
ings

Closest Use the closest in time
Above record

Bad Readings (when a Below record has values that
exceed those of a corresponding Above record)
Skip (Default) Skip that record
Clip Force the transmittance

(Below/Above) to be 1.0 for
that ring

Prompts: Two prompts can be defined, and responses
can be entered during data collection for each file.

Obs Remarks: An observation remark can be entered
for each data record. This remark is edited in the log
setup menu, and can be changed for individual
records by pressing the Menu key while in Logging
Mode.

Angles: This provides access to the angle values asso-
ciated with each ring. There is no need to change
these values.

Distances: The distance vector consists of five values
used in calculation of contact numbers for the five
rings of the optical sensor. Use the default values
unless you are measuring an isolated crown of a
plant. Refer toThe DISTS Vector on page 6-14 for more
information.

Masks: The mask determines which rings are used
(default = all) to compute LAI. Data from rings that are
ignored are still measured and recorded, however, so
nothing is lost even if a data file is generated with all
rings ignored.
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Controlled Sequence: A sequence of A and B read-
ings can be defined.

Console AutoLog: Activate and set up automatic log-
ging with wand(s) attached to the console.

PAR Sensors: Activate, name, and enter the cal-
ibration multipliers for LI-COR Light Sensors here.

GPS: Activate the global positioning system and choose
settings for when GPS data are recorded.

Console Setup
The Console Setup menu (Main Menu > Console
Setup) provides some basic setup options:

Set Time: Set the instrument time, as described in Set-
ting the Clock on page 3-3.

Auto Off Timer: Set the duration that the control unit
will remain powered on after no buttons have been
pressed (5-60 minutes, increments of 5 minutes).

Beeper: Turns the console beeper on or off.

Attached vs. Autonomous Configuration
In this section you'll find an overview of the ways that
you can use the wand to collect data: attached to the
console or autonomously (detached from the console).

Attached Configuration
This is the configuration used when an optical sensor is
attached to the control unit. The main advantage of hav-
ing the sensor attached to the console is real-time dis-
play of measured or computed values. When in log
mode, pressing the wand or console LOG button adds
data to the file on the console, not the wand, and LAI
calculations are updated for that file. In the console
autolog configuration, logging occurs at set intervals
without pressing the LOG button (see Logging Con-
figurations on page 3-14).
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Autonomous Configuration
This is useful for logging above canopy readings well
away from the console, for later import to the console.
Data can be logged manually (press LOG) or auto-
matically (Logging Configurations on page 3-14) on an
unattached wand, and later transferred to the console
and merged with below-canopy readings. Note that you
can also use a wand by itself to make complete one-
sensor readings of a canopy: Just label above and below
readings appropriately using the A/B button, transfer
the result to a file, and recompute that file. However,
since records stored on a wand accumulate in one big
file, this method is not convenient for generating mul-
tiple LAI files, unless you keep careful track of starting
and stopping times, so you'll know how to parse the file
later.

Operating Modes: One and Two Sensor Modes
You can collect data with one or two wands, as
described below.

One Sensor Mode
The simplest operating mode is to use one sensor for
above and below readings. A sequence of readings can
be predefined if attached to a console (see Logging Con-
figurations on page 3-14), or determined “on-the-fly” by
using the A/B key on the wand keypad. The basic pro-
cedure for using this mode is described in Operation:
One Sensor, One Control Unit on page 3-17.

Two Sensor Mode
Two-sensor mode simply means that there are two (or
more) sensors involved in collecting data. There are
some possible combinations here:
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A One sensor detached. This is the usual configuration.
The detached sensor can stay in an adequate clearing and
automatically log above canopy records. Later, the logged
readings are transferred to a file in the control unit, and
selected records (those closest in time to the recorded
below canopy records) will need to be imported from there
to the below canopy files.

B Both sensors attached to a control unit. This
configuration has limited usefulness, since the sensors
can’t be very far apart. However, in a short canopy with very
changeable sky conditions, this can be a reasonable
approach, provided there is an extra person (or a tripod) to
hold the above sensor. This method does put bothA and B
records in the same file, so later import is not needed.

C More than two sensors, or mixed sensors. In a
large experiment, there might be several LAI-2200Cs and/or
some older LAI-2000 units in use simultaneously. Typically,
one sensor would still be doing theA readings, while all the
others are collecting B data. FV2200 is then used to com-
bineA and B readings.

Matching Sensors
When using two or more optical sensors, they need to
be matched so that they read the same thing under the
same conditions. This can be done by console matching
or FV2200 matching. The recommended method is
FV2200 matching. This involves collecting data from
both sensors that can later be used to adjust one set of
readings in post processing using the FV2200 Software
package. There are multiple ways to do this, and they
are discussed in Multiple-Sensor Operation Revisited on
page 5-21.

Console matching, desribed in Procedure 2.1 - Making
Two Wands Match - Console Matching on page 8-23, is the
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required method when both optical sensors are attached
to the console while logging (only possible with short
canopies). Console matching cannot be used with light
scattering correction.

Setting Prompts
There are two prompts for storing additional inform-
ation with each data file. Each prompt can be defined so
that it requests a specific type of information, such as
“What” and “Where”. For the “What” prompt, you
might enter a habitat type, and for the “Where” prompt,
you could enter the location. After they are defined, you
can enter up to 8 alphanumeric characters in each of the
prompt fields when you create a new data file. To set
prompts:

1 Press theMenu button, then go to Log Setup and select
Prompt.

2 Enter the desired prompts in the Prompt1 and Prompt2
fields. If you wish, you can enter default responses, or leave
the Resp1 and Resp2 fields blank. Either way, you will be
able to enter responses in the Resp1 and Resp2 fields
when you create a new data file.

Creating Data Files
An LAI measurement is made by collecting above and
below readings in a file. Follow the steps below to cre-
ate a new file:

1 With the instrument on, press the START|STOP button.

2 SelectNew File and enter a file name (a maximum of 8
characters or numbers). File names are automatically gen-
erated based on the previous entry, incremented by one digit.

3 View/Edit Prompts, and/or pressOK.
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The LAI-2200C is now in Logging Mode (below).
Log A and B readings.

4 Press START|STOP (or EXIT) to save the file and quit.

Logging Mode
After a new file is created (see above), the console will
enter Logging Mode, which is used to log data to the
open file. In Logging Mode, the display will show four
lines of data. The Status indicator line is always dis-
played, along with three of the following fields:

Field Description

A:#B:# # A readings, # B readings
T: Time (HH:MM:SS)
D: Date (YYYY/MM/DD)
BATT Battery Voltage
1 or 2 Readings for Light Sensor 1 or 2
X1,...,X5 Readings for Wand X, rings 1-5
Y1,...,Y5 Readings for Wand Y, rings 1-5
gLAT: Latitude
gLNG: Longitude
gALT: Altitude
gSAT: Number of Satellites used
gHDOP: Horizontal Dilution of Precision
gUTC: UTC time (YYYY/MM/DD, HH:MM:SS)
SEQ: Off or AB (to indicate controlled sequence)
LAI: Current Leaf Area Index
SEL: Standard Error LAI
MTA: Mean Tilt Angle
SEM: Standard Error MTA

Use the arrow keys to change what is displayed in the
other fields. These changes are saved automatically.
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READY  X:A Y:-

A: 0 B: 0

LAI: 0.00

SEL: 0.00

Status Indicator: 

READY when waiting 

for data, WAIT when 

processing data.

Optical Sensor Status: indicates 

which sensors are connected 

and whether the sensor is set for 

an Above or Below reading. 

Here, a wand is connected to  

the X terminal and it is set to log 

an Above reading.

# of A readings

# of B readings

Leaf Area Index 

calculated from the 

current data.

Standard Error of LAI.

You can also enter the “Log Setup” menu from the log-
ging menu (press theMENU key while in Logging
Mode). Any changes made here will only be reflected in
the current file, except changes to light sensors, which
will be retained even after exiting Logging Mode.

Computations During Logging
While logging data, the LAI-2200C provides real time
updates of some computed quantities, such as LAI.
These computations are always done with a
Transcomp setting of “xPx”. That is, the middle setting
(Determine Above: Previous, Interpolate, or
Closest in time) is always P (Previous), regardless of
what you have selected. This is out of necessity, because
there is no way to interpolate or choose the closest
“Above” reading before all the “Above” readings have
been made. When you are done logging and close the
file, if the file needs to be recomputed because of this
mismatch, (or for other reasons, such as logging to an
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existing file), you will be prompted with Compute
file?. If you respond with OK, the file is recomputed
and stored. If you decline the recomputation, the file is
stored without being recomputed. It can be recomputed
at a later time.

Logging Configurations
This section includes basic procedures for logging LAI
data using various configurations.

Manual Sequence with Sensor Unattached
A manual sequence is the simplest way to collect data
with the LAI-2200C.

Follow these steps to manually log LAI data with the
optical sensor unattached:

1 Disconnect the wand from the console and power it on by
pressing theA/B|Power button.

2 Select Above or Below with theA/B|Power button.

3 Position the sensor and press LOG to record a data
value. Each record will be tagged with an A or B,
depending on settings.

The records must be moved to the control unit for view-
ing and processing. Procedure 2.13 - Moving Wand Data
to the Console on page 8-31.
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Manual Sequence with Sensor Attached
Follow these steps to manually log LAI data with the
optical sensor attached to the control unit:

1 Go toMENU > Log Setup > Controlled Sequence
> Use = No

2 Create a new file (see Procedure 2.2 - Opening a New Data
File on page 8-24).

3 Select Above or Below with theA/B|Power button.

4 Position the sensor and press LOG to record a data value.
Each record will be tagged with anA or B, depending on set-
tings.

Controlled Sequence
If a wand is attached to a console, then a controlled
sequence is an option. Specify beforehand what
sequence you want, (for example, ABBBB with 3 repe-
titions), and the console will automatically label logged
records accordingly. The ABOVE LED on the wand
(and the SEQ lines on the console) will indicate the next
required reading type. Follow Procedure 2.4 - Setting up a
Controlled Logging Sequence on page 8-25 to set up a
sequence.

Automatic Logging (Wand)
This configuration option allows you to set up an
optical sensor to log data at specified intervals, whether
or not the wand is attached to a console. Automatic log-
ging can be configured to record data values at intervals
from 5 seconds to 3600 seconds (60 minutes) in 5
second intervals. You can also specify the start and end
time and date for automatic logging. Automatically
logged data can be treated as A or B readings. Data
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points can be manually logged during auto-logging by
pressing the Log button.

To configure a wand for automatic logging, see Pro-
cedure 2.7 - Automatic Logging - Wand on page 8-27.

Automatic logging (Console)
A console can also be made to log automatically (Pro-
cedure 2.8 - Automatic Logging - Console on page 8-28).
Automatic logging can be enabled/disabled whether a
file is open or not, but the only time it actually occurs is
while a file is open. When a console autolog occurs, all
attached sensors (wands and light sensors) are logged,
and (if enabled) a G0 GPS record.

Transferring Wand Data
Data are stored in a wand under these conditions:

l Data logged because of automatic logging (attached
or unattached)

l Log button pressed while wand unattached (Manual
sequence with sensor unattached).

Wand data can be moved to the console and put in a
new file or import to an existing file.Procedure 2.13 -
Moving Wand Data to the Console on page 8-31.

Connecting Quantum Sensors
The light sensor connectors (1 and 2) on the LAI-2200C
accept LI-COR Quantum sensors (LI-190R or LI-191R).
Quantum sensors measure Photosynthetically Active
Radiation (PAR). The light sensor connectors are con-
figured to measure the signal (microamps) normally
provided by LI-COR light sensors.
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Follow Procedure 1.10 - Enabling a Quantum Sensor on
page 8-21 to enable a quantum sensor channel.

Making Basic Measurements
Now that you’ve become familiar with the operating
principles of the LAI-2200C and the instrument accessor-
ies, it is a good idea to make a few sample meas-
urements. Be sure to review the practical considerations
in Dealing with Sky Conditions on page 5-1 and Canopy
Types on page 6-1 prior to collecting actual data because
the use of improper measurement techniques will result
in poor data quality.

Operation: One Sensor, One Control Unit
To try out a basic measurement, you will need one
LAI-2270C Control Unit, and one LAI-2250 Optical
Sensor, then follow Example 1 - One Sensor Measurement
without scattering correction on page 8-1. You can do this
in an actual canopy, of course, or simulate the canopy in
the following manner:

1 Go somewhere with a good view of the sky, and use a 90
degree view cap when makingA (above canopy) readings.
Keep the sun out of the view.

2 Simulate B (below canopy) readings by aiming the sensor in
the same direction as the above reading, but substituting a 45
degree view cap instead.

This will theoretically give you gap fractions of 0.5 for
each ring, which will result in a leaf area index (LAI) of
about 0.86 and a mean tilt angle (MTA) of 39 degrees
(with default settings, and a uniform sky - see Figure 5-1
on page 5-4).
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Once you have gotten familiar with a basic meas-
urement, you will want to add scattering corrections.
These are described in Dealing with Scattering on
page 5-6. To try out a basic measurement with scattering
corrections, you will need an actual canopy. Follow
Example 2 - One Sensor Measurement with Scattering Cor-
rection on page 8-2.

Operation: Two Sensors, One Control Unit
To try out basic two sensor operation (Example 3 - Two
Sensor Measurement without scattering correction on
page 8-3) you will need one LAI-2270C Control Unit,
and two LAI-2250 Optical Sensors. The first decision to
be made involves how you wish to deal with matching
the sensors. The approaches are described in Three Meth-
ods for FV2200 Matching on page 5-22. You may also
choose to completely ignore the matching issue while
you get familiar with two sensor operation. In that case,
you will be following the steps for "Match Method 1" as
you follow Example 3, since that one allows you to com-
pletely ignore all matching while collecting field data.

When you are ready to do actual measurements with
two sensors, follow the instructions under Procedure 1.8 -
Build a Match File for Two Sensors (Match Method 1) on
page 8-19. We recommend that you do "Match Method
1" and make a match file for your two sensors. Once
that is done, the only time you would then deal with
matching is when you import and adjust A records
using FV2200 during post-processing (Procedure 3.6 -
Interpolating A Records - FV2200 on page 8-37).

Scattering correction on data collected with two sensors
requires a bit more planning and field work, and you
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have several options. See the discussion in Protocol
Suggestions for Direct Sun on page 5-30.

Importing A Readings from Separate Files
(Console)
When A readings are collected autonomously, they need
to be imported by the file that holds the B readings
before LAI can be computed. This can be done on the
control unit (described below) or with the FV2200 soft-
ware see (Procedure 3.8 - Import A and Adjust A Records -
FV2200 on page 8-38).

Note: Importing on the console is not recommended
if the files are large, or if the two sensors have not
been matched

1 If it hasn’t been done already, transfer the records from the
wand to the console: Go toMENU > Data > Wand >
Download > select wand. Choose Create new file
and name the file.

2 Go toMENU > Data > Console and select the file that
is to receive the imported records. Select the file that has the
B readings.

3 Select Edit from the menu, then select Import Obser-
vations.

4 Choose to importA records.

5 PressOK and the file will be recomputed using the imported
records.

6 LAI values will recompute automatically and can be viewed at
MENU > Data > Console > select file > View
Header.
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Data Management on the Console
In the following section, you'll learn about ways you
can manage data and files on the console.

File Quick View
To view a summary of a file, navigate toMenu > Data
> Console > select data file > Quick View. The file
header is presented:

Quick View:
File Name – The name of the file
Date and Time – Date file was created
Response1 and 2 – Responses to prompts 1 and 2
LAI – Leaf Area Index for the file
SEL – Standard Error LAI
ACF – Apparent Clumping Factor
MTA – Mean Tilt Angle
SEM – Standard Error MTA
DIFN – Diffuse Non-interceptance
SMP – Sample Size
gLAT – Average Latitude
gLNG – Average Longitude
gALT – Average Altitude
gHDOP – Average Horizontal Dilution of Precision
gNUMF – Average number of satellites found

Viewing Data on the Console
To view data in a file, go toMENU > Data > Console
> select data file > View. The following options are
presented:

View Header:
File Name – The name of the file
Date and Time – Date file was created
Response1 and 2 – Responses to prompts 1 and 2
LAI – Leaf Area Index for the file
SEL – Standard Error LAI
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ACF – Apparent Clumping Factor
MTA – Mean Tilt Angle
SEM – Standard Error MTA
DIFN – Diffuse Non-interceptance
SMP – Sample Size
gLAT – Average Latitude
gLNG – Average Longitude
gALT – Average Altitude
gHDOP – Average Horizontal Dilution of Precision
gNUMF – Average number of satellites found

View ANGLES/MASKS:
Displays angles and masks used for each ring.

View CNTCT#/STDDEV:
Displays contact number and Standard Deviation for
each ring in the current file.

View AVGTRANS/GAPS:
Shows average transmittance and gap fraction for the
current file.

View DISTS/ACFS:
Shows the distance vector (path lengths) and apparent
clumping factor for each ring.

View Observations:
Shows values for individual readings. Use the left and
right arrow keys to navigate through the list.

Reprocessing Data on the Console
A set of basic data processing features are available on
the LAI-2200C Control Unit. Refer to Data Analysis with
FV2200 on page 7-1 for advanced data processing with
the FV2200 software. To edit data that are stored on the
control unit, go toMENU > Data > Console > select
data file >Edit:
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Edit Angles to change the angles (normally, the default
values should be used).

Edit Mask to apply a mask to one or more rings.
Masked rings are ignored when LAI is computed. The
data for masked rings is retained in the file.

Edit Distances to change the default distances. This is
useful for measuring isolated canopies (see Example 7
- Isolated Tree on page 8-10 for an example).

Edit Transcomp to change how transmittance is com-
puted. See Log Setup on page 3-6 for a detailed explan-
ation.

Import Observations to import A records from
another file to the current file. This command
imports all A records or just the ones that are closest
in time to the existing B records in the target file.

Strip Observations to delete all A or B observations
from a file.

Additional Data Management Features
Three data management options, in addition to those
mentioned above, are available atMENU > Data >
Console Data > select data file. These include:

Recompute to recalculate LAI and other variables.
Delete to permanently remove the selected file.
Rename to rename the file.

Connecting to a Computer
The LAI-2200C has a USB connection that can be used
to transfer data to a computer.

Plug the USB cable into a USB port on your computer
and the LAI-2270C Control Unit. The LAI-2200C is
recognized as a USB mass storage device when it is
attached to a computer (PC, Mac, Linux platforms are
supported). The LAI-2270C will not be recognized if it is in
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Logging Mode or a menu, so be sure to enter the Monitor
Mode by pressing EXIT, or just turn off the control unit.

When it appears on your desktop, the name of the
LAI-2200C will be LAI unless it has been renamed.
Inside the LAI directory, you will find a folder named
Data, and inside Data you will find your logged data
files.

These files can be manipulated in the normal ways: you
can rename them, copy them to your computer (drag-
and-drop or cut-and-paste), delete them, and open them
with an application (FV2200, a spread sheet, etc.). You
can also create other directories on LAI, and move any
sort of file to them, but only files within the Data folder
will be accessible to the console’s software.

In the root directory of LAI, you may see some files
with .bin and .img extensions. The .bin and .img files
hold copies of the firmware for the console and wand.
Updating console or wand firmware involves down-
loading new files using the FV2200 "Check for Software
updates" (Help > Check for Software updates >
ShowWand and Console Information), putting
them in the root directory of LAI, and then telling the
console to do the update (see Instrument Firmware on
page 2-12.

To disconnect the console from the computer, eject it
before unplugging it—just as you would with any USB
storage device.

Global Positioning System
A Global Positioning System (GPS) is integrated into
the console of the LAI-2200C (or the LAI-2200 with the
2200CLEAR upgrade kit). When GPS is active, real-time
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location data can be viewed in monitor mode. The
FV2200 computer software uses GPS data for scattering
corrections and mapping.

Configuring GPS
In addition to displaying Latitude, Longitude, Coordin-
ated Universal Time (UTC), and other GPS data in real
time, the control unit can be configured to log GPS data
in three ways: averages in the file header, associated with
measurement records, or with GPS tagging.

l In the file header:When there are G records
(GPS records) present in a file, averages are included
in the file header (". File with GPS records as viewed
on a computer with FV2200." on the facing page).

l With measurement records: When an Above
and/or Below record is logged, GPS data for that
same place and time are logged in the same file, next
to the associated measurement record. The record
identifier for these GPS records will be G0 (Figure
3-1 on the facing page).
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Figure 3-1. File with GPS records as viewed on a computer
with FV2200.

l GPS Tagging: If GPS is active (step 2 below) and a
file is open, you can log a GPS record by itself. Sim-
ply press a numeric key (1–9) on the console. The G
record identifier will be G1–G9, depending on the
key that was pressed. This allows you to mark areas
in your plot (the corners, for example) while making
measurements, without logging spurious sensor read-
ings (Figure 3-2 on the next page).
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Figure 3-2. Plot marked by GPS Tagging. At each corner of
the plot, the "1" key was pressed while a file was open to log
a GPS record. A different numeric key could be used to mark
other plots in the same file.

Use these steps to activate and configure the GPS:

1 On the console, go toMENU > Log Setup. SelectGPS
(bottom of list).

2 Press the right arrow key to selectActive–On. GPS data
will now be displayed on the console in monitor mode. Press
OK to finish, or go to step 3 to enable GPS logging.

3 Press the down arrow key, then the left arrow key to select
Log GPS–Yes.

4 Press the down arrow and then selectWhen–A, B, or
Any. PressOK. GPS data will now be recorded with every
Above reading, every Below reading, or with any reading.

GPS Fix Quality
HDOP, one of the variables in G records, stands for
"Horizontal Dilution of Precision". It is a measure of
the geometric quality of the configuration of satellites in
the sky. The lower the number, the better the
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configuration and the better the fix quality. If all satel-
lites are grouped close together, the triangulation gets
worse, and HDOP goes up. An HDOP under 2 is very
good. If HDOP is above 5, the GPS may not be seeing
enough satellites in the right configuration for a good
fix.

Mapping
The map tool in FV2200 allows the export of location
data as a .kml file for Google Earth, with several choices
including a 3D representation of LAI along a path (see
Make a GPS Plot on page 7-6).

About Data Files
In this section we describe the files that are created by
the LAI-2200C. Files generated by the LAI-2200C are
text based and consist of four basic parts: Header, Stat-
istics, Sensor Information, and Observations (see Figure
3-3 on the next page).
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Figure 3-3. Data file as viewed on a computer.

Header
The header is a group of fields at the top of the file. It
includes the file name, console firmware version, time
stamp indicating when the file was created, and user
remarks. The remaining part of the header contains the
result of LAI calculations: leaf area index (LAI), standard
error LAI (SEL), apparent clumping factor (ACF), dif-
fuse non-interceptance (DIFN), mean tilt angle (MTA),
standard error MTA (SEM), and the number of pairs of
Above and Below observations that were included in the
calculations (SMP). If GPS logging is enabled, average
latitude (GpsLat), longitude (GpsLong), altitude
(GpsAlt), number of satellites used (GpsNum), hori-
zontal dilution of precision (GpsHDOP), and
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coordinated universal time (GpsUTC) are visible in the
header.

Statistics
The statistics group contains 8 groups of 5 numbers:
MASK indicates which rings were included in cal-
culations (1 indicates the ring is included, 0 indicates
omission). ANGLES are the midangles of the field of
view for each of the 5 rings. CNTCT# are the mean con-
tact frequencies (the logarithm of the gap fraction
divided by the path length), STDEV are the standard
errors of the contact frequencies, DISTS are the path
lengths, and GAPS are the gap fractions. ACFS is the
apparent clumping factor for each ring, and
AVGTRANS is the average transmittance for each ring
in the file. Theory on page 10-1 discusses how these
quantities, as well as those in the header, are computed.

Sensor Information
This field indicates which sensors were used to record
the data and the name of the wand used. The five values
to the right are matching values for each ring in the
sensor. If quantum sensors are connected to port 1 or 2,
the light sensor name and calibration information is in
this field as well.

Observations
The Observations each have a label (A or B indicating
above or below the canopy), a sequential number, a
time stamp, and the readings from the five rings of the
detector. In this example, the first four samples (B read-
ings 2 through 5) use A reading 1 as a reference. The
next four samples (B readings 7 through 10) use the A
reading 6 as a reference. If enabled, GPS observations
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are labeled G. Light sensor observations are labeled 1 or
2.

What do the Results Mean?
LAI is the answer to the question “How much foliage?”.

Although LAI nominally means “leaf area index”,
please remember that the LAI-2200C is measuring all
light-blocking objects, so “foliage area index” is more
appropriate. LAI is dimensionless, but it can be
thought of as {m2 one-sided foliage area/m2 ground
area}. However, if the Model is not Horizontal (that
is, if the DISTS values have been changed to reflect
measurements of an isolated plant instead of an
“infinitely” horizontal canopy), then the LAI value is
foliage density (foliage area in m2/canopy volume in
m3). SeeComputing LAI on page 7-8.

SEL is Standard Error of LAI (Lse).
ACF is Apparent Clumping Factor. It is equivalent to

the apparent clumping index Ωapp defined by Ryu, et
al (2010). One of the assumptions the LAI-2200C
makes is that foliage positioning is random - if not for
the entire canopy, at least for parts of it. For example,
consider a widely spaced row crop: The randomness
assumption is clearly wrong when considering the
entire field, but is much better when considering just
one row. Lang and Xiang (1986) showed that in cases
like this, if multiple transmittance measurements are
made so that each contains either mostly row or
mostly gap in its view, they can be combined by aver-
aging the natural logarithms of the transmittances to
give the correct leaf area index. For this reason, the
LAI-2200C combines multiple transmittance readings
by averaging the natural logarithms of the trans-
mittances when computing LAI. The ACF value is
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where LAIlog(avg(T)) is the leaf area index computed by
taking the log of the averaged transmittances, and
LAIavg(log(T)) is that reported by the LAI-2200C (com-
puted by averaging the logs of the transmittances).
Note that the simple averaged transmittances for each
ring are reported in the statistics block of the file,
after the label AVGTRANS, while the log-averaged
transmittances are reported after the label GAPS.
Ring by ring values of ACF are shown after the labels
ACFS.

The purpose of ACF is to provide a way to "undo"
the avg(log(T)) protocol used by the LAI-2200C to
combine readings. Why would you want to do that?
If, for example, you had an independently determ-
ined clumping factor Ω (determined, for example,
from a gap size distribution measurement) for a can-
opy that you wished to apply to the LAI-2200C res-
ults, you would need to do this to compute a true
LAI (Ftrue)

3-2

LAI × ACF undoes the clumping factor compensation
inherent in how the LAI-2200C works, and allows the
independently determined clumping factor Ω to be
applied.

MTA answers “How is the foliage oriented?”. If all the
foliage were horizontal, then the correct MTA would
be 0°; if all were vertical, MTA would be 90°. This
information may not be of particular interest to every-
one, but it is wise to make sure the numbers seem at



LAI-2200C Plant Canopy Analyzer Instruction Manual

3-32

least reasonable. Typically, MTA will range from the
30s to the 60s, but an unexpected MTA value can
indicate something wrong with the measurement or
the DISTS values.

SEM is Standard Error MTA.
DIFN is calculated by integrating gap fraction (GAPS)

to yield a value that indicates the fraction of sky that
is not blocked by foliage. This value ranges from 0
(no sky visible to the sensor) to 1 (no foliage visible
to the sensor). DIFN is in essence a single value rep-
resentation of canopy structure, as it combines LAI
and MTA into one number. However, DIFN does not
depend on the same assumptions that go into LAI
and MTA, but only depends on the assumption of no
scattering by the foliage. Of all the values computed
by the LAI-2200C, DIFN comes the closest to being
an indicator of “canopy light absorption”. However,
canopy absorption involves not only canopy structure
(DIFN), but also the foliage spectral properties in the
wavelength range of interest (for example, the pho-
tosynthetically active 400 to 700 nm region) for the
foliage and the surface beneath the canopy, and the
location of the sun. Therefore, in terms of canopy
absorptance, DIFN is merely an indicator of the
absorption of diffuse, short wave (<490 nm) radiation.

SMP is the sample size (total number of below canopy
readings).
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Section 4.
Measurement Guidelines
This section includes practical considerations for data col-
lection procedures and guidelines for collecting data under
a variety of conditions.

Guidelines for Getting Good Data
Collecting reliable data with the LAI-2200C depends on
having a protocol that is appropriate for the canopy of
interest and suitable for the measurement conditions. For
any A or B readings that are used as a pair, the view cap
must be the same size, the optical sensor (wand) must
view the same part of the sky, and the view cap must cover
the same part of the sensor (this only applies if the same
sensor is used for both A and B readings). These and other
considerations are discussed below.

Where to Measure?

A Readings
In general, A readings should be made as closely as pos-
sible to B readings, both in time and space; however,
under certain conditions and with the appropriate pro-
tocol, this is not essential to acquiring good data.

In some situations, especially in forest canopies, it may be
impossible or impractical to record A readings near the B
readings. In these situations, it is best to use two optical
sensors (see Operation: Two Sensors, One Control Unit on
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page 3-18), with one sensor positioned above the canopy
or in a clearing, logging data automatically. Additional
suggestions are in Canopy Types on page 6-1.

B Readings
It is best to consider a sampling protocol that is
designed for the canopy type that is being measured.
The best protocol for measuring a short homogeneous
canopy (such as a grassland) may not be the best pro-
tocol for measuring a row crop (and it certainly will not
be the best protocol for measuring a tall heterogeneous
canopy). Guidelines for measuring specific canopy types
are presented in Canopy Types on page 6-1.

One approach to collecting B readings is to make meas-
urements equally spaced along one or more transects
under the canopy. Alternatively, measurements can be
made at randomly chosen locations in the study area,
though practical considerations periodically make this
difficult. Predetermined sample locations may violate
the guidelines for usage and require adjustments to the
sample location in order to collect valid data. For
example, avoid making measurements with a leaf imme-
diately above the sensor, because one leaf may block the
entire view of the center rings. At the larger zenith
angles, when foliage is beside the sensor rather than
above it, an individual leaf blocks much less of the view.
The section called Foliage Size on page 4-8, provides
detailed guidelines for minimum distances and the the-
oretical justifications. Refer to Ross (1981) for guidelines
used for fisheye photography.

How Many B Readings?
When determining the proper number of B readings,
first consider the ground area over which the computed
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LAI is to be valid: An entire field? Part of a field? A
small plot? Second, what fraction of this area does one B
reading represent? As a rule of thumb, consider each B
reading to represent a sample of the canopy that is cyl-
indrical (or some fraction of a cylinder if a view cap is
used) with a radius roughly equal to the canopy height
(the potential view of the sensor is larger than this, but
the effective range is reduced by foliage). Thus,

4-1

where A is the ground area represented by the sample, f
is the view fraction (0.75, 0.5, 0.25, or 0.125 for the 270°,
180°, 90°, and 45° view caps respectively), and H is can-
opy height. For example, one B reading with no view
cap (f=1) in a canopy 5.0 m on a side and 1.0 m tall is a
sampling of approximately 3 m2, or 12% of the total
ground area. If that same canopy were only 0.2 m tall,
then one B reading would represent only 0.5% of the
ground area. Thus, canopy height is a very important
consideration.

Another consideration is the variability of the density of
the foliage in the plot. A homogenous canopy would
require fewer B readings than a heterogeneous one.
Table 4-1 on the next page provides guidelines for
determining the proper number of B readings. See Deriv-
ation of Formulae for Determining # of B Readings on
page 10-14 for the derivation.

This simple procedure is used to determine the number
of B readings necessary for 95% confidence that the true
LAI mean is within ±10% of the measured LAI.
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1 Make an LAI reading based on 6 B readings. Be sure to
include both the thinnest and densest parts of the canopy.

2 Divide the Standard Error of LAI by LAI (SEL/LAI)

3 Use Table 4-1 below to determine the number of B readings.

SEL/LAI #B Readings SEL/LAI #B Readings

0.01 2 0.06 11
0.02 3 0.07 13
0.03 5 0.08 16
0.04 6 0.09 19
0.05 8 0.1 23

Table 4-1. Guidelines for determining the appropriate
number of B readings.

Using View Caps
Use the 270° view cap to hide the operator from the
sensor any time measurements will be made with the
operator potentially in the field of view. No view cap is
needed if the operator is very careful to block exactly the
same portion of the sensor’s field of view for both A
and B measurements, but it is simpler to use the view
cap.

In general, any object that is common to both the A
and B readings will not affect the LAI computation.
Thus, one could measure the LAI of grass beneath a tree
if the A and B readings are in close proximity so that
the tree occupies the same portion of the sensor’s view
for both A and B readings.

Here is a summary of reasons to use a view cap:

1 To remove the sun from the sensor’s view

2 To remove the operator from the sensor’s view
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3 When sky brightness is very non-uniform

4 When there are significant gaps or clumps in the canopy

5 To reduce the required plot size

6 To reduce the required clearing size for above-canopy read-
ings in a forest

There are times when it is preferable to use the 180° or
270° field of view instead of a narrow one:

1 To avoid loss of signal near twilight or under very dense can-
opies

2 If the goal of the measurement is Le (effective LAI), not L (true
LAI).

Be very careful that the A and B sets of readings are
made with the sensor(s) viewing the same region of sky
without rotating the view cap on the sensor. This is
because there are usually slight azimuthal variations in
the sensitivity of the optical sensor’s detector, especially
on the outer ring.

When using the view cap to block the sun, it is good
practice to shade the entire lens from the sun, to pre-
vent light reflected from the surrounding view cap struc-
ture from influencing the readings. Usually it is only the
5th ring that responds to such reflections.

Measuring on Slopes
When making measurements on sloping terrain, there
are a couple of strategies that can be employed. One
method is to hold the optical sensor parallel to the
ground rather than level. Make sure that all associated A
and B readings are made with the sensor tilted at the
same inclination and pointed in the same compass dir-
ection.
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Figure 4-1. Tilt the sensor to match the slope.

One way to ensure that the sensor is held at the same
inclination for each reading is to mount the bubble
level on the handle rather than the sensor. Fix the hinge
at an angle that permits the handle to be held level
while the sensor is held at the desired inclination. Mark
the two pieces at the hinge so that this angle can be
reset easily (see Figure 4-2 below).

Figure 4-2. Level the handle, tilt the sensor to match the
slope, and mark across the hinge.

If it is impossible to incline the “above” and “below”
sensors at the same angle when measuring on a slope,
the effects can be minimized by using a 45° view cap,
and orienting the sensor for B readings along the con-
tour (looking neither uphill nor downhill). The A read-
ings need to be taken at the same compass direction as
the B readings.

Another way to minimize the effects of the slope is to
mask out the outer two or three rings in the analysis,
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either before (Procedure 2.10 - Excluding Rings from Ana-
lysis - Console on page 8-29 or after (Procedure 3.5 - Exclud-
ing Rings from Analysis - FV2200 on page 8-37) data
collection.

Sloping ground has some implications for scattering cor-
rections if you are measuring with the sensor parallel to
the ground (first method). This is discussed in K Records
and Sloping Terrain on page 5-10.

Bad Readings
Theoretically, B readings should always have lower val-
ues than A readings. In very sparse foliage they will be
very close, and in large gaps where no foliage is seen by
the sensor, they will be identical. But that is only in the-
ory.

As a practical matter, a B reading may exceed the value
of its A reading for any of the following reasons:

1 Changing sky conditions

2 Normal measurement variation

3 Operator error (A and B out of sequence)

4 Making B readings in sunlit foliage

A B reading is “bad” if one or more of the rings has a
value that exceeds its associated A reading, so that the
transmittance for that ring is greater than 1.0. If this is
due to operator error or changing sky conditions, it
would be good for the operator to be alerted so that the
measurement can be started over. But if a reading is bad
simply because of sparse foliage and normal fluc-
tuations, it would be nice for the console (control unit)
to overlook the slight discrepancy and proceed using a
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value of 1.0 for the transmittance(s) of the offending
ring(s).

To determine this setting, go toMENU > Log Setup >
Transcomp > and scroll down to Bad Readings.
Select one of the settings described below (press OK to
save the setting).

Skip:When a transmittance greater than 1.0 is found,
that B reading is ignored in the calculation. The offend-
ing record is still stored in the file, however. You will
know that a bad reading occurred if the number of B
readings is larger than the sample size in Logging Mode
(see Logging Mode on page 3-12). Skip should be used in
cases where A and B readings are not expected to be
very close.

Clip: If a transmittance greater than 1.0 is encountered,
it is considered to be simply 1.0. Note that this does not
change any stored values. This mode is useful when
measuring in canopies where B readings are likely to be
made under little or no foliage.

Foliage Size
As a general rule, the distance between the sensor and
the nearest leaf above it should be at least four times the
width of the leaf. When a view cap is used this distance
should be increased, but when more B readings are
taken the distance can be decreased.

Table 4-2 provides guidelines for determining the min-
imum distance from the sensor as a function of foliage
element size and zenith angle. To determine how close a
particular leaf size can be to the sensor, find the column
for the view cap being used in Table 4-2 on the facing
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page. Divide the values by the number of B readings to
be made and multiply the results by the leaf width (cm).

Table 4-2. Distance Factors.

The formula for determining whether a leaf is too close
to the sensor is:

4-2

where d is the distance factor from Table 4-2 above, B is
the number of B readings, and w is the leaf width (cm).

For example, with no view cap and only one B reading,
a 5 cm leaf should be 50 cm ((10/1)×5) away at 7°, 20
cm ((4/1)×5) away at 22°, and 10 cm ((2/1)×5) away at
68°.

Derivation of equation 4-2
One of the LAI-2200C assumptions (Assumptions on
page 1-7) is that the foliage elements are small compared
to the sensor field of view. Lang and Xiang (1986)
derived a formula for the error as a function of foliage
area and sample area: If R is the ratio of sample area
(the region over which gap frequency determinations
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are made) to the area of an individual leaf, then the
factor (E) by which the gap frequency is in error is

4-3

We apply this analysis to an LAI-2250 sensor by con-
sidering the sample “area” to be the distance around a
particular ring’s view at a distance from the sensor that
corresponds to the closest foliage. For example, the view
of ring #2 is centered at 22°. If the closest foliage at 22°
is 50 cm from the sensor, then the sample size for that
ring (assuming the full 360° view) is (2π)50(sin(22))-
)=118cm. If the leaf width is 5 cm, then R in equation 4-
3 is 118/5 = 24, and the error is 1.02 or 2%.

Table 4-2 on the previous page (Distance Factors) is for
an error (E) less than 5%, requiring the ratio of view cir-
cumference to leaf width (R in equation 4-3) to be at
least 10.6.
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Section 5.
Dealing with Sky Conditions
This section includes guidelines for collecting data under
various sky conditions. The LAI-2200C can be operated in
a range of daytime sky conditions, with appropriate adjust-
ments in measurement and/or post-processing protocol.

Best Sky Conditions: Clear, blue sky (at least in the part
of the sky viewed by the sensor) with the sun below the
horizon (twilight) or blocked by a convenient cloud.

Good Sky Conditions: Clear blue sky (or a few high thin
clouds) during sunlight hours. Interpolating above read-
ings over time works well under these stable conditions,
making tall canopies such as forests easy to measure with a
single sensor. Direct sunlight greatly increases scattering
errors, but this can be mitigated with scattering cor-
rections. See Sun on page 5-6.

Other Sky Conditions: Most other sky conditions (such
as broken or non-uniform clouds) can be problematic, and
need to be handled carefully. You will need to minimize
time differences between above and below readings, and
carefully align above and below readings to view the same
section of the sky. See Clouds below.

Clouds
A very uniform overcast can be good, but scattered or non-
uniform clouds represent the largest challenge for making
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measurements. The ideal LAI measurement involves
above and below canopy readings that see exactly the
same sky at exactly the same time. In practice, the sky
brightness is always changing with time and/or view dir-
ection, and hence does cause variability (random errors)
in the computed LAI, even without any canopy con-
siderations.

Cloudless blue sky is by far the easiest case to deal with.
It is stable, and small variations in view direction have
little effect on a sensor’s reading. A sunlit cloud, how-
ever, can be many times brighter than the blue sky sur-
rounding it, so slight variations in view direction can
have significant effects if such a cloud extends across a
particular ring’s view boundary. It is impossible to get
exactly the same view multiple times if the optical
sensor (wand) is moved between each one, so variations
in the readings are unavoidable. It is equally impossible
to get two separate sensors to have exactly the same
view, since there are very slight variations in the angular
response of each sensor. This section presents strategies
for dealing with these challenges.

Sky Variability Tests
It is easy to quantify a set of sky conditions in terms of
the potential error in LAI that it can produce. One
method of doing this is to make a series of A readings of
the sky. For example, mount a wand on a tripod and let
it log an A reading every 10 seconds for 10 or 15
minutes. The FV2200 software has a sky test (Procedure
4.1 - Sky Variability Test on page 8-44) that will select all
combinations of pairs of those readings, up to some spe-
cified maximum time separation, compute apparent LAI
for each pair, then plot LAI as a function of time sep-
aration.
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Figure 5-1 on the next page illustrates the results for four
condition: A) Cloudless, midday. B) Cirrus. C) Broken
cumulus, fairly windy. D) Heavy, non-uniform overcast.
Each condition was measured with A readings logged
every 10 seconds over about 30 minutes using a 45
degree view cap.

These examples illustrate the advantage of clear blue
sky, with LAI error of < .01 for A readings taken up to 5
minutes apart. On the other extreme, rapidly changing
clouds dictate readings as close together as possible.
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Figure 5-1. FV2200 Sky Variability Test.
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Sky Variability and Canopy Variability
There is another aspect of variable sky brightness that
will further increase the variability of LAI in a meas-
urement, and that is the canopy itself. The parts of a can-
opy that block the brighter part (e.g. cloud) of a sensor’s
view will be weighted more heavily than those that
block the darker part of the view (e.g. blue sky).

Dealing with Clouds
The two ways to deal with the variability that clouds
introduce are to 1) minimize the time between A and B
readings, and 2) increase the number of B readings that
you might otherwise take.

Timing
When there are clouds, the time between A and B read-
ings in a short canopy can be minimized simply by tak-
ing an A reading before every B reading. In a tall
canopy, that will not be practical with only one sensor.
In two sensor mode, the time can be minimized by mak-
ing the A readings more frequently. File sizes can be
kept manageable by a simple trick: Set the A unit to log
infrequently, say every 30 seconds. Once it starts log-
ging, note what part of the minute (on the below unit’s
clock) that the A unit logging takes place, and then only
log B readings as close as possible to those times. For
example, if the A unit is logging at 10 seconds and 40
seconds of each minute, then try to log B readings
within a few seconds of those times. (Operational aside:
autologging on an LAI-2200C wand is relative to the
start time only if you enable autologging prior to that
start time. Otherwise, it is relative to when you enable
autologging. That’s why it is simpler to just wait and see
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what the timing actually is after it starts logging. It also
saves you from having to synchronize clocks.)

Increase B Readings
With clouds in the sky, everywhere you would normally
take one B reading, take several in quick succession,
moving (view and position) just a little bit between each
one.

In summary, clouds can be a problem in that they can
introduce potentially large uncertainties into an LAI
measurement unless you take steps to minimize the
effect. By contrast, clear blue sky is easy to deal with. It,
however, brings with it another problem: direct sun-
light.

Sun
Measurements can be made in direct sunlight, if a) the
sun is always in the portion of the wand's view that is
masked by a view cap when making measurements, and
b) the measurements are corrected for scattering. While
clouds can cause random errors, scattering represents a
systematic error. Fortunately, scattering can be dealt
with by a few extra sky measure-ments at the time of
data collection, care in how measurements are made,
and some simple post-processing steps.

Dealing with Scattering
One of the traditional underlying
assumptions of the LAI-2000 and
LAI-2200C has been that foliage absorbs
all the radiation in the waveband seen
by the sensor (320-490 nm). Starting
with version 2.0, FV2200 allows this assumption to be
set aside and provides a mechanism (Kobayashi et al.,
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2013), for correcting measurements for the radiation
reflected and transmitted by the foliage. You should
apply this correction for data taken in direct sun, since
that’s when the scattering errors are the highest, but you
can also correct data taken when the sun is obscured,
adjusting for the actual foliage scattering properties in
your canopy, rather than assuming reflectance and trans-
mittance are both 0.

K Records
The scattering corrections require that a few extra sky
radiation measurements be taken in the field, in addi-
tion to measurements – or assumptions – of foliage
reflectance and transmittance. This sky brightness data
will ultimately – once the file is processed by FV2200 –
be contained in what we call a K record (K is for sky).
In order to make a K record, you typically need a
sequence of four A records, hereafter termed a 4A
sequence.

The 4A Sequence
The first two A readings in the 4A sequence use the
white diffuser cap (part number 6522-117). Follow these
steps to make a 4A sequence:

1 Diffuser cap in the sun. With your back to the sun, and the
sun shining on the diffuser cap, level the sensor, and take the
firstA reading.
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2 Diffuser cap shaded. Rotate just a bit to shade the diffuser
cap with the shadow of your head, and take the secondA
reading. If the sun is too high to shade the diffuser with your
head, hold the sensor with one hand and reach up and out
with the other to shade the diffuser. You want the entire dif-
fuser completely shaded, but not much more than that.

3 No cap, shaded. For the thirdA reading, remove the diffuser
and either shade the sensor with your head, or put a 270°
view cap in place. This reading needs to have the sun
blocked, but retain as wide a view of the sky as possible.
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4 NormalA reading. Use the same view cap and view direction
you are using for the associated B readings.

Ultimately, each LAI-2200C file that is to be scatter-cor-
rected will need to have at least one K record in it. This
does not necessarily mean that when you are collecting
data in the field, you need to do a 4A sequence in every
file. K records can be copied (by FV2200) into other
files that need them, so you can perform a 4A sequence
somewhere in a data file (beginning, middle, end, it
doesn’t matter when), or as part of a below-canopy file
if you are in two-sensor mode, or accumulate a series of
them into their own separate file. It is a simple matter
with FV2200 to turn 4A sequences into K records, then
copy them to whatever files need them. When FV2200
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copies K records, it does so based on time, and uses the
closest ones available in source files to the B records in
the destination file.

A complete example of using K records is given in
Example 2 - One Sensor Measurement with Scattering Cor-
rection on page 8-2, and a "guided tour" in A Scattering
Correction Example on the facing page.

HowMany K Records Needed
Sky conditions will determine how often K records (i.e.
4A sequences) are needed. The determining factor is
how fast the fraction of beam is changing. The simplest
case (as always) is clear blue sky. During the middle of
the day, one K record per hour would be fine. The
worst case is fast-moving scattered or broken clouds,
with the sun coming and going. The choice in those
conditions might come down to only taking data (A, B,
and 4A sequences) when the sun is between clouds, or
only taking data (A and B) when the sun is obscured
behind clouds (you know the fraction of beam is 0 then,
so you so don’t need K records), or waiting for a better
day.

Another consideration is if your measurement involves
multiple view directions. In principle, you should have a
K record for each view direction used. However, if your
view azimuths are symmetric about the solar azimuth (e.g.
sun is South, and your views are East and West), then
you would not need multiple K records unless there
were distinctly differing cloud formations in those two
directions.

K Records and Sloping Terrain
In steeply sloping terrain, we recommend keeping the
sensor parallel to the ground for A and B readings.
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SeeMeasuring on Slopes on page 4-5. This has some
implications for K records: The first two readings of a
4A sequence (with the white diffuser) should always be
made with the sensor level. The last two readings (wide
sky and normal A) should be made with the sensor par-
allel to the ground. Terrain slope information can then
be included with the other scattering inputs (see the
FV2200 User's Guide under the FV2200 "Help" menu),
so the solar angles can be adjusted appropriately.

A Scattering Correction Example
We present an example of making a single sensor meas-
urement complete with scattering correction. The steps
to do an example like this are summarized in Example 2
- One Sensor Measurement with Scattering Correction on
page 8-2. Here, however, we have a specific data file that
is included in the sample data files built in to FV2200.
This will let you follow along on data already taken for
you.

For this example we measured a site using 8 B records,
and a starting and ending A record. (Final A records are
only useful when you have interpolation enabled; we’ll
do that when we are done). Thus, the measurement
sequence without scattering corrections would be
ABBBBBBBBA. Because we are doing scattering cor-
rections, we need to replace at least one of the A read-
ings with a 4A sequence; we’ll replace the first, leaving
us with a measurement sequence that is
AAAABBBBBBBBA. Those first 4 readings are done as
shown in K Records on page 5-7.

You can load this data file into FV2200. Select Files >
Samples > ScatterExample.txt. The state of the file is like
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it just came from the field. The 4A sequence is there,
but hasn’t yet been turned into a K record.

1 You will want to add a variable named ScattCorr to the list
of displayed items in the main view of FV2200, if it is not
there already (Click theDisplay button, then theHeader
tab, and drag ScattCorr from the list on the left to the list
on the right). This field indicates if the scattering correction is
being done on a particular file, and if so, how big its effect. It
will be none with no scattering correction, off if the scat-
tering inputs are there but the scattering correction is turned
off, or a numeric value if the scattering correction is on. The
numeric value will be the increase in LAI due to the scattering
correction.
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If you wish to view the data records, double click the
File1 entry, and select the Current tab.

2 Click the Scattering Tool icon to open the Scattering Cor-
rection Tool, then click the K Records tab. Set the values
as shown.

Once the K records are made, the "Records" field in
the main view will show the change (Added 1 K,
‘removed’ 3 As).
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3 Click the Clipboard tab in the Scattering Correction Input tool,
and fill in the fields as shown. For information on obtaining
scattering properties, see Required Inputs for the Scattering
Model on page 10-12.

The file is now corrected for scattering, and the LAI
increased from 1.86 to 1.95.
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4 One final step would be to enable interpolation of theA read-
ings, since we have that finalA record in the file. If you do
that, following Procedure 3.6 - Interpolating A Records -
FV2200 on page 8-37, you will find that the LAI for this file
changes from 1.95 to 1.94.

When the scattering correction is applied (as evidenced
by the "ScattCorr" variable having a numeric value), all
computed values (LAI, MTA, GAPS, etc.) reflect the scat-
tering correction. The value of "ScattCorr" itself is the
difference in leaf area index (actually, it’s the difference
in the parameter EllipLAI, the leaf area index based on
the inversion scheme of Norman and Campbell (1989)
using the ellipsoidal representation of leaf angle. This is
the computation used internally when iterating through
the scattering correction model).

Other Ways to Make K Records
4A sequences are not the only way to make a K record.

3A Sequence
In settings where you cannot get a bigger unobstructed
view of the sky than is used for the normal A reading,
you can forego the wide sky view (the 3rd A of a 4A
sequence). FV2200 will use the last A reading in the
sequence for both the wide and narrow views. This of
course makes the assumption that the brightness dis-
tribution in the direction of your A readings is the same
as for the entire sky.

1A + Assumption
If your LAI data was collected with the sun obscured by
cloud, or below the horizon, then you already know the
fraction of beam is 0. If you are also willing to make the
assumption that the sky brightness distribution in the
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direction of your measurement is the same as for the
rest of the sky, then you can forego 3A or 4A sequences
entirely; FV2200 will let you build K records based on
the normal A readings in the file and your assumption
of the fraction beam value. This is also useful for cor-
recting old data for the effects of actual foliage reflect-
ance and transmittance.

Embedded Bs
Consider the following situation: You are in multi-
sensor operation mode, with one sensor devoted to A
readings, and other sensor(s) doing B readings. You
need to get K records from the A sensor, since that’s the
only one with a suitable clearing. Suppose further that
the A unit is just a wand that is automatically logging A
records at regular intervals, so there’s no chance of inter-
rupting autologging and putting 4A sequences into a
separate file. Can you get K records in this situation?
You can if there is enough time between autologs (prob-
ably at least 30 seconds) to do a few simple steps. When
it is time to get another K record, follow Procedure 2.12 -
Getting K Records on an Above Sensor on page 8-30. You
are essentially doing a 4A or 3A sequence, but labeling
all but the last as B records.

You will end up with a file filled with A records, with
occasional 2B or 3B sequences. The A record that imme-
diately follows each 2B or 3B sequence will also be
used to make the K record. Thus, a sequence of BBBA is
just like a 4A sequence, and a BBA is just like a 3A
sequence.

Again, this technique is only for above files that are oth-
erwise full of A records.

Note: This method will not work with the LAI-2000.
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Model Limitations for Scattering Corrections
The scattering correction is based on a simple model,
and how well it works in any particular circumstance
depends on how well those circumstances conform to
the assumptions of the model. A very fundamental
assumption of the model is that the canopy is one
dimensional (vertical), with foliage that can be clumped.
The sun is above the canopy looking down, and the LAI
sensor is below the canopy looking up. The model can-
opy is a good approximation to a fairly uniform, full
cover actual canopy. But how about other settings?

Here is a key factor in how well the model will predict
scattering errors: The model will fail when the relation
between gap fraction at any particular view angle and the
sunlit leaf area that is visible in that view angle differs from
what would be predicted in a horizontal canopy (Figure 5-2
on the next page).
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Figure 5-2. Representation of how the scattering model can
fail in an isolated canopy setting. Measurements A and B
have gap fractions PA and PB for a particular ring. In the
bottom part of the illustration, these are mapped to an ideal-
ized canopy in a layer with the same gap fraction at that
view angle. The problem in case A is that the measured sun-
lit area (and thus scattered radiation) is much larger than
the model would predict. This is seen by comparing the rel-
ative path lengths of sunlight through the canopy to get to
the ring's view in the measurement vs. the scattering model
(i.e. SA<S'A). In case B, the measured sunlit area is much
smaller then the model would predict. since SB>S'B.
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Another way to look at the problem presented by case A
in Figure 5-2 on the previous page is that unlike in the
model (sun above, viewer below), the viewer and the
sun are now effectively on the same side of the canopy.
And the lower the sun is in the sky, the more the meas-
urement will be dominated by sunlit leaf area, which
the model cannot begin to predict, since it assumes the
viewer is on the opposite side of the canopy.

Figure 5-3 on the next page illustrates the problem and
offers a clue about how to reduce the problem. If we
can choose a view direction that minimizes the dif-
ferences between the view path lengths through the can-
opy (they determine gap fraction) and the direct beam
path lengths through the canopy that determine sunlit
leaf area, then we might minimize the model’s errors. If
having the sensor look directly away from the sun, as in
Figure 5-2 on the previous page, maximizes the problem,
it suggests that viewing more toward the sun (the sun
can’t be in the sensor’s view, of course) might reduce
the problem.

This suggests the following measurement guideline for
canopies with significant gaps: As much as possible,
keep the sun in front of you, not behind you (Figure 5-3
on the next page).
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Figure 5-3. Measurement direction with direct sun. In
gapped or isolated canopies, if you are measuring with the
sun out and doing scattering correction, try to keep the sun
to the side or a bit in front. Avoid having the sun behind
you, especially if it is lower in the sky.

Testing the Model
Since no canopy fits the model, it is a good idea to test
your measurement protocol (and scattering correction
inputs) for each situation. A simple way to do this is to
pick a representative transect or plot and measure it (at
identical locations) when the sun is obscured, such as at
twilight, and compare those results with the scatter-cor-
rected results. Actually, you can scatter-correct both, but
the data set with the sun obscured will have an FBeam
value of 0. It’s best to do this sort of comparison under
clear blue sky, as clouds introduce their own variability
(see Sky Variability Tests on page 5-2).
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Multiple-Sensor Operation Revisited
Scattering corrections have some implications for multi-
sensor operations, so read this section even if you think
you are familiar with multi-sensor operation.

When two or more sensors are used to collect LAI data
(e.g. one sensor collects above canopy A records, the
other below canopy B records), two things have to hap-
pen to produce final LAI values:

1 Combining: TheA records and B records have to be com-
bined into one file. Normally, some of theA records are inser-
ted into the B file based on times of the B records.

2 Matching: One of the record types (A or B) must have its
values adjusted to account for calibration differences
between the two wands.

While it is possible to do both combining and matching
entirely on an LAI-2200C console, we highly recom-
mend that you use the FV2200 software for both of
these tasks instead. Here are the reasons:

l K records (i.e. 4A sequences, 3A sequences, etc.)
should be done with a wand with factory calibration
factors, not one matched to another sensor. FV2200
matching allows all wands to always use their factory
calibration values. This allows any wand to be used
for the K record precursors needed to do scattering
corrections.

l Console matching is done with one snapshot read-
ing, which is dangerous when there are clouds (see
Sky Variability Tests on page 5-2). FV2200 matching is
based on as many readings as you wish to average.

l FV2200 matching is not limited to two LAI-2200C
wands, like console matching is: it can be used for
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any number of wands, including old (LAI-2000)
instrumentation.

l Collecting the data for FV2200 matching can be
done anytime, not just at the time or place of data
collection. This means you can collect matching data
under the best sky conditions for matching (clear
blue sky), and in a place with the best view of the sky
(e.g. the roof of your building).

l FV2200 matching simplifies what needs to be done
in the field, reducing the chances for errors.

l Once the relevant files are on your computer,
FV2200 combining and matching can be done in
one simple step.

Three Methods for FV2200 Matching
There are three variations you can use to do FV2200
matching. The method you choose will depend on the
circumstances.

For this discussion, we will assume that there is a sensor
(the A unit) that is to be used for logging A records in a
clearing, and there is one (or more) B unit collecting
below canopy B records. Note that either “unit” could
be a) an autonomous wand, or b) an LAI-2000 or
LAI-2200C console and wand.

The three methods listed here are named for the setting
in FV2200 that you would use to do the match while
importing records. The FV2200 import dialog (Figure
5-4 on the facing page) lets you specify source files (the
ones with A records), destination files (the ones with B
records that need corresponding A records), and—
when needed—match files (files that contain some or all
of the information on how the sensors compare, so
adjustments can be made to imported A records).
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Figure 5-4. FV2200 Import Dialog.

Method 1: B / A Pairs in Match
Method 1 is the recommended method for matching
sensors. This method puts the match readings from both
A and B units into one special file, known as a match
file. This can be done before or after the measurements.
If you are careful about keeping lenses cleaned, this file
can be generated once and used over an extended period
(weeks, months, etc.). When you have a calibration ses-
sion, you might want to generate several files, one for
each view cap you might use. You could name the files
M45, M90, M180, for example, meaning they are for the
45, 90, and 180 degree view caps.

To make Match Method 1 file(s), follow the instructions
under Procedure 1.8 - Build a Match File for Two Sensors
(Match Method 1) on page 8-19, or Procedure 1.9 - Build a
Match File for More than Two Sensors (Match Method 1) on
page 8-21.

Figure 5-5 on page 5-25 shows an example match data set
for two sensors. The data reside in a file named 3213_
3214_Match.txt, and contains three LAI files with match
data for 3 view caps. Record types (A or B) in a match
file don’t matter for LAI-2200C files, since sensor serial
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numbers are recorded in data files and are used by
FV2200 when figuring out adjustment factors when
importing records.

Procedure 3.8 - Import A and Adjust A Records - FV2200 on
page 8-38 illustrates how to do match file adjustments
when importing A records.

The main advantage of Match Method 1 is that it elim-
inates all matching-related field work at the time of LAI
data collection. Just collect your LAI data and you’re
done; all the matching work has already been done. (Or
will be done; your calibration session could also happen
after the fact.)

The remaining two match methods involve collecting
matching data at the time of regular data collection. If
the sky is cloudless, then they can work as well as
Method 1.
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Figure 5-5. Sample match data for two sensors, PCH3213
and PCH3214. There are three files for three view caps, and
in each file several data pairs, all logged while viewing clear
blue sky. Since FV2200 uses serial numbers when applying
this data, it doesn’t matter what record types (A or B) the
sensors logged. They could be mixed (as shown), or all A, or
all B. If you are doing this with LAI-2000 format files, how-
ever, then the only way to identify sensors is by record type,
so the A records and B records in a match file should be
made by the same sensors as did the A and B records in
source and destination files. (You can convert formats, how-
ever, and avoid this constraint.)

Method 2: B (or A) in Match / A in Source
This method collects match data on-site, and creates a
match file that contains only the below canopy sensor’s
match readings; the corresponding above canopy
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sensor’s readings are in the above canopy file. The situ-
ation in which you might use this method is illustrated
below: There is a clearing in which the A unit will
reside, and a forest or other tall canopy in which one or
more B units will log a series of files along transects or
in plots.

1 Set up theA sensor and start it logging in a clearing at reg-
ular intervals in the Above file.

2 Before leaving the clearing, each B sensor makes a few
matching measurements next to theA sensor. Log these into
a file named "Match", or something to identify it as a match
file.
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3 Each B unit goes off and collects multiple below canopy files.
All have only B readings.

4 (Optional) Upon returning to the clearing, append a few more
readings into the Match file (or make a new match file),
before shutting down theA unit.

5 When importing theA records, use Match Method 2 to adjust
the readings based on corresponding readings between the
above file and the match file.

Method 3: A in Dest / A in Source
This method collects match data on-site, but does not
use a separate match file. Instead, each B file contains its
own match data, in that every B file contains at least
one A record that can be used for matching. To make
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this work, it must be possible for each B unit to get to
the A site and take at least one A record for each file it
creates. If that is not practical, then use Methods 1 or 2
instead.

1 Set up theA sensor and start it logging in a clearing at reg-
ular intervals in the Above file.

2 Begin the first B file with anA record logged alongside the
Above unit. Then go do the rest of the B records along the
transect.

3 (optional) You can then create other below files with only B
records if you like.
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4 End the final below file with anA record logged beside the
above unit.

5 For the below files with anA record (Files B1 and B2 in this
example) analyze them with Match Method 3.

You can also combine methods 2 and 3: If you have at
least one file done for method 3, you can use it (before
importing A records) as the match file for files with
only B records in them, using match method 2.

A potential advantage of Method 3 is that since you
have an A record logged, you can compute an LAI
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estimate in the field based on that one reading (if it is
done first, or if you pick the "closest in time" option for
using A records). That way, if disaster strikes (e.g. a bear
makes off with the A unit), you still have some results.

The obvious disadvantage is that you need to be able to
access the A site or a suitable clearing for each B file.
Also, like Method 2, it forces the matching to be done
at the time and place of the measurement, and that may
not result in the best match unless the sky is clear.

Protocol Suggestions for Direct Sun
This section includes some suggestions for taking meas-
urements in direct sunlight.

Single Sensor with Scattering Correction

l Make sure the sensor calibration is the factory
default, and hasn’t been modified by matching to
another sensor.

l You don’t need to do a K record for every file, unless
sky conditions are very changeable. You can import
K records from files that have them to files that need
them with the FV2200 Scattering Tool. Follow Pro-
cedure 3.10 - Importing K Records on page 8-40.

l You can intersperse K record precursors and single A
records. For example, a series of records such as
AAAAB...AB...AB...AAAA would turn into
KAB...AB...AB...KA.

l You might opt to keep the K’s in a separate file.
Whenever you need to do another K reading, re-open
that file (named K, for example), and append another
4A sequence (or 3A sequence, but be consistent)
into it.
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Multiple Sensors With Scattering Correction
Scattering correction requires collecting K record pre-
cursors in the field. When using multiple sensors with
scattering correction, make sure ALL the sensors have
their factory default calibrations (Procedure 1.5 - Resetting
Wand to Factory Calibration on page 8-19), and then fol-
low these protocols:

Matching Method
Use Method 1: B / A Pairs in Match on page 5-23 for your
inter-sensor calibration scheme. Get the data for this
once on a clear blue sky day, and then don’t worry
about it after that.

With One Operator
If you are operating in separate sensor mode (above and
below sensors), and there is only one person to do the
work, then plan on doing K readings with the below
sensor (see K Records on page 5-7), and putting them in
a separate file. Later you can import A records from the
above file using Procedure 3.8 - Import A and Adjust A
Records - FV2200 on page 8-38, and import Ks from the
K file using Procedure 3.10 - Importing K Records on
page 8-40.

With Multiple Operators
If there are enough people to dedicate someone to
doing the K records, then ideally they also have a sep-
arate instrument (or just a wand) to dedicate to it as
well. However, if the A unit needs to do double duty as
the “K unit”, one option is to do nothing but K records
(recall that a K record includes a normal A record): Go
through a 4A or 3A sequence as frequently as you think
is needed, or as frequently as your sanity can stand. In
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clear blue sky, one K record every 10 to 15 minutes
would be plenty. However, if you think you need a
higher frequency of reference A records than K records,
then follow Procedure 2.12 - Getting K Records on an
Above Sensor on page 8-30.

Measuring Non-Uniform Canopies with Direct
Sun
In a canopy with large gaps or wide rows or when meas-
uring individual crowns, scattering corrections intro-
duce additional constraints. Model Limitations for
Scattering Corrections on page 5-17.

Some Esoteric Details
This section is for those who want to know more about
the nuances of indirect LAI measurements.

Wand Calibrations
It is helpful to understand what is meant by an LAI
wand calibration. Each wand receives two types of cal-
ibration at the factory. One is an angular calibration,
which ensures that each ring has the proper angular
response to light. This calibration is actually done a few
times, with physical adjustments to the optics per-
formed in response to each, until the response meets
our criteria. This calibration should be stable for the life
of the wand, and it would likely take physical damage to
the wand to change it.

The other calibration that is done involves placing the
wand into an integrating sphere (an isotropic envir-
onment), and results in the five ring multipliers that are
stored in the wand's software. When these multipliers
are applied, the wand can be used to make valid
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distribution measurements of brightness, in which the
output of each ring can be compared to the others. That
is, under a perfectly uniform sky, all rings would read
the same value. For basic LAI measurements, this cal-
ibration is not important, since each ring is ratioed with
itself, so its absolute value doesn't matter. When doing
scattering corrections, measurements of sky brightness dis-
tribution are required, and thus, this calibration comes into
play.

What the ring factors do not do is ensure that two
sensors will read the same under the same conditions.
The relative distributions (one ring to the next) will be
right, but the absolute values may well be different. This
is why sensor matching is important.

General Considerations When Matching Sensors
The following items will affect how two sensors com-
pare:

Size and Orientation of View Cap
The size of the view cap has a primary effect on what
the wand reads. Less obvious, however, is the fact that
the detector rings in the sensor typically have some
small azimuthal variation in sensitivity, so how the view
cap is oriented also has an effect. Therefore, when
matching sensors, use the view cap that will be used for
the measurements, and in the orientation (relative to the
wand handle) that will be used for measurements.

Dirt/Dust on the Lens
If you keep the lenses clean while collecting data, then
match information that is also obtained under clean
lens conditions will still be valid. Otherwise, you can get
match data before and after a series of measurements to
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verify it hasn't changed, or to interpolate match data
through the time period. (This can't be done with con-
sole matching, but can be done with FV2200 matching)

Sky Conditions
Theoretically, two perfectly leveled sensors with the
same view cap aimed in exactly the same direction will
see the same sky. As a practical matter, they may not be
perfectly leveled nor aimed in exactly the same dir-
ection, nor have the exact same angular response. There-
fore, the best sky to use when matching sensors is one
that is as uniform as possible, which means blue sky
with no clouds. The worst case is blue sky with some
scattered clouds. If the portion of sky being viewed has a
bright cloud not fully contained within a ring's view,
then slight variations in view (direction or level) could
make a significant difference, because the sensors will
see differing amounts of that sunlit cloud, and that
cloud is many times brighter than the blue sky around
it. Matching sensors that are viewing clouds will build
in some biases to your measurements, so avoid it.

Detector Age
As a wand detector ages, its absolute calibration is sub-
ject to slight drift. If you match sensors even once a sea-
son, this should not be an issue.

Temperature
Temperature represents a potential cause of drift in how
sensors compare. Again, matching sensors once a season
will likely take care of this as well.

Some Scattering Correction Details
Scattering of light by foliage is greatest when the sun is
behind the viewer. It is at a minimum when the sun is
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in front of the viewer. The simple reason for this is that
the view with the sun at your back is dominated by
foliage reflectance (say 0.05 for leaves, stems, and
branches), while the view toward the sun is dominated
by foliage transmittance (say 0.01 for leaves, and 0 for
stems and branches).

You cannot make LAI measurements with the sensor ori-
ented toward the sun, of course, but if your meas-
urements are near the sun (keeping it blocked by the
view cap), then the scattering error in the uncorrected
readings could be much less than if the sensor is looking
directly away from the sun’s direction.

The scattering correction implemented in FV2200 takes
orientation into consideration. The measurement dir-
ection and view cap information is part of the “hand
entered” information specified when generating K
records. Solar position (azimuth and zenith) is com-
puted from UTC and your latitude and longitude. If the
console is equipped with GPS, and G records were
included in the file, then latitude, longitude, and UTC
are known. Otherwise, you specify latitude and lon-
gitude of the measurement site, and its time zone (or
more specifically, the hour shift between the console
clock and UTC).

Rain, Fog, and Dew
Accurate measurements can be made in wet canopies if
care is taken to keep water droplets off the lens. Work-
ing in rain is also possible, but measurements will have
greater uncertainty. Droplets on the lens present a con-
cern because they block light. A few small droplets can
reduce the light seen by some rings by 10% or more.
Therefore, it is important to keep the lens free of
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droplets by wiping it with the cloth provided in the lens
cleaning kit.
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Section 6.
Canopy Types
This section includes suggested protocols and con-
siderations for measuring LAI in various canopy types.

Measuring Plant Canopies
Short Homogeneous Canopies
Short homogeneous canopies are the simplest to measure.
Under stable sky conditions with a 270° view cap, one A
reading for four or more B readings should be sufficient.
To reduce uncertainty of measurements, you can take
more B readings.

Small Plots
When measuring small plots, it is important to be sure
that objects outside the plot do not influence meas-
urements. From beneath a canopy, the optical sensor’s
potential view is conical, with a radius that is about 3
times the canopy height. The optical sensor (wand) has a
view of 74° (tan (74)=3.48). However, 3 serves as a working
number because of the reduced probability that foliage
will be significant at the edge of the sensor’s field of view.
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In a canopy that is 1 m high, the optical sensor should
be at least 3 m from the edge in any direction that it can
“see”. In a plot so small that the sensor will “see” out-
side the plot area if measured from the middle, one
could use a 90° view cap and make readings from the
corners looking into the plot. Alternatively, a 180° view
cap could be used if the measurements were taken near
the center of the plot.

Note: If the sun is out, you may need a K record (e.g.
a 4A sequence) for each view cap and direction you
use. See Dealing with Scattering on page 5-6.

In dense canopies, the minimum plot size may be
reduced if foliage blocks enough of the optical sensor’s
view. This is easily tested by getting down on the
ground and looking up at about a 30° elevation angle. If
you are unable to see the edge of the plot from this vant-
age point, then the plot is large enough regardless of its
actual dimensions.
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An additional method for measuring small plots is to do
the LAI computations without the outer ring. Without
the outer ring, the minimum plot size decreases to 1.6
times the canopy height. The outer ring can be omitted
with the Mask function prior to data collection (Pro-
cedure 2.10 - Excluding Rings from Analysis - Console on
page 8-29), after data collection but while the file is still
on the control unit (Procedure 3.7 - Recomputing a Data
File - Console on page 8-38), or after the file has been
moved to a computer (Procedure 3.5 - Excluding Rings
from Analysis - FV2200 on page 8-37).

Row Crops
Row crops, with architecture ranging from very wide
row spacing to closed canopy, can be measured accur-
ately using the technique described here. In general,
readings should be made along diagonal transects
between the rows, as shown in Figure 6-1 on the next
page. Choose locations along transects so that readings
are made at even intervals across the row. For example,
if making 4 B readings per transect, make the first in
the row, the second ¼ of the way between the rows, the
third at mid-row, and the fourth ¾ of the way across.
Measuring with a diagonal transect, rather than a per-
pendicular transect, improves spatial averaging.
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Figure 6-1. A row crop with a homogeneous canopy (e.g., no
gaps between rows) can be measured with a wide view cap.

Be sure to make all B readings at the same height; if fur-
rows and mounds cannot be smoothed, position a board
along the transect and rest the sensor on it when taking
readings.

If the rows have significant gaps where vegetation is
lacking, perform the Canopy Gap Test (see The Gap Test
on page 6-11) to see if these gaps merit special attention.
If the Gap Test error is less than 10% (homogeneous can-
opy), then use as wide a field of view as possible,
depending on sky conditions. If the Gap Test error is
greater than 10% (heterogeneous canopy), then use the
45° view cap and double (at least) the number of diag-
onal transects. Measure the transects in pairs: one tran-
sect with the sensor looking along the row, and the
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other with the sensor looking across the row, as shown
in Figure 6-1 on the previous page.

Figure 6-2. A row crop with a heterogeneous canopy (e.g.,
gaps between rows) may require a narrow view cap and
more repetitions.

Note: if the sun is out, you may need a K record (e.g.
a 4A sequence) for each view cap and direction you
use. See Dealing with Scattering on page 5-6 and Meas-
uring Non-Uniform Canopies with Direct Sun on
page 5-32 for details.

Tall Canopies and Forests
The primary challenge to measuring very tall canopies is
getting the A readings.

Single Sensor: A single sensor can be used effectively in
forests when there is clear blue sky. In such conditions,
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you will want to do a 3A or 4A sequence in a suitable
clearing or on a tower, then make the B readings under
the forest canopy at your plots or along your transects.
You can then return to the clearing and do final 4A
sequence. Example 4 - Forest Sites with One Sensor (and
Control Unit) on page 8-5 illustrates how to do this. And
in fact, you can also do the same with simply a sensor
by itself, following Example 5 - Forest Sites with One
Sensor (without Control Unit) on page 8-6. This means if
you happen to have a control unit and two sensors (and
two people), you can use both and get your meas-
urements done twice as fast, since you can split up the
below canopy work. The above canopy data can come
from just one unit, or each can get its own, letting you
bypass any sensor matching.

Two Sensors: Refer to the discussion in Multiple Sensors
With Scattering Correction on page 5-31.

Note: If the sun is out and you are measuring a forest
canopy with large gaps, choose a view direction to the
side or slightly in front of the sensor’s view (taking
care of course to not take a reading with the sun actu-
ally in the field of view). see Measuring Non-Uniform
Canopies with Direct Sun on page 5-32 for an illus-
tration and discussion.

MakingA Readings in Forest Canopy
There are several considerations for getting A readings
in a forest canopy.

A readings should be made as close as possible to the
site to be measured. The maximum acceptable distance
depends entirely on sky conditions. With blue sky
(ignoring the sun for a moment), the two sensors could
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be kilometers apart and still see the same sky brightness
distribution. With an overcast sky, however, the lower
the clouds, the greater the probability that two sensors
some distance apart will see different skies, especially
with the central rings (near the zenith). A low, het-
erogeneous overcast sky with quickly moving clouds is
the worst case, when even 100 meters could be too great
a distance between the sensors.

If making A readings in a clearing, be sure that the clear-
ing is big enough. With a 180° or larger view cap, the
sensor should be in the middle of a clearing with a dia-
meter at least 7 times the height of the trees above the
sensor (2×tan74°≈7).

With the 90° or 45° view cap, however, a clearing half
that size (diameter only 3.5 times the tree height) can be
used, since the sensor can now be positioned on the
edge of the clearing (looking in).
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This is a common reason for using a narrow view cap in
a forest. Neglecting the outer ring may be necessary if
an adequately large clearing is not available. In that case,
the clearing should be 1.5 times the canopy height if the
45° or 90° view cap is used. Refer to the Small Plots on
page 6-1.

When making A readings for forest canopies, clearings
can be made “bigger” by raising the sensor. Use the bot-
tom level and hold the sensor over your head. The
sensor can be elevated by standing on a stump, the cab
of a vehicle, or by raising the sensor with a long pole,
etc.

Don’t forget: The A readings should be made with the
same view cap (covering the same part of the optical
sensor), sensor inclination (if the ground slopes), and
direction of view that the B readings will have.
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Making K Records in a Forest Canopy
K records (or more precisely the precursors to them)
have similar considerations as A records, plus a few. (If
you aren’t sure what K records are, see K Records on
page 5-7). If the A unit is going to do double duty as the
K unit, as described in Procedure 2.12 - Getting K Records
on an Above Sensor on page 8-30, then the first and third
readings of a 4A sequence need some consideration:

The first A reading (sunlit diffuser) needs to be in the
sun. If the site in the reference clearing where the A
unit is located happens to be shaded, then that is a prob-
lem.

The third A reading is the wide sky reading. Unless your
A site happens to be on top of a tower above the can-
opy, it is not likely to have an unobstructed view of the
sky in all directions. You will have to choose a view cap
for the third reading that is as large as will work. The
worst case would be if that view is no larger than the
normal A view, in which case you can just skip that
reading, as described in Embedded Bs on page 5-16.

Canopies with Large Gaps
LAI is proportional to the logarithm of the gap fraction,
so the proper way to average gap fractions is to average
their logarithms (Lang and Xiang, 1986). This in fact is
how the LAI-2200C averages multiple B readings in a
file. However, each B reading is a linear average of the
light from whatever azimuthal view is visible to the
sensor, as determined by the view cap. Problems can
arise if the sensor sees dense foliage in one direction and
little or no foliage in another direction at the time a B
reading is recorded, because the gap in the canopy will
be “over weighted”, and LAI will be underestimated. A
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way to avoid this problem is to use a view cap to restrict
the sensor’s field of view, so that dense and sparse
regions of the canopy are included in separate B read-
ings. The figure below illustrates how a 45° view cap
helps isolate a gap near a transect.

If on the other hand, you wish to measure Le (effective
LAI), then you do not want the instrument to log aver-
age. In this case, use a wide field of view (270°), and
multiply your resulting LAI by ACF, the apparent
clumping factor.

The Canopy Gap Test (see The Gap Test on the facing
page) can be used to estimate the error of using a wide
field of view in a heterogeneous canopy, when large
gaps and foliage are included in the same B reading.

Note: When the sun is out and you are measuring
canopies with large gaps, choose a view direction to
the side of or slightly in front of the sensor's view (tak-
ing care of course to not take a reading with the sun
actually in the field of view). See Protocol Suggestions
for Direct Sun on page 5-30 for an illustration and dis-
cussion.
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Conifers
It is well known that conifer needles are not arranged in
space randomly, and radiation penetration models that
make that assumption will underestimate the trans-
mittance of a conifer canopy (for example, Norman and
Jarvis, 1975; Oker-Blum and Kellomaki, 1983). Since the
LAI-2200C assumes random foliage positioning, it will
underestimate LAI in conifer canopies.

Numerous researchers have developed sampling tech-
niques for acquiring accurate LAI measurements in ever-
green forests, including Chen (1996), Stenberg (1996),
Chen et al. (1997), and Kucharik et al. (1998). A detailed
sampling protocol for conifer stands is described in Law
et al. (2008).

The Gap Test
The canopy gap test is a quantitative way to estimate the
error of using a wide field of view in a heterogeneous
canopy. That is, a canopy with dense foliage in some
areas and sparse (or no) foliage in others. The problem
is that LAI is proportional to the logarithm of the gap
fraction, but for any one reading, the sensor will linearly
average gap fraction over its view. If the sensor’s view
includes both dense and sparse foliage areas, the gap
fraction for that B record will thus be incorrectly aver-
aged. If the dense and sparse regions are measured in
separate B records, they will be correctly averaged.

Follow Procedure 1.11 - The Canopy Gap Test on
page 8-22 to estimate the error from using a view cap
that is too large.
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Measuring Isolated Plants
This section describes the measurement of isolated
plants, for which a different protocol must be used. We
begin with a discussion of LAI and foliage density.

Note: It is best to avoid direct sun when making meas-
urements of isolated canopies. If you do need to make
measurements of isolated canopies in direct sun, fol-
low the recommendations in Isolated Canopies and
Scattering Corrections on page 6-23.

LAI or Foliage Density?
LAI is one-sided leaf (or foliage) area per unit ground
area. In a large, homogeneous plant community, LAI is
a reasonable way to express the amount of vegetation.
An isolated plant presents difficulties, however, because
the amount of foliage over a given area of ground
depends on ground position. For example, consider a
single tree:

The amount of foliage above a unit
of ground area at the tree’s cen-
ter…

…is probably
different
than the
amount of
foliage near
the tree’s
edge.
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Also, the ground area affects the
LAI measurements. For example,
we might wish to express LAI
based on the tree’s drip line area,
or based on the area associated
with the tree as a member of a
community, as illustrated in the
over-head view below.

Thus, LAI for an isolated plant is ambiguous unless the
size and position of the ground area is also given.

A more useful measure of foliage amount for individual
plants, or clumps of plants, is that of foliage area density
(or simply foliage density), which is foliage area divided
by canopy volume. Foliage density has units of m2

foliage area per m3 canopy volume, which reduces to
units of inverse length, typically m-1. If a tree has 2 m2

of foliage in a 5 m3 crown, its foliage density is 0.4
m2/m3, or 0.4 m-1.
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The DISTS Vector
Theory on page 10-1 describes the theory of the
LAI-2200C, showing that the only theoretical difference
between measuring LAI and measuring foliage density
involves something called the DISTS (Distances) Vector.

The DISTS Vector is a group of 5 numbers in the con-
trol unit that are used in the computations. These num-
bers indicate the distances sky radiation must travel
through the canopy to reach each of the 5 detector rings
of the sensor. They can be viewed on the console by
going toMENU > Log Setup > Distances. The
default values in this vector are 1/cosθ , where angle is
the view associated with each of the five rings (7°, 23°,
38°, 53°, and 68°). When making LAI measurements,
there is no need to adjust these values since 1/cosθ is suf-
ficient regardless of canopy height.

Foliage density measurements, however, require that the
DISTS vector indicate the actual mean path lengths that
each ring sees through the canopy. When results are
computed, the LAI value is now foliage density. The
units of foliage density depend on the units used for the
DISTS values. If distances are entered in m, then the
foliage density is in m-1.

To set the DISTS vector for new data, go toMENU >
Log Setup > Distances. To change the DISTS vector
for an existing data file, go toMENU > Data > Con-
sole Data. Select a data file, then Edit > Edit Dists.

A Simple Example
Consider a perfectly hemispherical shrub with a radius
of 0.7 m. A hemisphere is the simplest because the path
lengths for each ring view are identical.
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7°
23°

38°

53°

68°

To measure the foliage density of this shrub, access the
Distance vectors (MENU > Log Setup > Distances)
and set each of the five values to 0.7. The measurement
is similar to that for LAI, except that a spatial average
under the shrub is now not wanted; we will take only
one B reading, directly under the center of the plant.
This example is illustrated in Example 6 - A Simple Isol-
ated Canopy on page 8-8.

Isolated Trees
Note: It is best to avoid direct sun when making meas-
urements of isolated canopies. If you do need to make
measurements of isolated trees in direct sun, follow
the recommendations in Isolated Canopies and Scat-
tering Corrections on page 6-23.

Trees are best measured using the 180° or smaller view
cap, and placing the sensor next to the trunk below the
crown for B readings. The view cap prevents the sensor
from seeing the trunk of the tree. Usually, you will put
the sensor above or below the largest branches in the
crown because it is important to avoid having these
branches dominate the sensor’s view. Place the sensor
just above the low branches (Method 1) or place it well



LAI-2200C Plant Canopy Analyzer Instruction Manual

6-16

beneath them out of the canopy (Method 2). Both tech-
niques are illustrated here:

The thick segments of the diagonal lines in this figure
indicate the distances each ring sees through the canopy.
Note that sometimes a ring will see no foliage, as with
the 68° ring in Method 2 above. A ring that sees no
foliage should be masked. A 90° or 45° view cap can be
used to further reduce the size of the canopy that is
sampled. The view cap and view directions should be
chosen to avoid including neighboring trees in the meas-
urement.
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If a tree is symmetric and well isolated, several B read-
ings can be taken in different directions. The figure
below illustrates measuring a tree with 4 B readings 90°
apart, but a better average could be obtained with 12 B
readings 30° apart, for example.

Note: all associated above and below readings must
be viewing the same portion of the sky.

If a tree is asymmetric, then the path lengths through
the tree (and thus the distance vector) will depend on
azimuthal direction. Since only one distance vector is
associated with a file, asymmetric trees should be meas-
ured using several files. Average foliage density is then
computed by averaging the foliage densities from each
of the files.
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A simple method for computing path lengths and can-
opy volumes is provided in the FV2200 software. Use a
coordinate system centered below the tree, and determ-
ine the coordinates of a sufficient number of points to
describe the shape of the canopy. Alternatively, a pho-
tograph of the tree that includes a meter stick for scale
can be used to obtain the tree profile.

An example of the measurements needed to describe a
tree crown are shown below:
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1 2
3

4

5

6

7

       X    Z

1: (0.0, 0.6)

2: (0.8, 0.6)

3: (1.4, 0.8)

4: (1.6, 1.5)

5: (1.3, 2.3)

6: (0.8, 2.8)

7: (0.0, 3.3)

The FV2200 software can use these data to determine
path lengths, neglect rings if necessary, and compute
canopy volume, foliage density, or dripline LAI.

Refer to the detailed example: Example 7 - Isolated Tree
on page 8-10.

Isolated Rows and Hedges
The measurement of individual rows (e.g. hedges, grape
vines) is possible with the LAI-2200C. Again, the data
should be treated as foliage density. Here we describe
two methods for measuring isolated rows or hedges.

Note: It is best to avoid direct sun when making meas-
urements of isolated canopies. If you do need to make
measurements of isolated rows or hedges in direct
sun, follow the recommendations in Isolated Canopies
and Scattering Corrections on page 6-23.
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Method 1
The measurement of isol-
ated rows, such as a
hedge or the rows in a
vineyard, is similar to
measuring isolated trees.
With this method, the
above and below meas-
urements are taken along
the length of the row.

For the below-canopy
readings, place the sensor
near the row center and
orient the view cap so that the sensor looks away from
the center. Keep it close to the lowest vegetation, but far
enough away from any leaves to ensure that individual
leaves do not block the view (see Measuring Isolated
Plants on page 6-12).

Next, characterize the canopy shape by measuring a
number of X, Z coordinates. The number of coordinates
required will vary, depending on the complexity of the
canopy shape. If the canopy is asymmetrical, char-
acterize each side with X, Z coordinates. Measure or
estimate the row ratio for the hedge (the length Y over
width X). These values are used by FV2200 software to
compute the foliage density or dripline LAI.
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1

2 3
4

5

    X        Z

1: (0.0,   0.5)

2: (0.0,   1.97)

3: (0.31, 1.89)

4: (0.51, 1.77)

5: (0.67, 1.55)

6: (0.63, 1.29)

7: (0.54, 1.01)

8: (0.25, 0.64)

6

7

8

X

Z

For asymmetrical canopies, LAI needs to be computed
for each side of the canopy. LAI for the hedge is the
average of LAI for both sides. A complete example,
including sample data is presented in Example 7 - Isol-
ated Tree on page 8-10.

Method 2
A simple way to measure LAI in a hedge is to take an A
reading viewing the sky. Take a number of B readings
on one side of the row or the other, making sure that
the sensor “sees” through the hedge, as shown below. It
is useful for both symmetrical and asymmetrical can-
opies.
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In addition to the above
and below-canopy read-
ings, measure X, Z
coordinates to char-
acterize the shape of the
entire canopy, measure
the distance between the
sensor and the hedge
centerline, (the X offset
in meters), and the dis-
tance between the sensor
and the bottom of the
canopy, (the Z offset in
meters). Measure or
estimate the row ratio for
the hedge (the length Y over width X). This information
will be used in the FV2200 software to compute dis-
tances and LAI for the shrub. In the figure below, the
sensor was held at the base of the canopy, resulting in a
Z offset of 0.

This example is illustrated in Example 6 - A Simple Isol-
ated Canopy on page 8-8.
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Isolated Canopies and Scattering Corrections
The model used to do the scattering corrections in
FV2200 ver. 2.0 is one-dimensional, while the geometry
for an isolated canopy is clearly two or three-dimen-
sional. That discrepancy is not a major issue for determ-
ining scattering from diffuse radiation. However, when
Fbeam > 0 (i.e. when the sun is out), it can be a serious
issue, since the actual path length for sunlight to reach
the foliage along the path of a ring's view through the
canopy is potentially much different in reality versus the
model (see Figure 5-2 on page 5-18).

Therefore, if it is possible to avoid direct sun when meas-
uring isolated canopies (single tree, single row, etc.),
then that is the best approach. If you do need to make
measurements in direct sun, then the following steps
should be taken to minimize the error in the scattering
adjustment:

l Measure with the sun as high in the sky as possible.
l Work with the sun to the side or slightly in front of

the sensor's view, while keeping the sun OUT of the
sensor's field of view (see Figure 5-3 on page 5-20)

l If you are measuring a canopy from the outside look-
ing through (across a row, for example), have the
sensor looking toward the shaded side of the canopy,
not the sunlit side.
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Section 7.
Data Analysis with FV2200
FV2200 allows easy manipulation of LAI-2200C and
LAI-2000 data files (hereafter referred to as LAI files).
These files can be read from disk, or imported from either
console type (LAI-2200C or LAI-2000). LAI files can be
manipulated in any way that they can on the control unit
(console), and in many other ways besides. FV2200 also
supports mapping for files containing GPS records.

Getting FV2200
FV2200 is available for Windows®, Mac OSX®, and
Linux. Download to your computer using the following
link: www.licor.com/2200C-software.

Software Updates
Once FV2200 is installed, each time it is run it checks a
LI-COR server for any LAI-2200C related updates since the
last time it ran. If there are changes, a “Latest News” file is
displayed, which will display any software updates to
LAI-2200C console software, wand software, or FV2200,
and provides links to the new versions. Also, once FV2200
is running, you can get this information manually in
either of two ways from the Help menu. Also under the
Help menu is a guide to using FV2200.

http://www.licor.com/2200C-software
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Main Window
When the FV2200 software is launched the main win-
dow will open. From this window, you can import LAI
files or open LAI files from a disk. Three tool bars are
visible in the Main Window: File, Display, and Edit.
Toolbars can be hidden, moved around or detached by
clicking and dragging the toolbar drag handle. Hide and
show toolbars using the View menu or by right-clicking
on the menu bar. To resize buttons in the toolbars or
change display defaults, select File > Preferences (or
FV2200 > Preferences on Mac). Choose between
small icons (no boxes checked), large icons, or icons
with labels (small or large).
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Basic Tasks
FV2200 can read files on your computer that have been
transferred from control units (Procedure 3.1 - Moving
Data to a Computer on page 8-35), or directly from an
LAI-2270C Control Unit that is connected to your com-
puter with a USB cable.

To open files that are saved on your computer’s hard
drive or the LAI-2200C console if it is attached via USB,
click the Open icon or File > Open and navigate to the
stored file. Double click the file to open it, or select mul-
tiple files and click OK.

Alternatively, you can drag the data file(s) onto the
main window: The file(s) will be opened in the current
view, or if there are no views, one will be created.

On Mac and Windows operating systems, you can drag
and drop the data file(s) onto the FV2200 icon: on Mac,
if FV2200 is not running, it will launch, create a view,
and open the files in that view. If FV2200 is running,
this is just like dropping the files onto the main win-
dows. On Windows, FV2200 will launch (if it is already
running, a second one is launched), a view is created,
and the files opened in the view.

If multiple files were selected, click Yes to place them
into one tab or No to place them in separate tabs.
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Once files have been opened, a view is created with the
tab showing the source files. If you open another file or
group of files, these will go into a second view. LAI files
(rows of a view) can be cut, copied, and pasted from one
view to another.

View an LAI File
Double click a file in a view to open the Details win-
dow.

Import A Records
When A and B records are in separate files, they must
be merged to compute results. If the A and B readings
were collected using two different sensors, imported A
records may also need to be adjusted to match the B
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sensor's calibration, if it hadn’t been done already. This
is discussed in Multiple-Sensor Operation Revisited on
page 5-21. Both of these tasks—importing and (if neces-
sary) adjusting—are accomplished using the "Import
Records" dialog.

Recompute Data Files
There are a number of reasons a file might need to be
recomputed, such as adding scattering corrections,
importing A readings, masking a ring, etc., and gen-
erally the recomputation happens automatically as part
of that process. There is also a Recompute dialog box
that lets you make some typical modifications (change
the ring mask, change how transmittances are com-
puted, or change the canopy model) and apply those
changes to one or a group of files.

Implementing Scattering Corrections
Scattering corrections are discussed in Dealing with Scat-
tering on page 5-6. If the necessary data (the K record
precursors) have been collected for your files, use
FV2200’s Scattering Tool to complete the task: generate
K records, copy them to other files (if necessary), set the
remaining inputs in the files, and recompute. The
example given in Example 4 - Forest Sites with One Sensor
(and Control Unit) on page 8-5 includes all of these steps.
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Plot Selected Data
You can plot data within an LAI file, or across multiple
files. You can define a chart, then click on various LAI
file(s) to update the chart for that file(s). All of this is
configured using the Add Chart dialog.

Make a GPS Plot
LAI files that contain GPS data, either because they
were logged with an LAI-2200C console with built-in
GPS, or they have had GPS data added as part of the
scattering correction inputs, can be used to generate
.kml files, which allows selected data to be displayed on
a satellite image of the area. For example, Figure 7-1 on
the facing page shows a path of where the data points
were logged (top) and a 3D image of LAI along that
path (height being proportional to LAI at any given
point).
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Figure 7-1. LAI data plotted on Google® Earth with a .kml
file produced by FV2200.

View LAI for each B Record
Often it is desired to “break apart” an LAI data file and
see what the LAI was at each location for which there
was a B reading. FV2200 version 2 provides this inform-
ation for you without your having to do anything. To
see it, double click the file to get the Details view, and
click on the Gap Fractions tab.
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Computing LAI
FV2200 duplicates the LAI computation done in the
LAI-2200C console (LAI-2000 Method), and also
provides some alternatives: the Lang Method, Ellipsoidal
Method, and Constrained Least Squares Method. These
are described below.

There are some points to remember when interpreting
these results:

1 The “L” in LAI (Leaf Area Index) is traditional, and not neces-
sarily a fact. Anything that blocks light will be included in the
result: branches, stems, animals, etc. Thus, “Foliage Area
Index” is a better way to think of this.

2 LAI could be foliage area index (m2 foliage/m2 ground), or
foliage area density (m2/m3) canopy. It is the path lengths
(Dist[*]) that determine which units are appropriate. For stand-
ard path lengths (Horizontal Uniform model), LAI is foliage
area index. For any other path lengths (Isolated Canopy, Meas-
ured Distances, and Isolated Canopy, Computed Distances),
LAI should be interpreted as foliage density.

3 The LAI values include a correction (log average trans-
mittances) for clumping. Thus, especially if narrow view caps
were used, measured LAI is closer to L (true LAI) than Le
(effective LAI). If you want Le, multiply LAI by ACF, the appar-
ent clumping factor.

LAI-2000 Method
LAI is computed from (see Theory on page 10-1 for the
derivation):

7-1

where L is the leaf (all light blocking objects) area index
(LAI), is the mean contact number for the ith ring
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(CONTACT#[*]), and Wi is the weighting factor for the
ith ring (LAI_W[*]).

The mean contact number is a function of the trans-
mittance and the path length Si (DIST[*]). For n
Above/Below pairs of observations,

7-2

Weighting factor Wi is computed from

7-3

where is the mean zenith angle and is the ring

width (radians) associated with ith ring. Values for
are given in Table 7-1 below below. The weighting
factors are normalized to sum to 1.0, so when one or
more rings are masked, the remaining weighting factors
increase.

Ring Width (°) Weighting Factor

1 12.2 0.041
2 12.2 0.131
3 11.8 0.201
4 13.2 0.290
5 13.2 0.337

Table 7-1. Ring widths and weighting factors.
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Lang Method
A simple method of computing LAI from the slope and
intercept of a plot of contact number vs. angle was pro-
posed by Lang (1987).

7-4

where Llang is leaf area index (LangLAI), m is the slope
and b is the intercept of contact number (CNTCT#[*])
plotted as a function of angle (in radians). LangLAI can
be added to views or viewed in the “All Values” tab of
any data file.

Ellipsoidal Method
Another method of inverting gap fraction data is to use
an ellipsoidal-based description of leaf angle dis-
tribution. Refer to Norman and Campbell (1989), and
Campbell (1986).

Variables computed with the Ellipsoidal Method
include:

EllipLAI – LAI (or foliage density) obtained from the
ellipsoidal distribution method.

EllipMTA – Mean Tilt Angle obtained from the ellips-
oidal method.

EllipX – The ratio of horizontal to vertical radii of an
ellipsoid whose surface area fractions describe the
foliage angle distributions in the canopy.

These variables can be added to views or viewed in the
“All Values” tab of any data file.

Constrained Least Squares Method
An alternative method of inverting gap fraction data is
that of constrained least squares. Refer to Norman and
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Campbell (1989) and Perry et al. (1988). The outputs
associated with this method are listed below:

CLS_LAI – LAI (or foliage density) by method of the
constrained least squares.

CLS_c – The smallest constraint that yields all positive
area fractions.

CLS_LAD[*] – foliage angle distribution. The angle
classes are 9°, 27°, 45°, 63°, and 81° (90 divided evenly
by 5). If one or more rings are masked, there will be
fewer angle classes.

CLS_MTA – Mean Tilt Angle based on the distribution
(S).

CLS_Mu, CLS_Nu – Mu, Nu of the Beta distribution
(Goel and Strebel, 1984).
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Section 8.
Examples and Procedures
This chapter contains step-by-step instructions for most of
the common operations with the LAI-2200C and FV2200.

Each Example tells how to measure LAI with a particular
optical sensor (wand) configuration or canopy type.
Examples 2, 4, and 5 include the scattering correction for
use with direct sun conditions. When using two or more
optical sensors with scattering correction, see Multiple
Sensors With Scattering Correction on page 5-31.

Each Procedure describes a particular task on the console
or in post-processing. These procedures are referenced
from various locations in this manual.

Example 1 - One Sensor Measurement
without scattering correction
This step-by-step section requires one LAI-2270C Control
Unit and one LAI-2250 Optical Sensor and view caps. Fol-
low these steps:

1 Place the desired view cap on the sensor with the opening point-
ing away from the handle. Attach the optical sensor to the con-
trol unit (either the X or Y terminal) and turn on the control unit.
Verify that the sensor is operating correctly by placing a hand
over the lens and observing that the reading drops (in Monitor
Mode). Remove your hand and notice that the reading returns to
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normal.

2 Set prompts, if desired.

3 Open a file (Procedure 2.2 - Opening a New Data File on
page 8-24). Enter responses to the prompts and pressOK to
save or EXIT to skip the prompts. Now the LAI-2200C will
enter Logging Mode and is ready to record data.

4 Position the optical sensor above the canopy. Be sure it is
level and that no foreign objects are in view of the sensor.
Verify that the ABOVE LED is illuminated (press theA/B but-
ton on the wand if it is not). Press the LOG button on the
wand or control unit to record an Above reading.

5 Press theA/B button (the ABOVE LED will turn off). Hold the
optical sensor below the canopy(level and oriented in the
same direction as the above-canopy reading was) and press
the LOG button to record a Below reading.

6 LAI, MTA, SEL, and SEM values will be visible in Logging
Mode (use the arrow keys to change what is displayed).

7 Continue making B readings, moving the sensor to a new loc-
ation each time. Typically, the distance between B readings is
on the order of the canopy height. You can intersperseA read-
ings as necessary, if sky conditions or the view direction
changes.

8 When you are finished, press the START|STOP button to
close the file and exit Logging Mode.

Example 2 - One Sensor Measurement
with Scattering Correction
This example is of an LAI measurement that would nor-
mally be made by doing an A reading, followed by a
series of B readings. Thus, our sequence (if we weren’t
doing scattering corrections) might be ABBBB. Because
we are doing scattering corrections, we will want to
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replace the A readings with a 4A sequence. Thus, we’ll
end up with a record sequence of AAAABBBB.

Preliminary steps are just like the previous example.

1 Perform a 4A sequence (Procedure 2.6 - Logging a 4A or 3A
Sequence on page 8-26).

2 Log the B readings.

3 Close the file (press START|STOP).

4 Transfer the file to FV2200 (Procedure 3.1 - Moving Data to a
Computer on page 8-35).

5 Convert the 3A or 4A sequences to K records (Procedure 3.9
- Generating K records from Sequences on page 8-39).

6 Enter the remaining scattering inputs (step 6 of Procedure
3.11 - Set Scattering Inputs for a Group of Files on page 8-41).

Note: For more details about measurements with scat-
tering correction, see Protocol Suggestions for Direct Sun
on page 5-30.

Note: When using two or more sensors with scat-
tering correction, see Multiple Sensors With Scattering
Correction on page 5-31.

Example 3 - Two Sensor Measurement
without scattering correction
The Match Methods mentioned below are discussed in
Three Methods for FV2200 Matching on page 5-22.

1 Place the desired view caps (same size) over the lenses of two
optical sensors (see chapters 4 and 6). Connect the optical
sensor to the control unit and turn on the control unit.
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2 Synchronize clocks in both wands (Procedure 1.4 - Syn-
chronizing Wand and Console Clock on page 8-18), and delete
any data from the above wand (MENU > Data > Wand
> Purge).

3 Start the Above wand autologging (Procedure 2.7 - Automatic
Logging - Wand on page 8-27).

4 Disconnect the Above wand, and place it in an area that
affords a clear view of the sky. Be sure it is level, stable, and
oriented so that it views the same sky as the below canopy
sensor will see.

5 Before leaving theA unit:

A If you are doing Match Method 2, create your match file
now (Procedure 2.5 - Creating a Match File for Match
Method 2 on page 8-26).

B If you are doing Match Method 3, record your match
data by opening a file and logging a fewA readings
with the sensors together. Leave the file open for the B
records.

6 Go to the site for measuring B records, and record the read-
ings. For each one, make sure it is seeing the same sky as the
A unit.

7 (Match Method 3 only, optional) Before closing the file, return
to theA unit, and append 1 or 2A readings into the file.

8 Press START|STOP to close the file.

9 If you are doing Match Method 1 or 2, repeat step 6 as neces-
sary, creating more below files. If you are doing Match
Method 3, then you have to repeat steps 5 through 8 as
needed.

10 When you are done, disable autologging on the above sensor
(Procedure 2.7 - Automatic Logging - Wand on page 8-27)
and download the files from the sensor to the control unit
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(Procedure 2.13 - Moving Wand Data to the Console on
page 8-31).

11 Move the above and below files onto your computer (Pro-
cedure 3.1 - Moving Data to a Computer on page 8-35).

12 ImportA records from the above file into the below files (Pro-
cedure 3.8 - Import A and Adjust A Records - FV2200 on
page 8-38).

Note: When using two or more sensors with scat-
tering correction, see Multiple Sensors With Scattering
Correction on page 5-31.

Example 4 - Forest Sites with One
Sensor (and Control Unit)
This method is best suited to a clear blue day. The
strategy is to start at a clearing and make A and K read-
ings in an “above” file. Then move to the measurement
site and measure each transect or plot in separate
"below" files. Finally, return to the clearing and make
final A and K readings. FV2200 is used to put
everything together, do the scattering corrections, and
compute final results.

1 At theA site, open a file (Procedure 2.2 - Opening a New
Data File on page 8-24). We’ll assume the name is “above”,
and log a 4A or 3A sequence (depending on the size of the
clearing) (Procedure 2.6 - Logging a 4A or 3A Sequence on
page 8-26). Close the file.

2 Measure each transect or plot into a separate below file. Each
will have any number of B records.

3 Return to theA site, and repeat step 1, open file “above” and
append another 4A sequence into it. Close the file.
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4 Read all files into FV2200 (Procedure 3.3 - Loading Data Files
into FV2200 on page 8-36). They can all be in one view.

5 Generate K records in file “above” (Procedure 3.9 - Gen-
erating K records from Sequences on page 8-39).

6 Import K records to the below files (Procedure 3.12 - Com-
bining Multiple Files - FV2200 on page 8-43).

7 ImportA records to the "below" files (Procedure 3.8 - Import
A and Adjust A Records - FV2200 on page 8-38). Enable inter-
polation, and don’t do adjustments (since A and B are the
same sensor).

8 Set the rest of the scattering inputs on the "below" files (step
6 of Procedure 3.11 - Set Scattering Inputs for a Group of
Files on page 8-41).

Example 5 - Forest Sites with One
Sensor (without Control Unit)
The only difference between this example and the one
above is that we don’t have separate files; everything
gets collected by the wand and winds up in one file.
Again, this is best on a clear blue day.

1 At theA site, log a 4A or 3A sequence (depending on the
size of the clearing).

2 Move to measurement sites, and log B records. You will need
to mark the start of each new ‘file’: you could log a fakeA
record, or cover the lens with your hand and log a record with
tiny values in it. Later on, you will use these markers and even-
tually delete them.

3 Return to theA site, and repeat step 1.

4 Copy the wand data to a control unit (Procedure 2.13 - Mov-
ing Wand Data to the Console on page 8-31). We'll call this
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file ‘BIG’, since it is the big file from which we’ll make the
other files, one for each transect or plot.

5 Load ‘BIG’ into FV2200 (Procedure 3.3 - Loading Data Files
into FV2200 on page 8-36).

6 Generate K records in ‘BIG’ (Procedure 3.9 - Generating K
records from Sequences on page 8-39).

7 Set the rest of the scattering inputs in ‘BIG’ (step 6 of Pro-
cedure 3.11 - Set Scattering Inputs for a Group of Files on
page 8-41).

8 In the main view of FV2200, copy ‘BIG’ (highlight it and hit
copy button (or File > Copy). Then paste (File > Paste)
as many copies into that same view as you have transects or
plots.

9 For each file pasted, double click it to get the detail view and
do the following:
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10 Click the Keep button.

Example 6 - A Simple Isolated Canopy
Consider the example given in A Simple Example on
page 6-14. In this example, the plant is a hemispherical
shrub with measured path lengths of 0.7 m. Launch the
FV2200 software. Click on File > Sample files >
Manual Examples.txt. Double click on the file called
SHRUB to view file details, then select the As Read
tab. The data file for this shrub looks something like
this:
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... 

MODEL IsoMeasured

...

LAI  6.69 

SEL  0.00

ACF  1.000

DIFN  0.092

MTA  49

SEM  2

SMP  1

MASK  1 1 1 1 1

ANGLES 7.00 23.00 38.00 53.00 68.00

AVGTRANS 0.059 0.068 0.097 0.084 0.131

ACFS  1.000 1.000 1.000 1.000 1.000

CNTCT# 4.035 3.850 3.338 3.539 2.903

STDDEV 0.000 0.000 0.000 0.000 0.000

DISTS  0.700 0.700 0.700 0.700 0.700

GAPS  0.059 0.068 0.097 0.084 0.131

...

A: 1 20090924 12:13:44  109.23  108.96  102.21  96.61  100.67

B: 2  20090924 12:14:05  6.480    7.360    9.880    8.110  13.19

The LAI value is foliage density. There are two ways to
tell this by looking at the file. One is theMODEL line.
“Horizontal” means the canopy model is horizontally
infinite, or at least large enough that the default DISTS
vectors apply. “IsoMeasured” means an isolated canopy.
The other way to know this is to look at the DISTS val-
ues. Since they are not the default values (1.008, 1.086,
1.269, 1.662, and 2.669), then LAI should be interpreted
as foliage density.

Click on the Header tab, then click Change. In the
Recompute dialog, check Change Canopy Model,
then check Change View Cap. Select the 90 degree
cap and observe changes in the Volume and Area
fields, which are used to compute Drip Line LAI
(DLLAI).
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Example 7 - Isolated Tree
Below is an example of the procedure that could be
used to measure LAI for an isolated plant. The steps
below will generate a file much like the example file
named TREE1 in the FV2200 software, which is
accessed by going to File > Sample files > Manual
Examples.

1 Create a new file with default Transcomp settings. Use a
90° view cap and take one AB pair in each of the four dir-
ections.

2 Measure the average shape of the tree’s crown with several
X, Z pairs of points that describe the profile, as shown below
(a photo of the profile with a meter stick for scale could be
used as well).

3 Measure the X and Z offsets, as shown below.

4 Open the file with the FV2200 software.
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5 Select the file and click the Recompute button. Check the
Change Canopy Model box.

6 Check the Isolated Computed box, and the Change
vertical profile box.

7 Click the Edit… button and enter the X, Z coordinates to
define the canopy shape. Right click on the profile to add
more points. ClickOK when finished.

8 Enter the X and Z sensor position. Observe changes in volume
and area values as these fields are updated.

9 ClickOK to implement the changes. The new LAI value,
along with a summary of the procedure, will be visible in the
log.

10 Save the file to retain any changes.
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Example 8 - Isolated Row 1
There are two approaches that can be used to measure
an isolated row, such as a grape vine or hedge. The first
is described here, and the second is described for "Row
2" below.

The steps below will generate a file much like the
example named ROW1 in the FV2200 software, which
is opened by clicking on File > Sample files >
Manual Examples.

1 Set the console Transcomp settings toDefine Above:
A; Determine Above: Interpolate; Bad Read-
ings: Clip. Place a view cap with a 90° opening over the
lens and create a new file.

2 Make an above-canopy reading, mul-
tiple below-canopy readings, and a
second above-canopy reading. Make
the below canopy readings with the
sensor at the base of the canopy, as
shown.

3 Measure several X, Z coordinates
(meters) to characterize the vertical
profile, perpendicular to the centerline
of the hedge. This example uses 8
coordinates. See the following figure.
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1

2 3
4

5

    X        Z

1: (0.0,   0.0)

2: (0.0,   1.47)

3: (0.31, 1.39)

4: (0.51, 1.27)

5: (0.67, 1.05)

6: (0.63, 0.79)

7: (0.54, 0.51)

8: (0.25, 0.14)

6

7

8

X

ZPlace the 

sensor at the 

0,0 coordinate.

4 Measure the width (Y) and depth (X) of the hedge to compute
the row ratio (Y/X), 5 in this case.

5 Open the data file in the FV2200 software.

6 Click the Recompute button. In the Recompute Dialog box,
select Change Mask. Deselect ring 5 because it did not
“view” any foliage.

7 Next, check the Change Canopy Model check box,
then the Isolated Computed radio button. Check the
Change Vertical Profile button, then select Edit….

8 Enter the X, Z coordinates to define the shape of the hedge.
Right click on the canopy profile to add more points.

9 Check the Change Row Ratio box and set the row ratio
to 5. ClickOK.
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10 The new LAI values are displayed in the Log. Save the file to
retain changes.

If the hedge were asymmetrical, two files would be
required, one for each side of the canopy (or row 2
below could be used).

Example 9 - Isolated Row 2
The steps below will create a file similar to the example
ROW2 in the FV2200 software, which is opened by File
> Sample files > Manual Examples.

1 Set the console Transcomp settings toDefine Above:
A;Determine Above: Interpolate; Bad Readings:
Clip. Place a view cap with a 90° opening over the lens and
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create a new file.

2 Make an above-canopy reading, sev-
eral below canopy readings, and a
final above-canopy reading. Take the
below-canopy readings along a line
that is parallel to the centerline of the
shrub, but not directly under the
shrub, as shown.

3 Measure a number of X, Z coordinates
(meters) to characterize the vertical
profile, perpendicular to the center-
line, of the hedge. Measure the distance between where the
B readings were taken and the centerline of the hedge (X off-
set), -0.20 in this case, and the distance between the veget-
ation and the sensor (Z offset) in meters (0.0 in this case), as
shown in the following figure.

4 Measure the width (Y) and depth (X) of the hedge to compute
the row ratio (Y/X).

5 Open the data file in the FV2200 software.

6 Click the Recompute button. In the Recompute Dialog box,
check the Change Canopy Model check box, then the
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Isolated Computed radio button. Check the Change
vertical profile button, then select Edit….

7 Enter the X, Z coordinates to define the shape of the hedge.
Right click on the canopy profile to add more points.

8 Check the Change Sensor check box.

9 Check the Change Row Ratio box and set the ratio. Click
OK.

The new LAI value is shown in the Log. Save the file to
retain changes.
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1.0 Preoperation Procedures
You may need to go through some of these procedures
before starting your field work.

Procedure 1.1 - Setting the Console Clock
Manually
The console clock uses 24-hour time notation (1:00 p.m.
= 13:00). Follow these steps to set the clock:

1 Go toMENU > Console Setup > Set Time and press
OK (or the Right arrow button).

2 The time field reads HH:MM YYYY/MM/DD. Use the Up and
Down arrow buttons to select the correct values for each
field, and use the Left and Right arrow buttons to switch
between fields.

3 PressOK to implement the new time or EXIT to abandon
changes.

Procedure 1.2 - Setting the Console Clock from
GPS
The console clock uses 24-hour time notation (1:00 p.m.
= 13:00). If GPS is active and has valid data, you can
choose to set the clock using GPS-generated Universal
Coordinated Time (UTC). To set the clock using GPS:

1 Go to MENU > Console Setup > Set Time > Use GPS and
press OK (or the Right arrow button).

2 Enter a number for UTC Offset, ± difference from UTC in
hours and minutes for a particular time zone (e.g. if console is
set to Central Daylight Time (USA), then this is –5).

3 Press OK to implement the new time or EXIT to abandon
changes.
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Procedure 1.3 - Setting the Wand Clock
Manually
The optical sensor (wand) clock can be set manually or
synchronized with the control unit clock. To set the
wand clock Manually:

1 Connect the wand to the control unit, go toMENU >
Wand Setup > Select wand > Clock and pressOK
(or the Right arrow button).

2 Select Set Time

3 The time field reads HH:MM YYYY/MM/DD. Use the Up and
Down arrow buttons to select the correct values for each
field, and use the Left and Right arrow buttons to switch
between fields.

4 The time is implemented after you select Yes. Verify the time
and pressOK.

Note: If using two optical sensors, the clocks in both
must be synchronized in order to match data in time.
See Procedure 1.4 - Synchronizing Wand and Console
Clock below.

Procedure 1.4 - Synchronizing Wand and
Console Clock
The optical sensor (wand) clock can be synchronized
with the control unit clock.

1 Connect the wand to the control unit, go toMENU >
Wand Setup > Select wand > Clock and pressOK
(or the Right arrow button).

2 Select Sync Time.

3 The time is implemented after you select Yes. Verify the time
and press OK.
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Procedure 1.5 - Resetting Wand to Factory
Calibration

1 Go toMENU >Wand Setup > Select wand >
Match Values > View/Set.

2 Press LOG.

Note: Factory calibration values need to be in place
for sky brightness distribution to be measured, which
is an important step when doing scattering cor-
rections.

Procedure 1.6 - Deleting Records From a Wand
To delete all records from the optical sensor memory:

1 Attach the optical sensor(s) to the console.

2 Go toMENU > Data > Wand > Purge.

3 Select the appropriate optical sensor.

4 Press OK to purge, or EXIT to return to the Wand Data menu.

Procedure 1.7 - Setting Prompts

1 Press theMenu button, then go to Log Setup and select
Prompt.

2 Enter the desired prompts in the Prompt1 and Prompt2
fields. If you wish, you can enter default responses, or leave
the Resp1 and Resp2 fields blank. Either way, you will be
able to enter responses in the Resp1 and Resp2 fields
when you create a new data file.

Procedure 1.8 - Build a Match File for Two
Sensors (Match Method 1)
This is best done on a cloudless day, in a location with a
clear view of the sky. If the sky is not cloudless in the
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area being viewed by the sensors (and you can’t chose a
better day), then hand-hold both optical sensors (so they
move a little bit) for step 5 and log about 10 readings
instead of 1 or 2.

You will want to do these steps for each size view cap
that you might be using, creating a separate file for
each.

1 Install the view cap to be used on each optical sensor. Each
sensor should have the same view cap size with the same ori-
entation on the lens.

2 Connect the sensors to a console.

3 Reset each sensor to its factory default calibration Procedure
1.5 - Resetting Wand to Factory Calibration on the previous
page).

4 Open a file (Procedure 2.2 - Opening a New Data File on
page 8-24). Give it a name to reflect that it is a match file, and
include the view cap size (e.g. M45 or M90).

5 Make sure sensor are pointed in the same direction, side by
side. Log 1 or 2 readings by pressing LOG for each reading.

6 Close the file.

LAI-2000 Note: If you do this with LAI-2000s, do not
connect two sensors to a single console, but rather use a
separate console for each wand, and make separate files.
Then follow one of two paths:

l Convert each file to LAI-2200C format (Procedure 3.4
- Converting LAI-2000 file to LAI-2200C on page 8-36),
being sure to specify the serial number for the
sensor.

l Combine the two files into one file for that view cap
size (Procedure 3.12 - Combining Multiple Files -
FV2200 on page 8-43).
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Alternatively, if you wish to retain the LAI-2000 format,
then when you create the two files, log A readings in
one, and B readings in the other, and combine the files.
Then, on subsequent data collection, be sure the sensor
that logged the A readings is always the one used for
above data.

Procedure 1.9 - Build a Match File for More than
Two Sensors (Match Method 1)

1 Build match files for pairs of sensors by following the instruc-
tions under Procedure 1.8 - Build a Match File for Two
Sensors (Match Method 1) on page 8-19. If there is an odd
number of sensors, so that one cannot be attached to a con-
sole, then

A Use it autonomously to log readings without a console.
Be sure to clean its memory first (Procedure 1.6 - Delet-
ing Records From a Wand on page 8-19).

B Download the logged records by importing them into the
appropriate match file (Procedure 2.13 - Moving Wand
Data to the Console on page 8-31).

2 Combine all the match files for a given view cap size by using
Procedure 3.12 - Combining Multiple Files - FV2200 on
page 8-43.

Procedure 1.10 - Enabling a Quantum Sensor

1 Attach the quantum sensor cable to port 1 or 2, then go to
MENU > Log Setup > PAR Sensors, select Port 1
or Port 2 (whichever has a quantum sensor attached), and
pressOK.

2 Set the Enabled field toOn.
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3 (Optional) Name the sensor. The name is used in the Con-
tributing Sensors section of data files (see Sensor Information
on page 3-29).

4 In the Cal field, enter the calibration multiplier for your light
sensor. The calibration multiplier is printed on your sensor’s
calibration certificate. It also can be found by entering your
sensor's serial number in the Calibration search box at
http://www.licor.com/env/support.

5 PressOK to implement the changes.

Quantum sensor settings are saved to the global tem-
plate and will be applied to any data file that is created.

Procedure 1.11 - The Canopy Gap Test
The Canopy Gap Test is discussed in The Gap Test on
page 6-11. Follow these steps to estimate the error res-
ulting from using a view cap that is too large:

1 Use a 45° view cap.

2 Set Transcomp to A-P-C (Above, Previous, and Clip).

3 Make a measurement in the canopy consisting of 2AB pairs.
Both of the below readings should be in the same location,
but one viewing the densest part of the canopy, and the other
viewing the sparsest part. (Because they are viewing different
directions, you need separateA readings for each B reading.)

Look at the value of ACF, apparent clumping factor.
For purposes of this test, interpret this as the ratio of the
LAI you would get with a wider view cap to the one
you would get with the narrower view cap. For
example, an ACF of .95 means the wider view cap
would produce an LAI that is 5% lower than that found
with a narrow view cap. An ACF of 0.8 would be 20%
lower, and so on. The lower the ACF, the more you
need the narrow view cap.
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2.0 Field Operation Procedures
Thi section includes procedures for field measurements.

Procedure 2.1 - Making Two Wands Match -
Console Matching
Here’s how to make two sensors match each other prior
to collecting data. This technique will adjust the match
values of one of the sensors. It should be performed
with both sensors viewing a cloudless sky.

Note: This technique is only recommended if LAI
data is to be collected with two wands attached to one
console. There are better matching methods for all
other cases. See Multiple-Sensor Operation Revisited on
page 5-21.

1 Attach the two sensors to be matched to the console, and
turn on the control unit.

2 Place the sensors side by side so they see the same section of
blue, cloudless sky, if at all possible. View the readings in
Monitor mode (Monitor Mode Navigation on page 3-2).

3 Set match values.

A Go to MENU, select Wand Setup, select the wand to be
used for Below readings, and press OK.

B Select Match Values and press OK.

C Select Calculate and press OK. The wand chosen in step
“a” will be set to match the other wand. Press OK.

4 View values in Monitor Mode to confirm match.

5 To reset the original calibration values, select View/Set
Values from theMatch Values menu (Menu >
Wand Setup > Select wand > Match Values).
Press LOG to reset, thenOK.
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Note that when data are logged, each A or B record con-
tains an indicator (e.g. W1, W2, etc) telling what wand
took the data. In the header is a “Contributing Sensors”
section that relates the wand indicators to actual serial
numbers and match values:
 :

DISTS 1.008 1.087 1.270 1.662 2.670

GAPS 0.000 0.000 0.000 0.000 0.000

### Contributing Sensors

MATCH W1 PCH2516 3978 1244 1000 1004 1289

MATCH W2 PCH2462 3650 1044 900 904 1144

### Data

A 1 20090924 15:23:21 W1 199.228 198.956 202.214 186.611 190.670

B 2 20090924 15:23:55 W2 2.48003 2.33006 2.68008 3.11003 4.21009

B 3 20090924 15:24:02 W2 7.43006 2.60031 2.15000 3.34005 4.14001

 :

Procedure 2.2 - Opening a New Data File

1 With the instrument on, press the START|STOP button.

2 SelectNew File and enter a file name (a maximum of 8
characters or numbers). File names are automatically gen-
erated based on the previous entry, incremented by one digit.

3 View/Edit remarks, and/or pressOK.

4 The LAI-2200C is now in Logging Mode. LogA or B readings.

Procedure 2.3 - Import to an Existing Data File

1 With the instrument on and a sensor attached, press the
START|STOP button.

2 Select EXISTING FILE and select a file from the list.

3 View/Edit remarks, and/or pressOK.

4 The LAI-2200C is now in Logging Mode. LogA or B readings.

Hint: It is helpful to sort the list of existing files by
modification date, with most recent files near the top of
the list. To sort the list that way, press theMENU key
when viewing the existing file list, and select Reverse
Date. That sort order will remain for subsequent uses
until you change it to something else.
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Procedure 2.4 - Setting up a Controlled Logging
Sequence
The controlled logging sequence is discussed in Con-
trolled Sequence on page 3-15.

1 Connect the optical sensor to the control unit.

2 Go toMENU > Log Setup > Controlled Sequence
and pressOK.

3 Set theUse field to Yes.

4 Set the number of repetitions (from 1 to 41).

5 Define the sequence. Press the number "2" button to specify
anA reading and the "8" button to specify a B reading (e.g.
for the sequenceABBBB, press 28888). The sequence can
have up to 20 readings.

6 PressOK. The controlled sequence will be used for any new
file.

7 Create a new file (Procedure 2.2 - Opening a New Data File
on the previous page). To view your position in the sequence,
in the logging screen, use the left or right arrow key to
change a field to indicate Seq:. This will indicate where you
are in the sequence. The wand LEDs indicate which reading is
next in the sequence.

The sequence can be interrupted at any time by pressing
the A/B|Power button. For example, if the upcoming
measurement is specified as an A reading, press the
A/B|Power button to change the upcoming reading as
a B reading. After logging the data point, the sequence
will continue with the next specified measurement.

To deactivate the controlled sequence, set the Use field
to No.
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Procedure 2.5 - Creating a Match File for Match
Method 2
Match methods are discussed in Three Methods for
FV2200 Matching on page 5-22.

Set up the A sensor and get it logging. Place the B wand
beside it, open a file, and log several A records:

1 Press START|STOP button on the control unit, select
New File, and name the file "match," or something to
identify it as a match file.

2 Make sure the B wand is set forA records (the ABOVE LED
should be lit).

3 Put the sensors together, being as careful as you can that
they are both equally leveled and oriented. Press the LOG
button several times to capture severalA records.

Procedure 2.6 - Logging a 4A or 3A Sequence
Photos and descriptions of these steps are in K Records
on page 5-7.

1st A reading - white diffuser, sunlit.

2nd A reading - white diffuser, shaded.

3rd A reading - as wide a view as possible.

4th A reading - normal view cap, normal direction (nor-
mal = same as B measurement).

Note that step 3 is optional: If the largest unobstructed
view of the sky is no larger that the view with the nor-
mal view cap, skip this step, and consider it a 3A
sequence.
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Procedure 2.7 - Automatic Logging - Wand
This procedure describes how to configure a wand for
automatic logging. Discussion is in Automatic Logging
(Wand) on page 3-15.

1 Attach the wand to the console. On the console, go to
MENU >Wand Setup > select wand >Auto Log
and pressOK.

2 Select Start Time, and enter the desired start time and day
(you can only set the start day of the current month). Press
OK.

3 Select Stop Time, and enter the desired stop time and day
(current month). PressOK.

4 Select Frequency and enter a multiple of 5 seconds
between 5 and 3600 seconds. PressOK after entering the
value.

5 Select theOn/Off field, highlightOn and pressOK. The
optical sensor can be disconnected from the control unit. If
the wand is powered off, it should power up automatically at
the specified start time. If these readings are “Above,” be
sure that the blue “Above” LED is illuminated. This will ensure
that these readings are tagged with anA in the file.

When automatic logging is “On”, the LOG LED light
on the wand will blink every 2.5 seconds during the
run-up to the logging start time. When it begins logging
data, the LOG LED light will blink every second and
the wand will beep at the beginning and end of each
log.

Note: In wand versions 1.19 and below, automatic
logging may not start if you specify a start time that
has already passed.
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Procedure 2.8 - Automatic Logging - Console
This recipe describes how to configure a console for
automatic logging. Discussion is in Automatic logging
(Console) on page 3-16.

1 Go toMENU > Log Setup > Console AutoLog.

2 Set theActive field toOn. Press the down key to select
Period and enter a multiple of 5 seconds between 5 and
3600 seconds. PressOK after entering the value.

When a file is open and autologging is active, the dis-
play will show AUTO followed by a countdown to the
next log in seconds. All attached sensors (wands and
quantum sensors) are logged, and (if enabled) a G0 GPS
record.

Procedure 2.9 - Importing A Records - Console
When A readings are collected in a separate file, they
need to be imported by the file that holds the B read-
ings before LAI can be computed. This can be done on
the control unit (described below) or with the recom-
mended method of using the FV2200 software (Pro-
cedure 3.8 - Import A and Adjust A Records - FV2200 on
page 8-38).

1 If it hasn’t been done already, transfer the records from the
wand to the console: Go toMENU > Data > Wand
Data > Download > select wand. Choose Create
new file and name the file.

2 Go toMENU > Data > Console Data and select the
file that is to receive the imported records. Select the file that
has the B readings.

3 Select Edit from the menu, then select Import Obser-
vations.

4 Choose to importA records.
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5 PressOK and the file will be recomputed using the imported
records.

6 LAI values will recompute automatically and can be viewed in
MENU > Data > Console Data > select file >
View Header.

Procedure 2.10 - Excluding Rings from Analysis -
Console
The mask determines which rings are used (default =
all) to compute LAI. Data from rings that are ignored
are still measured and recorded, however, so nothing is
lost even if a data file is generated with all rings
ignored.

Prior to logging:

1 Go toMENU > Log Setup > Masks.

2 Select YES for every ring to be used orNO for every ring to
be ignored.

3 PressOK to keep the settings, EXIT to leave the menu
without making changes, or LOG to reset to default settings.

After logging:

1 Go toMENU > Data > Console > select data file
> Edit > Edit Mask.

2 Select YES for every ring to be used orNO for every ring to
be ignored.

3 PressOK to keep the settings, EXIT to leave the menu
without making changes, or LOG to reset to default settings.

Rings can also be excluded in post-processing with the
FV2200 software. Follow Procedure 3.5 - Excluding Rings
from Analysis - FV2200 on page 8-37.



LAI-2200C Plant Canopy Analyzer Instruction Manual

8-30

Procedure 2.11 - Interpolating A Records -
Console
The Interpolate Transcomp setting will choose the A
reading that is closest in time to a given B reading to
compute LAI.

1 Go toMENU > Log Setup > Transcomp.

2 Scroll down to the line below "Determine Above".

3 Use the left and right arrow keys to select Interpolate.

4 PressOK to keep the settings, EXIT to leave the menu
without making changes, or LOG to reset to default settings.

Procedure 2.12 - Getting K Records on an Above
Sensor
When a wand is logging A records autonomously, it is
possible to also use this wand for getting K record pre-
cursors, provided the logging interval is about 30
seconds or more. The goal is to intersperse a 2B or 3B
sequence into the file. See Embedded Bs on page 5-16 for
more explanation.

When it’s time to get another K record, do this:

1 Wait for an autolog to occur.

2 Push theA/B button to change to B records.

3 Remove the view cap, and put the white diffuser in place.

4 With the sun on the diffuser, press the LOG button.

5 Shade the diffuser, and press the LOG button again.

6 (Optional wide sky view). Remove the diffuser. With the
sensor shaded, or with a 270° view cap, press LOG again.

7 Place the normal view cap back on, and press theA/B button
to change back toA records, so that the next autologged
reading will be anA.
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8 Use FV2200 to convert BBBA or BBA sequences to K records
(Procedure 3.9 - Generating K records from Sequences on
page 8-39).

Procedure 2.13 - Moving Wand Data to the
Console
Wand data can be moved to the console and put in a
new file or import to an existing file.

1 Connect the wand to the console. On the console, go to
MENU > Data.

2 SelectWand Data and then chooseDownload.

3 Select the optical sensor that has the desired data.

4 SelectNew File to create a new data file or selectAdd to
File to import an existing data file.

5 If you chooseNew File, name the file (up to eight char-
acters) and pressOK. If you chooseAdd to File, select the
file from the list and pressOK.

It may take several seconds for the file to be transferred
and for appended files to be modified. When the file is
copied, it remains in the memory of the optical sensor.
To delete files from the optical sensor memory, follow
Procedure 1.6 - Deleting Records From a Wand on
page 8-19.

Procedure 2.14 - Measuring Leaf Transmittance
and Reflectance
The theoretical discussion for this procedure is in
Required Inputs for the Scattering Model on page 10-12.
Leaf transmittance will be labeled LeafTau and leaf
reflectance will be LeafRho. This technique was first
described in Kobayashi et al., 2013.
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You will need an optical sensor (wand), the drilled cap
(lens cap with a small hole in the middle), and a white
diffuse reflectance standard panel (about 25 cm by 25
cm). Let Rpanel be the absolute reflectance of the panel.
Typical Rpanel for a clean, halon reflectance standard is
0.99. You can use something less reflective, as long as
you know its reflectance.

This procedure should be done on a clear day with the
sun far enough from the zenith (overhead) so that the
sensor will not shade the reflectance panel when moun-
ted above it.

1 Attach the drilled cap (with the small hole) to the optical
sensor. Attach the optical sensor to the control unit.

2 Using a ring stand or other suitable device, mount the optical
sensor about 20 cm above the center of the white standard
panel, viewing downward. Make sure the sensor or ring stand
does not shade the panel.

3 Determine the size of the optical sensor’s view by increasingly
shading one corner of the white standard panel until the Ring
#1 reading begins to change (Figure 8-1 on page 8-34). This
indicates how far the view extends from the center of the
panel. Doing this shading on three corners instead of just one
will account for any sensor tilt. Adjust the sensor’s height
until its view includes as much of the panel as possible
without getting closer than a few centimeters from the
panel's edge. All subsequent measurements should be with
the sensor locked in this position.

4 Hold a leaf against the optical sensor lens cap so that the hole
is completely covered by the leaf. Note the Ring #1 reading;
we will refer to this value as T.

5 Remove the leaf, and note the Ring #1 reading again. This is
Tref.
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LeafTau = T / Tref
6 Cover the reflectance standard with the type of leaves being

measured. Overlap them so that all parts of the panel visible
to the sensor are covered. Note the Ring #1 reading; we will
refer to this value as R.

7 Remove the leaves and any debris and note the Ring #1 read-
ing again. This is Rref.

LeafRho = R / Rref / Rpanel
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Figure 8-1. Determining wand height for measuring leaf
optical properties. Viewed from above. Shade three corners of
the reflectance panel to determine the area viewed by the
optical sensor. Shading of the viewed area causes the reading
to change. Adjust wand height until the viewed area fills as
much of the reflectance panel as possible without getting very
close to the edge.

3.0 Post Operation Procedures
This section describes procedures that you will follow
after collecting data.
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Procedure 3.1 - Moving Data to a Computer

1 Connect the console to your computer with the USB cable. It
will appear as a mass storage drive named LAI.

2 Open the data folder in the LAI drive.

3 Locate the LAI file (look for name it was given for logging),
and drag or copy it to a directory on your computer.

Note: The LAI-2270C Control Unit will not be recog-
nized if it is in Logging Mode or a menu, so be sure
to enter the Monitor Mode by pressing EXIT, or just
turn off the control unit.

Procedure 3.2 - LAI-2000 File Transfer - RS-232
The steps below describe how to import data from an
LAI-2000 using FV2200:

1 Click theAcquire button to launch the Acquire Wizard.
Enable the LAI-2000 radio button and clickNext.

2 Connect the LAI-2000 to the serial port on your computer with
a 9-pin RS-232 cable. On the LAI-2000, press FCT 31 and
enter the following settings: Baud=4800; Data bits=8;
Parity=none; XON/XOFF=NO.

3 Press FCT 33 and enter the following: Format: Stand-
ard; Print Obs: YES.

4 ClickNext.

5 Select the serial port that is attached to the LAI-2000 and
clickNext.

6 Choose whether you would like to route to a view (check
Add to View), save the file, or both. You may open the
files in any of the current view tabs or a new view tab, and
save multiple files as one file.
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7 On the LAI-2000, Press FCT 32 and enter the page range.
The incoming data will be displayed in the Wizard window, as
well as routed to a view and/or saved in a file, depending on
what you selected.

8 Click Finish and FV2200 will process the last file that was
downloaded. Note that the last file received will not be pro-
cessed (added to a view, or written to disk) until you click the
Finish button.

Procedure 3.3 - Loading Data Files into FV2200
The FV2200 software package can be used to read data
files directly from the console (connected with a USB
cable), or files can be dragged to the computer and read
from there (Procedure 3.1 - Moving Data to a Computer on
the previous page).

1 Launch FV2200 on your computer (see Data Analysis with
FV2200 on page 7-1).

2 Click theOpen icon or File > Open and navigate to the
stored file.

3 Double click the file to open it, or select multiple files and
clickOK.

Alternatively, you can drag the data file(s) onto the
main window: The file(s) will be opened in the current
view, or if there are no views, one will be created. On
Mac and Windows operating systems, you can drag and
drop the data file(s) onto the FV2200 icon.

Procedure 3.4 - Converting LAI-2000 file to
LAI-2200C
There are a couple of ways to do this. To convert a
single file, you can use the Current tab of the Details
window. The advantage of this method is that you have
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an opportunity to specify sensor serial numbers, which
are useful when doing importing and adjusting records
(Procedure 3.8 - Import A and Adjust A Records - FV2200
on the next page). Another method of converting
formats involves saving files in a view.

Details for both methods are included in the FV2200
User Guide on the "Help" tab of FV2200.

Procedure 3.5 - Excluding Rings from Analysis -
FV2200
Mask attributes can be changed in the FV2200 software
so that selected rings are excluded.

1 In the Main Window, select the files that you wish to recom-
pute, and click the Recompute button (or click Edit >
Recompute). The Recompute Observations dialog
box will appear. Alternatively, double-click a data file to open
the File Details window, select the Header tab and click
Change…

2 Enable the Change Mask box, then unselect the box
beside each ring that is to be omitted.

3 ClickOK. Changes to calculations will also be displayed in
the “Log” section of the Main Window.

Procedure 3.6 - Interpolating A Records - FV2200
There are a couple of ways to do this:

l For one or more files, use the Recompute tool,
check the Recompute Transmittance box, and
check the interpolation radio button.

l For a single file, open the Details view, click the
Header tab, then click the Change... button in the
Canopy Model andMask box.
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l Use the Details view, click the Current tab, and edit
the middle item of the Transcomp= line to be an i,
and click Keep.

l If the file has not had A records imported yet, you
can specify that the A records are to be interpolated
in the Import dialog box.

Procedure 3.7 - Recomputing a Data File -
Console

1 Go toMENU > Data > Console.

2 Select a data file.

3 Select Recompute to recalculate LAI or other variables.

This can also be done with FV2200 using Edit >
Recompute.

Procedure 3.8 - Import A and Adjust A Records -
FV2200
Detailed examples are in the FV2200 2.0 User Guide
(Access in the Help menu). Here is a simplified outline:

1 Open the "above" and "below" file(s). You may elect to put
them into one view.

2 If match files are involved, load them as well.

3 Open the Import dialog (Edit > Records > Import).

4 If imported readings are to be adjusted, click theAdjust
box, and select the match method to be used.

5 Check the appropriate boxes in the list of files, identifying the
match files(s), source, and destination.

6 ClickOK.
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Procedure 3.9 - Generating K records from
Sequences

Normally, you only check one pattern (AAAA, AAA,
etc.) per file. You can get away with mixing certain pat-
terns, however, such as AAAA and AAA, or BBBA and
BBA provided the sequences do not run together. In
other words, 4A or 3A sequences surrounded by B
records would be fine, or 3B or 2B records surrounded
by A records would be fine. (You would not want to
mix A sequences with B sequences, however). The order
that FV2200 converts records in a file (if doing more
than one sequence in the file) is this: 4A, then 3A, then
3BA, then 2BA. So, if you have 4A and 3A together,
the 4As will be done first, before the 3As. If you do
check more than one pattern for a file, you will see a
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warning. It won’t stop you; it’s just a check to see if you
know what you are doing.

Procedure 3.10 - Importing K Records
If you have K records, but not in the right file, or need
to share K records among multiple files, then follow
these steps (also illustrated in Figure 8-2 on the facing
page):

1 Put the source and destination files (the files that have K
records, and the files that need them) into the same view, and
make that the active view.

2 Open the Scattering tool (Edit > Scattering).

3 Click the K Records tab.

4 Set the drop-down menu to Import K Records.

5 In the file list, check the Source andDest boxes as
needed.

6 Click the Import K Records button.

FV2200 is smart about importing K records; it only cop-
ies the ones that are needed for any given file, based on
the times of the B records in the destination files. It will
always import at least one, and more if they are avail-
able and if the B record times warrant it.
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Figure 8-2. Importing K Records. K records can be copied
from files that have them to files that need them. Only the
closest-in-time K records are copied.

Procedure 3.11 - Set Scattering Inputs for a
Group of Files
Examples are in the FV2200 2.0 User Guide (Access in
the Help Menu). Here is a simplified outline:

1 Put the files for which you want to do scattering correction
into a common view, and make it the active one.

2 If any of the files contain K Record precursors (e.g. 4A
sequences), generate the K records (Procedure 3.9 - Gen-
erating K records from Sequences on page 8-39).

3 If any of the files need to import K records, do that next (Pro-
cedure 3.10 - Importing K Records on the previous page).

4 If any of the files need to importA records, do that next (Pro-
cedure 3.8 - Import A and Adjust A Records - FV2200 on
page 8-38).
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5 If there are still files with no K records, you can generate
them based on assumptions:

A Click the K Record tab in the Scattering tool (Edit >
Scattering).

B Set the drop-down menu toMake K Records from
Assumptions.

C Set the input fields, and select the Target files.

D Click theGenerate button.

6 Set remaining inputs:

A In the view, highlight the file(s) that are to receive these
inputs.

B Click the Clipboard tab (Figure 8-3 below) in the Scat-
tering tool (Edit > Scattering).

C Set the input values.

D Click theUpdate button.

Figure 8-3. Clipboard for scattering correction inputs. For
information on obtaining scattering properties, see Required
Inputs for the Scattering Model on page 10-12 .
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Procedure 3.12 - Combining Multiple Files -
FV2200
The Combine Files dialog (File > Combine) lets you
pick a selection of files for which all of the data records
are to be combined. The file header information of the
resulting file will be based on the first file’s headers in
the source list.

If you need a more customized method to combine
files, you can simply cut and past from the Detail View.
The thing to watch if you do that, however, is the Con-
tributing Sensor information and the Sensor ID values
of each record. The Combine Files automated routine
takes care of relating sensor IDs (W1, W2, etc.) to the
proper sensor in a new list. For example, if one file has
one Contributing Sensor, say serial # 1234, and another
file has a different one (#4321), if you combine by cut-
and-pasting records, all files will have sensor ID’s of W1,
and differences will be lost. The automated combine,
however, will leave you with W1 and W2 records, with
both sensors appearing in the Contributing Sensor list
labeled appropriately as W1 and W2.



LAI-2200C Plant Canopy Analyzer Instruction Manual

8-44

Procedure 3.13 - Determining LAI for each B
record - FV2200
Double click the file to get the Details view, and click
on the Gap Fractions tab.

4.0 Miscellaneous Procedures
This section describes procedures that you may nned to
do under special circumstances.

Procedure 4.1 - Sky Variability Test
The sky variability test is discussed and demonstrated in
Sky Variability Tests on page 5-2.

1 Log a file ofA readings with a sensor mounted on a tripod,
logging at regular intervals—perhaps 10 seconds.

2 Move the file to a computer, and load it into FV2200.

3 Double click on the file to open the Details window.

4 Click the Sky Test tab in the Details window.
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Section 9.
Instrument Software Reference
This section provides a description of the functions that
are available through the LAI-2200C Control Unit soft-
ware.

Main Menu
1 Wand Setup
Select Wand X (name) or Y (name).

1.1 Set Name
These fields are used to name the optical sensors. When
an optical sensor is named, the name is stored in the
optical sensor. For example, if an optical sensor is
attached to the X port and named “PCH3102”, and later
attached to the Y port, it will still be called “PCH3102”.

1.2 Clock
1.2.1 Set
The Set function is used to manually enter the time
for the optical sensor clocks (HH:MM,
YYYY/MM/DD).

1.2.2 Sync
The Sync function sets the optical sensor clock based
on the control unit clock. Presents Yes/No veri-
fication.
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1.3 Cal Values
Calibration multipliers are set from this field. Use the
arrow and numeric keys to enter calibration values.
Press OK to store the values. These values should
match the calibration sheet.

1.4 Match Values
These functions pertain to the match values for the
selected wand.

1.4.1 View / Set Values
View/Set allows you to view and/or edit the cur-
rent values, or reset them to the calibration values
by pressing LOG.

1.4.2 Compute Values
Two wands must be connected for this. The wand
selected when entering the menu will be matched
to the other. Compute will determine the values
by measurement: You will need a second wand con-
nected to do this, and both wands positioned and
stable, viewing the same view of the sky (Don't do
this indoors with artificial light, or looking out a
window - tiny variations in views can cause large
errors in those environments.) When you select
"Yes", the match will be performed.

1.5 Auto Log
1.5.1 On/Off
1.5.2 Start Time
1.5.3 Stop Time
1.5.4 Frequency
Auto Log and the subsequent menu options are
used to configure automatic logging, start time,
stop time, and frequency.
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2 Log Setup
These settings apply to new data, not existing data.

2.1 Transcomp
2.1.1 Define above:
This field defines how the sensor determines which
readings are above-canopy and which are below-
canopy.

Compare: The console will compare adjacent
records to determine which type (A or B) has con-
sistently higher values for active (non-masked)
rings. That type will then be considered the above-
canopy record type.

A: Means that readings taken while the optical
sensor “Above” LED is illuminated will be con-
sidered above-canopy readings when calculating
LAI.

B: Readings taken while the optical sensor “Above”
LED is not illuminated will be considered below-
canopy readings when calculating LAI.

2.1.2 Determine Above:
This field defines how the sensor uses above-can-
opy readings when computing LAI.

Previous: Uses the previous above-canopy record
in the file to compute LAI.

Interpolate: Interpolates between two closest-in-
time above-canopy records to generate each
required above-canopy record. This is particularly
useful when sky conditions are changing rapidly.
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Closest: Associates each above-canopy record with
the closest below-canopy record (in time) to com-
pute LAI.

2.1.3 Bad Readings:
Bad readings occur when a below reading exceeds
the value of a corresponding above reading (see
page Bad Readings on page 4-7). There are two
options:

Skip: The instrument will beep if a below reading
has transmittance >1.0. It will log the below read-
ing, but it will not use the record when computing
LAI.

Clip: The transmittance for that ring in that record
will be taken to be 1.0 when LAI is computed.

2.2 Prompts
Prompt1:
Resp1:
Prompt2:
Resp2:
Set prompts to prompt the user for additional inform-
ation that will be recorded with each data file.

2.3 Obs Remarks
Remarks can be entered for each logged record.
Remarks are set at this menu level or changed for
individual records by entering the Log Setup menu
while in logging mode. Changes to the remark are
saved with each subsequent data file.

2.4 Angles
2.4.1 Sensor Angles:

1: 7.00
2: 23.00
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3: 38.00
4: 53.00
5: 68.00

Angles in these fields are set to reflect the view of
each ring in the sensor.

2.5 Distances
2.5.1 Distance Vectors

1: 1.008
2: 1.087
3: 1.270
4: 1.662
5: 2.670

The values are the average path length each ring
sees through the canopy. By default, the values are
1/cos θ . For large, flat uniform canopies, this is suf-
ficient; canopy height does not matter. For isolated
canopies, the values should represent actual path
lengths in meters.

2.6 Masks
2.6.1 Use Ring

Ring1: <YES | NO>
Ring2: <YES | NO>
Ring3: <YES | NO>
Ring4: <YES | NO>
Ring5: <YES | NO>

Determines which rings are used in LAI cal-
culations. To exclude a ring, set its value (use ←
and → ) to No. To reset (all rings to Yes), press the
LOG button while viewing this screen.

2.7 Controlled Sequence
Use: Yes|No
Reps: up to 41
Pattern:
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2.8 Console AutoLog
Active: < On | Off >
Period: xx

The logging period can be entered in multiples of 5
seconds with a maximum of 3600 seconds (1 hour).

2.9 PAR Sensors
2.8.1 Port 1
2.8.2 Port 2

Enabled: < On | Off >
Name: Port 1
Cal: xxxxx

These fields are used to configure LI-COR radi-
ation sensors. Enable the port by selecting On,
Name the sensor, and enter the calibration mul-
tiplier for the sensor.

2.10 GPS
Active: < On | Off >
Log GPS: < Yes | No >
When: < A | B | Any >

3 Data

3.1 Console Data
3.1.1 Select data file:
3.1.1.1 Quick View
Shows the file header, which includes the file
name, time and date created, responses to
prompts, LAI, SEL, ACF, MTA, SEM, DIFN,
and SMP (sample size). This also shows GPS
information if the GPS is on.

3.1.1.2 View
3.1.1.2.1 View Header
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Shows file name, time and date created,
responses to prompts, LAI, SEL, ACF, MTA,
SEM, DIFN, and SMP (sample size). This also
shows GPS information if the GPS is on.
3.1.1.2.2 View ANGLES/MASK

Shows angles and masks used to compute the
selected data file.
3.1.1.2.3 View CNTCT #/STDDEV

Shows contact number and standard deviation
computed for the selected data file.

3.1.1.2.4 View AVGTRANS/GAPS

Shows average transmittance and gap fraction
computed for the selected data file.

3.1.1.2.5 View DISTS/ACFS

Shows distances and apparent clumping
factors for each ring.

3.1.1.2.6 View Observations

Shows ring values for each above and below
reading in the file. Use the left/right arrow
keys to scroll through readings.

3.1.1.3 Edit
These options pertain to the selected data file
only.

3.1.1.3.1 Edit Angles

Sensor Angles: Edit the angles used in com-
putations. Press OK to save new settings,
EXIT to cancel, and LOG to reset to default
settings.
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3.1.1.3.2 Edit Mask

Use Mask: Apply a mask to any ring that is
not to be used in computations. Press OK to
save the new settings, EXIT to cancel, and
LOG to reset to default values.

3.1.1.3.3 Edit Distances

Distance Vectors: Change these values to alter
distances used in computations. Press OK to
save the new settings, EXIT to cancel, and
LOG to reset to default values.

3.1.1.3.4 Edit Transcomp

Use this field to change how the instrument
defines above-canopy readings, determines
above-canopy readings, and treats bad read-
ings. A full description is in section 2.1 above.

3.1.1.3.5 Import Observations

This function can be used to import A or B
records from another file.
3.1.1.3.6 Strip Observations

This function can be used to remove all A or
B records from a file.

3.1.1.4 Recompute
Recomputes values for the selected data file. Use
if any changes have been made to the file.
3.1.1.5 Delete
Permanently deletes the selected file.

3.1.1.5 Rename
Prompts for a new file name for the selected file.
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3.2 Wand Data
3.2.1 Download – to transfer data from the wand
to the control unit.

3.2.2 Purge – to delete data files from the wand.

4 Console Setup

4.1 Set Time
4.1.1 Console Time
Prompts for time and date. Use the up and down
arrow keys to set time and date, or set via GPS
UTC if available.

4.2 Auto Off Timer
Set the duration that the control unit will remain
“On” before powering off automatically. The auto off
timer can be set to 5-60 minutes in increments of 5
minutes using the up/down arrow keys.

4.3 Beeper
Turns the instrument beeper “On/Off”. Select the
desired setting and press OK.

5 Firmware

5.1 Console
5.1.1 Info
5.1.2 Upgrade
See page Console Firmware on page 2-12 for details.

5.2 Wand
5.2.1 Info
5.2.2 Upgrade
See page Optical Sensor Firmware on page 2-13 for
details.
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Section 10.
Theory
The LAI-2200C measures the probability of seeing the sky
when looking up through a vegetative canopy in different
directions. These measurements essentially contain two
pieces of structural information about the canopy: 1) the
amount of foliage in the canopy and 2) the foliage ori-
entation. This section describes the details of how the
LAI-2200C extracts this information from its meas-
urements.

Calculations
As a beam of light passes through a plant canopy, there is
a certain probability that it will be intercepted by foliage.
The probability of interception is proportional to the path
length, foliage density (area of foliage per volume of can-
opy), and foliage orientation. If foliage elements are small
compared to the overall canopy, and they are randomly dis-
tributed in the sensor view, then it is well known that a
beam of light from zenith angle θ has a probability of P(θ)
of non-interception:

10-1

where G(θ) is the fraction of foliage projected toward θ , µ
is foliage density (m2 foliage per m3 canopy volume), and
S(θ) is path length (m) through the canopy at angle θ .
Miller (1967) gives the exact solution for µ as
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Foliage Density and Leaf Area Index
In a horizontally large, homogeneous canopy, path
length, S(θ) is related to canopy height h by

10-3

In such a canopy, the relation between leaf area index L
and foliage density µ is

10-4

Substituting these into (10-2) yields

10-5

Thus, we can use a common formula 10-7 for com-
puting either L or μ: For L, we use S(θ)=1/cosθ (height h
does not matter because it cancels out of equation 10-5,
and for computing μ we use actual values of S(θ). The
difference between L and μ is driven by S(θ).

Clumping
When multiple observations of P(θ) are available, there
are two ways they can be combined: The values of P(θ)
can be averaged:

10-6



Section 10. Theory

10-3

or the values of lnP(θ) averaged:

10-7

Equation 10-7 will account for clumping (on spatial
scales larger than the field of view of the sensor), but
equation 10-6 is appropriate for determining effective
leaf area index Le, which by definition must ignore
clumping.

The LAI-2200C computes both of these, and uses equa-
tion 10-7 for its reported leaf area index value L, and the
ratio of equations 10-6 and 10-7 for computing Ωapp, the
apparent clumping factor (Ryu et al. 2010).

10-8

Effective leaf area index, Le, can be computed by

10-9

Foliage Orientation
Once L or µ is determined from equation 10-1, equation
10-2 can be solved for the orientation function G(θ ).

10-10

Figure 10-1 on the next page shows the theoretical values
of G(θ ) for an ideal canopy whose foliage is random
both in position and azimuthal orientation, but inclined
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at a fixed angle. Curves for ten different foliage inclin-
ation angles are shown.

Figure 10-1. Idealized relationship between projected foliage
area and direction for various foliage inclination angles,
after Warren Wilson (1959).

The (rad-1) LAI-2200C calculates foliage mean tilt angle
after the manner of Lang (1986), using an empirical

polynomial relating inclination angle to the slopes of
the idealized curves between 25° and 65° (data in Table
10-1 on the facing page, plot in Figure 10-2 on the facing
page).
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MTA
(degrees)

Slope
MTA
(degrees)

Slope

1 -0.6964 50 -0.1547
10 -0.6859 60 0.1180
20 -0.6546 70 0.3164
30 -0.5855 80 0.4131
40 -0.4105 89 0.4431

Table 10-1.

Figure 10-2. Plot of equation 10-22, which relates slope of
the foliage orientation function to average inclination angle.
0° leaf angle is horizontal, and 90° is vertical.

Implementation Algorithms
In this section, the subscript i refers to optical sensor
rings (i=1…5), and the subscript j refers to observational
pairs (j=1…Nobs). Bij is the jth below-canopy observation,
ith ring, and Aij is its corresponding above canopy read-
ing.
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AVGTRANS
The average probability of light penetration into the can-
opy is computed by

10-11

The 5 values of are labeled AVGTRANS in the

LAI-2200C data file.

GAPS
The probability of light penetration based on averaging
the logarithms of transmittance for the ith ring is com-
puted from

10-12

The values of Gi are labeled GAPS in the data file.

LAI and CNTCT#
The leaf area index L for the file, labeled LAI, is com-
puted from

10-13

where

10-14

and
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10-15

Ki is sometimes called the contact number, and is repor-
ted with the label CNTCT# in the data file. For further
explanation of Wi, see Weighting Factors, below.

ACF and ACFS
An apparent clumping factor for each ring, labeled
ACFS in the LAI-2200C data file, is computed from

10-16

A total apparent clumping factor, Ωapp, labeled ACF in
the data file, is computed from

10-17

SEL and STDDEV
Standard error Lse of the leaf area index value is reported
as SEL, and is computed from

10-18

where Lj is the leaf area index calculated for an indi-
vidual A/B pair
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10-19

where Kij is the contact value for the pair.

10-20

The standard deviation of the contact numbers is
reported as STDEV, and computed from

10-21

MTA
Mean Tilt Angle α f is the average inclination of the
foliage in degrees from the horizontal (0=flat, 90=ve-
ertical), and is computed from a 5th order polynomial α
(m):

10-22

where

a0=56.81964
a1=46.84833
a2=-64.62133
a3=-158.69141
a4=522.06260
a5=1008.14931
The value of α(m) is constrained so that 0≤α(m)≤90. The
independent variable m is the slope of the mean contact
numbers (K) plotted against ring angle θ in radians.
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10-23

SEM
Standard error of the mean tilt angle is estimated from

10-24

where mse is the standard error of the slope m. When m
> 0, we use (m-mse); otherwise, we use (m+mse).

DIFN
Diffuse non-interceptance D is the fraction of sky radi-
ation that will penetrate the canopy, averaged over the
hemisphere (Norman and Welles, 1983). Note: this is
computed from not .

10-25

where

10-26

This value is reported as DIFN in the data file. FV2200
makes a related computation (Dsky, labeled DIFN_SKY),
that is weighted by sky brightness distribution based on
the A readings.

10-27
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where Ai is the average of the NA above canopy readings
in the file.

10-28

Weighting Factors
The weighting factors for LAI and DIFN work out to be
(when no rings are masked):

θi dθi
Wi
sinθdθ

W'i
sinθcosθdθ

7 12.2 0.041 0.033
23 12.2 0.131 0.097
38 11.8 0.201 0.127
53 13.2 0.290 0.141
68 13.2 0.337 0.102

When a ring is masked (excluded from the com-
putations), its weighting value is set to 0. This will
increase the weighting of the remaining rings, since
their sum must be

10-29

and

10-30

The values of Wi are available on the FV2200 as the
LAI_wt, and the values of W’i are shown as DIFN_wt.
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Alternative Methods
Gap fractions have been measured using fisheye pho-
tographs (Anderson, 1971; Bonhomme and Chartier
1972), by traversing a sunward-pointed sensor beneath
the canopy (reviewed by Ross, 1981; Lang et al. 1985;
Perry et al. 1988), by linear light sensors (Walker et al.
1988), and by pushing metal probes through the canopy
(Warren Wilson, 1959).

See Norman and Campbell (1989), Welles (1990),
Welles and Cohen (1996), Gower et al. (1999), Machado
and Reich (1999), de Jesus et al. (2001), Mussche et al.
(2001), Breda (2003) Hyer and Goertz (2004), Keane et
al. (2005), Garrigues et al. (2008) for additional reviews
and comparisons.

Mathematical techniques for deducing foliage density
and angle distribution from measurements of gap frac-
tion (or contact frequency) have been presented by
many authors, including Warren Wilson (1959), Miller
(1963, 1967), Philip (1965), Ross (1981), Anderson
(1984a, 1984b), Lang (1986, 1987), Lang et al. (1985),
Perry et al. (1988), and Norman and Campbell (1989).

Scattering Correction
One of the traditional underlying assumptions of the
LAI-2000 and LAI-2200C has always been that foliage
absorbs all the radiation in the waveband seen by the
sensor (320-490 nm). Starting with version 2.0, FV2200
allows this assumption to be set aside, and provides a
model (Kobayashi et al, 2013) for correcting meas-
urements for the radiation reflected and transmitted by
the foliage.
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How Scattering Correction Works
The algorithm that FV2200 uses for correcting for scat-
tering goes something like this:

1 Compute gap fractions. From the measured gap fractions, cal-
culate a first guess of leaf area index (LAI) and leaf angle dis-
tribution (LAD).

2 Predict the scattering effect on gap fractions. Run the Kobay-
ashi model to predict the error that an LAI-2200C would make
in a canopy based on LAI, LAD, and the other scattering cor-
rection inputs (leaf properties, sky brightness distribution,
etc.). The model is a one-dimensional, multi-layer model, hav-
ing foliage properties that you have specified. Foliage ori-
entation, clumping, and total LAI is based on Step 1.

The model propagates beam and diffuse radiation
through the layers, and predicts fractional irradiances
on sunlit and shaded leaves in each layer. It then pre-
dicts the view that the LAI sensor, and the bottom of
the canopy, has of the sunlit and shaded foliage
throughout the model, and the resulting radiation
errors each ring of a B reading would have.

3 Subtract the scattering effect from gap fractions. The gap frac-
tions are then adjusted to remove the predicted scattering
effects.

4 The adjusted gap fractions are used to compute a new LAI
and LAD. If they have not changed, the process is done. Other-
wise, it’s back to step 2 with the adjusted gap fractions.

This process usually takes 4 or 5 iterations.

Required Inputs for the Scattering Model
The scattering model uses the following inputs:
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l LeafRho: Average foliage reflectance in the blue
(230-490 nm waveband).

l LeafTau: Average foliage transmittance in the blue.
l SoilRho: Surface reflectance beneath the canopy in

the blue.
l SolarZen: Solar zenith angle (0° = overhead, 90° = on

horizon).
l SolarAzm: Solar azimuth angle (0° = North, 90° =

East, etc.).
l SkyViewCap: The azimuthal view size of WideSky

values (e.g. 270°).
l AViewCap: The azimuthal view size of ASky values

(e.g. 45°).
l AViewAzm: The azimuthal direction of ASky values

(0° = N, 90° = East, etc.).
l FBeam: The fraction of the total incident radiation

from the sky that is direct beam, in the blue.
l WideSky: The 5 ring values of sky brightness using

the SkyViewCap.
l ASky: The 5 ring values of sky brightness using the

ASky Cap.

Scattering Properties
The three values for average vegetative reflectance, trans-
mittance, and the surface beneath the canopy (LeafRho,
LeafTau, and SoilRho) should be for the 320-490 nm
(blue) waveband. The values could come from spec-
troradiometric measurements integrated over this wave-
band, or from a radiometer sensitive in that waveband.

Kobayashi et. al. present a technique for using the
LAI-2x00 optical sensor (wand) and a reference panel to
determine leaf reflectance (LeafRho) and transmittance
(LeafTau) values. To use this method, follow Procedure
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2.14 - Measuring Leaf Transmittance and Reflectance on
page 8-31. A lens cap with a small hole at the center
(1.27 mm in diameter) was attached to the optical
sensor. They also used a white halon diffuse reflectance
standard panel (25 cm x 25 cm and 99% reflectivity).

Sky Brightness Properties
Both WideSky and ASky have the following con-
straints:

l They need to be made with an unobstructed view of
the sky.

l They should be made with the same wand.
l The wands making the measurements should be

using the factory calibration values. This is the cal-
ibration that relates one ring to another. With this
calibration, all of the sensor’s rings will read the
same in a purely isotropic environment. This
(WideSky and ASky) is the one time in LAI-2200C
processing that the rings of the sensor are NOT
treated independently, and the factory isotropic cal-
ibration is needed.

Derivation of Formulae for Determining
# of B Readings
The guideline presented in Chapter 4 for determining
the number of B readings (How Many B Readings? on
page 4-2) comes from the following analysis:

10-31

where M is the true mean of a population, m is the
mean of a sample of that population, t(n) is the value of
the t distribution (ignoring sign) for a 5% probability,
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and E is the standard error of m. We rewrite equation
10-31 in terms of an acceptable uncertainty :

10-32

Since standard error E is standard deviation D divided
by the square root of the number of samples n, we can
express as:

10-33

To solve equation 10-33 for sample size n, we find a
functional relationship for t(n) by fitting a curve to the
form

10-34

and find a = -0.11528, b = 0.060798, and c = 2.9817. Sub-
stituting equation 10-34 into 10-33 and solving for n
yields

10-35

where

and .

As a practical matter, the term can be determ-
ined by a “trial measurement” with the LAI-2200C using
some number of B readings. These readings should be a
fair representation of the diversity of the foliage density.
Given LAI, SEL, and SMP, the term can be
computed from
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10-36

Table 10-2 below, from equation 10-35, predicts the
number of samples necessary for a 95% confidence that
a sampled mean is within some error of a population
mean.

n n n
0.2 2 1.2 8 2.2 19
0.4 3 1.4 10 2.4 22
0.6 4 1.6 12 2.6 25
0.8 5 1.8 14 2.8 28
1.0 7 2.0 16 3.0 30

Table 10-2.

Table 4-1 on page 4-4 is in terms of SEL and LAI, rather
than D and m, and is based on a sample of 6 (SMP)
with = 0.1.



A-1

Appendix A.
Troubleshooting
Console will not power up:

This could be one of three things: low batteries, a locked
processor (try removing the batteries for a few seconds), or
a short in a wand (try disconnecting all sensors).

Can’t match sensors (Console Match Procedure 2.1 -
Making Two Wands Match - Console Matching on
page 8-23):

Be sure both sensors see the same diffuse view. Also, be
sure that both wand match values are set to their default
values before performing a match. If the match values are
not set to their defaults there is a chance that the match
will fail. If you are still unable to match the sensors after
restoring the default values, reset the match values to those
given on the calibration sheet with the sensor. Then per-
form the match again.

If the sensors see direct sunlight or artificial light, then the
match procedure is futile.

Instrument will not turn off:

The LAI-2200C will not power off if a data file is open or
if it is reading data from the internal memory. Wait a few
moments for the data transfer to finish and close any open
data files, then try again. If the control unit continues to
be unresponsive, press and hold the power button for 5
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seconds. Open data files may be lost. If the LAI-2200C
continues to be unresponsive, remove the “AA” batteries
for a moment. Replace the batteries. Stored data will
not be at risk, but open data files may be lost.

Instrument (wand or console) locks up:

For both the wand and console, remove and re-install
the batteries.

Wand not recognized or does not respond to light:

Disconnect then reconnect the wand. After a few
seconds, the control unit should begin displaying values
associated with the wand.

LAI=0

Check the raw readings on the console or using FV2200.
Are there both A and B records in the file? Do the rel-
ative magnitudes of the A and B records seem correct?
Check the number of samples used. If it is 0, then the
unit threw out all the A and B pairs because of bad read-
ings. Set the Transcomp settings to APC and recompute
the file.

Questionable MTA results:

This may indicate a problem, or be due to the method
used by the control unit to compute MTA. Check the
DISTS values. If they do not reflect the canopy being
measured (isolated canopy or large area), MTA and LAI
will be incorrect. Also, the method used by the control
unit has the drawback of losing resolution near the
extremes of 0° (horizontal leaves) and 90° (vertical
leaves). Refer to Foliage Orientation on page 10-3 for a
plot of the polynomial used. Note that slight changes in
slope (the independent variable) make a big difference
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at the extremes of MTA. It is not uncommon in a can-
opy of relatively horizontal foliage for the control unit
to give MTA values from 0° to 20° or even 30° from one
measurement to the next. If more accurate MTA’s are
needed, use the FV2200 software to compute a mean tilt
angle with the Constrained Least Squares technique.

Data will not read to memory or transfer to a com-
puter:

In rare cases, such as after a fall, the SD memory card
can slip out of place. Follow these steps to check the SD
card and put it back in place if needed:

1 Power off the instrument and remove the AA batteries, if
installed (instructionsMaintenance on page 2-8).

2 Open the instrument case. If the SD card (see Figure A-1 on
the next page) is touching the side of the case, it is dis-
connected. Continue to step 3 to put it back in place. If there
is a gap between the SD card and the instrument case, then
the SD card is not out of place. In that case, contact LI-COR
technical support for assistance.
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Figure A-1. Light sensor and power cable connectors are
circled.

3 Disconnect the light sensor and power cable connectors
(circled above) from the main PC board.

4 Using a small Phillips screwdriver, remove the six screws (see
arrows below) that attach the main PC board to the instru-
ment case.

Figure A-2. Arrows point to the six screws that need to be
removed.
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5 Lift the main PC board slightly above the edge of the instru-
ment case, and push the SD card firmly into the slot. It will
“click” into place when properly inserted.

6 Reinstall the main PC board, replacing the six screws. There
should now be a small gap between the SD card and the side
of the insrument case. To help prevent the SD card from com-
ing loose again, you can place a small piece of tape over the
SD card and its metal card slot, as indicated in figure 11-2.

7 Reconnect the light sensor and power cable connectors to the
main PC board.

8 Reassemble the case.

9 Reinstall the AA batteries and battery cover.

If you continue to have difficulty transferring data or
reading to memory, please call LI-COR technical sup-
port or email envsupport@licor.com for assistance.
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Appendix B.
Specifications

LAI-2270C Control Unit
Sensor Inputs: 2 bulkhead connectors (6-pin) for
LAI-2250 Optical Sensors. 2 BNC bulkhead connectors
for LI-COR Quantum Sensors.

Data Storage Capacity: 128 MB of FAT16 memory.
Keypad: 22 button tactile response keypad. 10 key
numeric keypad with full alphabetic capabilities with 9
function/control keys.

Display: 128x64 graphics LCD display.
Communications: USB (as mass storage device)
Global Positioning System (GPS RADIONOVA® RF
Antenna Module): Horizontal position accuracy: 2.5 m
CEP (50% Circular Error Probability, Open-Sky, 24hr
Static, good view of the sky). Maximum position update
rate: 1 Hz. GPS receiver sensitivity, autonomous acquis-
ition: -148dBm. Time to first fix (TTFF), hot start: 1
second. TTFF, warm start: 6s (typical). TTFF, cold start
(with good view of the sky): 37 seconds at 90% prob-
ability.

Clock: Year, Month, Day, Hour, Minute, Second. Accur-
acy of ±3 minutes per month.

Power Requirements: 4 “AA” batteries (alkaline, NiMH,
or lithium).

Battery Life: 90 hours with 4 “AA” alkaline batteries
without optical sensor attached and without GPS
enabled. 60 hours with 4 “AA” alkaline batteries with
one optical sensor attached and without GPS enabled.
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40 hours with 4 "AA" alkaline batteries without
optical sensor attached and with GPS enabled.

Low Battery Warning: Display indicates when battery
power is <15%.

Size: 20.9 x 9.8 x 3.5 cm (8.2” x 3.9” x 1.4”).
Weight: 0.454 kg (1.0 lb) with batteries.

LAI-2250 Optical Sensor
Sensor Inputs: 1 6-pin bulkhead connector for control
unit interface.

Memory: 1 MB flash memory for record storage; 1KB
EEPROM for calibration and configuration storage.

Keypad: 2 button, tactile response keypad.
Clock: Year, Month, Day, Hour, Minute, Second. ± 3
minutes per month. Can be synced with control unit
clock when joined with a data cable.

Power Requirements: 2 “AA” batteries (alkaline,
NiMH, lithium).

Battery Life: 180 hours of typical operation (with 2
alkaline batteries).

Optics: 1.00° maximum decentering error as measured
from center of mass of ring. 0.50° maximum mag-
nification error as measured from the center of mass
of ring 4.

Wavelength Range: ≈320-490 nm
Nominal Angular Coverage:

Ring1: 0.0-12.3°
Ring 2: 16.7-28.6°
Ring 3: 32.4-43.4°
Ring 4: 47.3-58.1°
Ring 5: 62.3-74.1°

Lens Coating: MgF2 for improved transmission at
oblique angles (external and internal lenses).

View Caps: Provide azimuthal masking of view into
quadrants of 0°, 10°, 45°, 90°, 180°, and 270°.
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Diffuser Cap: Used to cover the lens when measuring
sky radiation properties for scattering corrections.

Size: 63.8 L x 2.9 W x 2.9 D cm (25.1” x 1.125” x 1.125”)
(Endcap: 4.4 W x 5.1 D cm; 1.75” x 2.0”).

Drilled Cap: Used to measure leaf optical properties.
Weight: 0.845 kg (1.86 lbs) with batteries.

LAI-2200C General
Operating Temperature Range: -20 to 50° C (-4 to
122° F).

Humidity Range: 0 to 95% RH, non-condensing con-
ditions.

Storage Temperature Range: -40 to 65° C (-40 to 149°
F).
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Appendix C.
Part Numbers
The following is a partial list of parts available from
LI-COR or your distributor.

Description Part #

LAI-2270C Control Unit LAI-2270C
LAI-2250 Plant Canopy Sensor LAI-2250
Wand Cable 9922-127
Lens Cap Set 9920-005

Lens Cap 6520-020
Diffuser Cap 6522-117
Pinhole Cap 6520-035
View Restricting Cap 90° 6520-021
View Restricting Cap 180° 6520-022
View Restricting Cap 45° 6520-023
View Restricting Cap 270° 6520-029
View Restricting Cap 10° 6520-030

GPS Board 9922-135
GPS Flex Cable 388-13760
3 V Lithium Battery BR1225 442-08614
Wand Battery Cap 345-10735
Storage Case 9922-125
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Appendix D.
LAI-2000 vs. LAI-2200C
1.0 Operational
1.1 The LAI-2200C uses menus instead of Fct codes. Access

the menu by pressing the Menu key. The full structure
is given in Instrument Software Reference on page 9-1.
Changes are shown below, along with the equivalent
Fct codes that the LAI-2000 used.

Main Menu
Wand Setup

<user picks wand>
Set Name
Clock
Cal Values "Fct 01 XCal or Fct 02 YCal"
Match Values "Fct 03 Vectors"
Auto Log "Fct 11 Set Op Mode" for remote above
logging.

Log Setup
Transcomp "Fct 16 Bad Reading", plus other new
options.
Prompts "Fct 12 Set Prompts"
Angles "Fct 07 Set Angles"
Distances "Fct 06 Set Dists"
Masks
Control Sequence "Fct 11 Set Op Mode"
PAR Sensors "Fct 08 1,2 Channels"
Data

Wand Data
Download
Purge
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Console Data
<user picks file>

View "Fct 27 View"
View Header
View Ang/Dst
View Cntct#/StdDev
View Ang/Gap Frac
View Observations

Edit "Fct 25 Edit"
Edit Angles
Edit Mask
Edit Distances
Edit Transcomp
Import Observations
Strip Observations

Recompute "Fct 26 Recompute"
Delete
Rename
Console Setup

Set Time "Fct 05 Set Clock"
Upgrade Firmware
Auto Off Timer
Beeper

1.2 Optical Sensors (Wands) are Smart.
1.2.1. The console can detect when one is attached, and

which port it is attached to.
1.2.2. The wands carry their own identity and cal-

ibration information with them.
1.2.3. The wands can log data without being attached to

a console. Here's the thing to remember: If a wand is
attached to the console, and a log file is open, press-
ing the LOG key on the console or on the wand will
add a record to the file in the console. Otherwise,
pressing LOG will add a record to the memory of the
wand. Also, automatic logging can be set up for a
wand (define start time, stop time, and frequency).
Any autologged data always goes the wand memory.
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To get records out of a wand, attach it to a console,
and go toMENU > Data > Wand > Download.
You can put the data into a new file, or append it to
an existing file.

1.3 Less Dependence on Operating Mode. The LAI-2000
had a list of operating modes to choose from (1
Sensor X, 1 Sensor Y, etc.). These have essentially
gone away. To illustrate this, we show below how to
do the most common of the former modes using the
LAI-2200C:

A) 1 Sensor X or Y:
Power on.
Attach a wand.
Press Start/Stop. Name the file.
Use the A/B button on the wand to select if the next

reading is A or B.
Log readings.
Press Start/Stop to close the file.

If you want to do a predetermined sequence (↑↓↓↓,
etc.), you can set that up withMENU > Log Setup
> Control Sequence.

B) Remote Below, and Remote Above:

Power ON
Attach Both Sensors.
Match one to the other (MENU >Wand Setup >
(pick one to adjust) > Match Values)

Setup autolog. (MENU >Wand Setup > (pick the A
wand) > Auto Log)

Detach and deploy the A wand.
Collect B file(s) with the console and remaining wand.
Retrieve the A data. Reattach the A wand, and go to
MENU > Data > Wand > Download, and name a
new file.

Merge the A and B readings. Go toMENU > Data >
Console > (pick a B file) > Edit > Import
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Observations, and select the A file. Repeat for
remaining B files.

2.0 Computational
2.1 Weighting Factors. Both instruments compute LAI

by applying weighting factors to the contact values
computed for each ring ("Weighting Factors" on
page 10-10). The LAI-2000 assigned ring data to the
entire interval between 0 and π/2, while the
LAI-2200C only uses the discrete bands actually
viewed by the rings. Refer to Weighting Factors on
page 10-10 for LAI-2200C weighting factors.

2.2 Ignoring rings. The LAI-2200C allows rings to be
ignored in the computation of LAI. To set this for
new data files: MENU > Log Setup > Masks. To
change this on an existing data file: MENU > Data >
Console > (pick a file) > Edit > Edit Mask

2.3 ACF. The LAI-2200C computes a new value, Appar-
ent Clumping Factor (ACF), which is a value 1 (no
clumping) or less (clumping). The LAI-2200C reports
an ACF value for each ring (the log of the average
transmittance divided by the average of the logs of
the transmittances), and a weighted average for all the
rings. This is discussed further on page Imple-
mentation Algorithms on page 10-5.
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Standard Terms and Conditions
1. General. LI-COR Inc. (“LI-COR”) is delivering these goods and products
(“Products”) subject to these Terms and Conditions of Sale (“Conditions”).
Buyer will be deemed to have assented to these Conditions upon Buyer’s
placement of order. Notwithstanding the above, failure of LI-COR to object
to provisions contained in any purchase order or other form or document
from Buyer shall not be construed as a waiver of these Conditions nor an
acceptance of any such provision.

2. Buyer’s Use Only/No Resale. The purchase of Products only conveys to
Buyer the non-transferable right for only Buyer to use the quantity of
Products and components of Products purchased in compliance with the
applicable intended use statement, limited use statement or limited label
license, if any, in LI-COR catalogues or on the label or other doc-
umentation accompanying the Products (all such statements or licenses
being incorporated herein by reference as if set forth herein in their
entirety). Buyer has no right to resell the Products, or any portion of them,
and any such resale is strictly prohibited unless LI-COR first accepts and
approves a purchase order and acknowledges in writing that the Products
may be resold by Buyer and the terms of such resales.

3. Prices/Taxes. All prices are quoted for delivery to Buyer when goods are
loaded on the carrier at LI-COR premises in Lincoln, Nebraska, USA.
Accordingly, unless otherwise specified by LI-COR, prices are exclusive of
shipping, insurance and installation charges, all of which are Buyer’s sole
responsibility. All prices are exclusive of all sales, use, excise, value added,
withholding and other taxes, and all customs, duties, documentation
charges, and freights forwarder charges now or hereafter claimed or
imposed by any governmental authority upon the sale of the Products. Any
such charges will be added to the product invoice or subsequently invoiced
to the Buyer. In the event LI-COR is required to pay any such tax, duty or
charge, Buyer will promptly reimburse LI-COR.

4. Payment Terms. All payments shall be made in immediately available
U.S. Dollars net thirty (30) days from the date of invoice for qualified
accounts, without set-off, deduction or withholding of any kind, unless



LAI-2200C Plant Canopy Analyzer Instruction Manual

otherwise stated by LI-COR in writing and may be paid by check
(drawn on a U.S. bank), wire transfer or major credit card. All open
account invoicing must be pre-approved. Any amounts not paid when
due will accrue interest at the rate of 1 1/2% per month, or the max-
imum amount allowed by law, if lower. In the event that any payment is
more than thirty (30) days late, LI-COR shall have the right to suspend
doing business with Buyer until all past due balances are made current.
Buyer shall pay for all costs (including reasonable fees) incurred by
LI-COR in connection with the collection of late payments. Each accep-
ted purchase order is a separate, independent transaction, and Buyer has
no right of set-off against other purchase orders or other transactions
with LI-COR. Buyer hereby grants LI-COR a security interest in the
Products in the amount of the unpaid balance of the purchase price
until paid in full. LI-COR may file a financing statement for such secur-
ity interest and Buyer shall sign any such statements or other doc-
umentation necessary to perfect LI-COR security interest.

5. Return Policy. Buyer may return non-consumable Products to
LI-COR within forty-five (45) days of invoice date only with prior
authorization by LI-COR, the Product(s) being returned in new and
unused condition and must be resalable as new. Any returned Product
(s) are subject to payment of a fifteen percent (15%) re-stocking fee on
all items returned. Buyer shall be responsible to make payment to
LI-COR for any and all expenses related to deinstallation of the Product
(s), including but not limited to shipping, duties, and taxes. All pay-
ments subject to this provision shall be made to LI-COR within thirty
(30) days of return, or de-installation, of the Product(s).

6. Delays In Performance. LI-COR shall not be liable for any delay in
performance hereunder due to unforeseen circumstances or due to cir-
cumstances beyond its control including, but not limited to, acts of
nature, acts of government, labor disputes, delays in transportation,
delays in customs clearance and delays in delivery or inability to deliver
by LI-COR’s suppliers.

7. Shipment and Packing. All Product prices exclude costs of shipping
and handling and insurance, in accordance with delivery terms des-
ignated by LI-COR. Unless otherwise agreed in writing, such costs will
be paid by the Buyer and will appear as a separate item on LI-COR
invoice. LI-COR shall ship in accordance with LI-COR standard prac-
tices. Buyer may specify different shipping instructions, subject to agree-
ment by LI-COR. Unless otherwise agreed to in writing by LI-COR, all
products shall be packaged, if appropriate, for shipment and storage in
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accordance with standard commercial practices. All packing shall con-
form to carrier requirements.

8. Partial Shipments. Any Products delivered in partial shipments may
be invoiced individually. Additional shipping and handling charges may
apply.

9. Title/Risk of Loss. All domestic shipments are made FOB per Uni-
form Commercial Code. All international shipments are made per
INCOTERMS 2000 designated by LI-COR. LI-COR title to the Products
and the risk of loss of or damage to the Products ordered by the Buyer
will pass to Buyer at time of LI-COR delivery of Products to the carrier.
The carrier shall be deemed Buyer’s agent, and any claims for damages
in shipment must be filed with the carrier. LI-COR is authorized to des-
ignate a carrier pursuant to LI-COR standard shipping practices unless
otherwise specified in writing by Buyer.

10. Intellectual Property Rights. Title to and ownership of the doc-
umentation, and any improved, updated, modified or additional parts
thereof, and all copyright, patent, trade secret, trademark and other intel-
lectual property rights embodied in the Products, shall at all times
remain the property of LI-COR or LI-COR licensors.

11. Acceptance. All sales are final and all Products shall automatically be
deemed accepted upon delivery to Buyer when goods are loaded on the
carrier at LI-COR premises in Lincoln, Nebraska, USA. Buyer may not
return any Products to LI-COR except as provided for by LI-COR war-
ranty or as provided herein.

12. Product Warranties. Unless otherwise specified by LI-COR:

(a) LI-COR warrants that, for a period of twelve (12) months from
the date of shipment of the Products from LI-COR (the “Warranty
Period”), unless otherwise specified for individual Products or exten-
ded by a Support Contract or Extended Warranty Contract, the
Products sold hereunder will be free from material defects in mater-
ials and workmanship and will conform to LI-COR published spe-
cifications in effect as of the date of manufacture. LI-COR
SPECIFICALLY DISCLAIMS ANY INDIRECT,SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES (INCLUDING
LOSS OF USE OR LOST PROFITS) WHICH MAY RESULT FROM
THE USE OF PRODUCTS PURCHASED HEREUNDER, AS
FURTHER SET FORTH IN SECTION 13 OF THESE
CONDITIONS OF SALE. This limited warranty extends only to
Buyer as original purchaser unless otherwise agreed upon in writing
by LI-COR.
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(b) The foregoing warranty shall not apply if the defective Product
(i) has been subjected to abuse, misuse, neglect, negligence, accident,
improper testing, improper installation, improper storage, improper
handling or use contrary to any instructions issued by LI-COR, (ii)
has been repaired or altered by persons other than LI-COR, (iii) has
not been installed, operated, repaired and maintained in accordance
with the documentation or operated outside of the environmental
specifications for the Product; (iv) has failed due an Act of God,
including but not limited to fire, flood, tornado, earthquake, hur-
ricane or lightning or (v) has been used with any devices, accessories
or products not manufactured by or approved by LI-COR. In addi-
tion, the foregoing warranty shall not apply to Products (i) LI-COR
Standard Terms and Conditions of Sale – rev. 5/15/2009 marked or
identified as “sample,” (ii) loaned or provided to Buyer at no cost, or
(iii) which are sold “as is.”

c) If during the Warranty Period: (i) LI-COR is notified promptly in
writing upon discovery of any defect in the Product, including a
detailed description of such alleged defect, (ii) such Product is
returned, transportation charges prepaid, to LI-COR designated man-
ufacturing facility subject to the prior approval of LI-COR with a
valid Return Material Authorization (“RMA”) number, and (iii)
LI-COR inspections and tests determine that the Product is indeed
defective and the Product has not been subjected to any of the con-
ditions set forth above, then, as Buyer’s sole remedy and LI-COR sole
obligation under the foregoing warranty, LI-COR will, at LI-COR
option, repair or replace without charge the defective Product. In no
event will the Buyer itself nor will the Buyer allow any party other
than LI-COR or a third party authorized in writing by LI-COR to
perform any service on the Products.

(d) During the Warranty Period, LI-COR will provide on-site war-
ranty repair for Odyssey® Infrared Imager, Aerius Automated
Infrared Imager, Pearl® Imager and/ or 4300 DNA Analyzer
Products including travel costs, repair parts, and labor to maintain
the hardware in proper operating condition. At LI-COR discretion,
the Buyer may be required to run certain diagnostic procedures to
help determine the source of the problem before on-site warranty
repair is rendered. If an on-site service call is initiated, LI-COR will
dispatch a service technician to the Buyer site. On-site service will be
provided 8:00 a.m. to 5:00 p.m. (Buyer local time), Monday through
Friday, excluding LI-COR holidays. The cost of a repair/service call
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for an instrument malfunction caused by third party hardware
and/or software will be billed to Buyer on a time and material basis.

(e) Any Product that has either been repaired or replaced under this
warranty shall have warranty coverage (parts only) for the longer of
ninety (90) days or the remaining original warranty period. Replace-
ment parts used in the repair of Products may be new or equivalent
to new.

(f) EXCEPT FOR THE WARRANTIES SET FORTH IN THIS
SECTION, LI-COR MAKES NO OTHER WARRANTIES, EXPRESS,
IMPLIED OR STATUTORY, WITH RESPECT TO ANY
PRODUCTS OR OTHER PRODUCTS PROVIDED IN
CONNECTION WITH THESE CONDITIONS, INCLUDING
WITHOUT LIMITATION ANY IMPLIED WARRANTY OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE,
NONINFRINGEMENT, OR ARISING FROM COURSE OF
PERFORMANCE, DEALING, USAGE OR TRADE.

(g) Notwithstanding anything herein to the contrary, LI-COR makes
no warranty with respect to any third party products provided under
these Conditions. Buyer’s sole remedy with respect to such third
party products shall be pursuant to the original manufacturer’s or
licensor’s warranty, if any, to Buyer, to the extent permitted by the
original manufacturer or licensor.

13. Limitation of Liability. IN NO EVENT SHALL LI-COR, ITS
LICENSORS OR ITS SUPPLIERS BE LIABLE TO BUYER OR ANY
THIRD PARTY FOR COSTS OF PROCUREMENT OF SUBSTITUTE
PRODUCTS OR SERVICES, LOST PROFITS, DATA OR BUSINESS,
OR FOR ANY INDIRECT, SPECIAL, INCIDENTAL, EXEMPLARY OR
CONSEQUENTIAL DAMAGES OF ANY KIND ARISING OUT OF OR
IN CONNECTION WITH THE USE OF THE PRODUCTS OR THESE
CONDITIONS, HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY (WHETHER IN CONTRACT, TORT (INCLUDING
NEGLIGENCE), STRICT LIABILITY, PRODUCTS LIABILITY OR
OTHERWISE). LI-COR TOTAL AND CUMULATIVE LIABILITY
ARISING OUT OF OR IN CONNECTION WITH ANY PRODUCTS
PURCHASED BY BUYER HEREUNDER SHALL IN NO EVENT
EXCEED THE PURCHASE PRICE PAID BY BUYER FOR SUCH
PRODUCTS. THE LIMITATIONS SET FORTH IN THIS SECTION
SHALL APPLY EVEN IF LI-COR OR ITS SUPPLIERS HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, AND
NOTWITHSTANDING ANY FAILURE OF ESSENTIAL PURPOSE OF
ANY LIMITED REMEDY.
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14. Authorized Use of Biotechnology Products. Unless otherwise
expressly indicated in LI-COR catalogues, LI-COR website or on the
label or other documentation accompanying Biotechnology Products,
the LI-COR Biotechnology Products are intended for RESEARCH USE
ONLY and are not to be used for any other purposes including, but not
limited to, unauthorized commercial purposes, in vitro diagnostic pur-
poses, ex vivo or in vivo therapeutic purposes, investigational use, in
foods, drugs, devices or cosmetics of any kind, or for consumption by or
use in connection with or administration or application to humans or
animals. Buyer acknowledges that the Biotechnology Products have not
necessarily been tested for safety or efficacy, unless expressly stated in
LI-COR catalogs or on the label or other documentation accompanying
the Biotechnology Products.

15. Authorized Use of Biotechnology Products. Unless otherwise
expressly indicated in LI-COR catalogues, LI-COR website or on the
label or other documentation accompanying Biotechnology Products,
the LI-COR Biotechnology Products are intended for RESEARCH USE
ONLY and are not to be used for any other purposes including, but not
limited to, unauthorized commercial purposes, in vitro diagnostic pur-
poses, ex vivo or in vivo therapeutic purposes, investigational use, in
foods, drugs, devices or cosmetics of any kind, or for consumption by or
use in connection with or administration or application to humans or
animals. Buyer acknowledges that the Biotechnology Products have not
necessarily been tested for safety or efficacy, unless expressly stated in
LI-COR catalogs or on the label or other documentation accompanying
the Biotechnology Products.

16. Severability. If any portion of these Conditions is held invalid, the
parties agree that such invalidity shall not affect the validity of the
remaining portions of these Conditions.

17. Export Control. Buyer acknowledges and agrees that the Products
purchased under these Conditions may be subject to restrictions and
controls imposed by the United States Government and the regulations
thereunder. BUYER WARRANTS THAT IT WILL NOT EXPORT OR
RE-EXPORT ANY PRODUCTS PURCHASED WITHOUT PRIOR
WRITTEN NOTIFICATION AND APPROVAL OF LI-COR.

18. Assignment. Buyer shall not assign or transfer these Conditions or
any rights or obligations under these Conditions, whether voluntary or
by operation of law, without the prior written consent of LI-COR.
LI-COR may assign or transfer these Conditions to any successor by way
of merger, acquisition or sale of all or substantially all of the assets relat-
ing to these Conditions. LI-COR or any successor may assign all or part
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of the right to payments under these Conditions. Any assignment or
transfer of these Conditions made in contravention of the terms hereof
shall be null and void. Subject to the foregoing, these Conditions shall
be binding on and inure to the benefit of the parties’ respective suc-
cessors and permitted assigns.

19. Entire Agreement. These Conditions of Sale take precedence over
Buyer’s additional or different terms and conditions, to which notice of
objection is hereby given. Acceptance by Buyer is limited to LI-COR
Conditions of Sale. Neither LI-COR commencement of performance
nor delivery shall be deemed or construed as acceptance of Buyer’s addi-
tional or different terms and conditions. These Conditions supersede all
prior communications, transactions, and understandings, whether oral
or written, and constitute the sole and entire agreement between the
parties pertaining to the referenced quotation or purchase order,
provided that: (1) these Conditions shall not, without LI-COR prior writ-
ten consent, supersede any conflicting terms of: (a) prior written agree-
ments duly executed by LI-COR, or (b) governmental purchase orders,
terms of purchase, requests for quotation or acquisition regulations rel-
ative to governmental purchasers; and (2) to the extent not in conflict
with any such prior or governmental terms, these Conditions shall sup-
plement them. No modification, addition or deletion, or waiver of any
of the terms and conditions of these Conditions shall be binding on
either party unless made in a non-preprinted agreement clearly under-
stood by both parties to be a modification or waiver, and signed by a
duly authorized representative of each party.

20. Entire Agreement. These Conditions of Sale take precedence over
Buyer’s additional or different terms and conditions, to which notice of
objection is hereby given. Acceptance by Buyer is limited to LI-COR
Conditions of Sale. Neither LI-COR commencement of performance
nor delivery shall be deemed or construed as acceptance of Buyer’s addi-
tional or different terms and conditions. These Conditions supersede all
prior communications, transactions, and understandings, whether oral
or written, and constitute the sole and entire agreement between the
parties pertaining to the referenced quotation or purchase order,
provided that: (1) these Conditions shall not, without LI-COR prior writ-
ten consent, supersede any conflicting terms of: (a) prior written agree-
ments duly executed by LI-COR, or (b) governmental purchase orders,
terms of purchase, requests for quotation or acquisition regulations rel-
ative to governmental purchasers; and (2) to the extent not in conflict
with any such prior or governmental terms, these Conditions shall sup-
plement them. No modification, addition or deletion, or waiver of any
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of the terms and conditions of these Conditions shall be binding on
either party unless made in a non-preprinted agreement clearly under-
stood by both parties to be a modification or waiver, and signed by a
duly authorized representative of each party.

21. Force Majeure. Shipping dates are approximate and may be delayed
absent prompt receipt from Buyer of all necessary information. LI-COR
shall not be responsible for any failure to perform or delay attributable
in whole or in part to any cause beyond its reasonable control, including
but not limited to Acts of God, government actions, war, civil dis-
turbance, insurrection, sabotage, labor shortages or disputes, failure or
delay in delivery by LI-COR suppliers or subcontractors, transportation
difficulties, customs clearance, shortage of energy, raw materials or
equipment, or Buyer’s fault or negligence. In the event of any such delay
the date of delivery shall, at the request of LI-COR, be deferred for a
period equal to the time lost by reason of the delay.

22. Governing Law and Venue. These Conditions and performance by
the parties hereunder shall be construed in accordance with the laws of
the State of Nebraska, U.S.A., without regard to provisions on the con-
flicts of laws.
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